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N O T E S  T O  T H E  L E A R N E R  

 

Dear Learner, 

Welcome to this Learning programme. We trust that this Learning programme will be of great value to 

you during your studies and in your new learning experience. To succeed in anything in life requires a lot 

of hard work. 

 

It will be expected of you to work through this study guide with a great deal of attention. It provides you 

with information on how to work through the material, details exactly what will be expected of you and 

what objectives you need to achieve during the study of this Learning programme. 

• Complete your assignments with dedication and submit them in time. 

• Complete the self-study sections for your own benefit. The self-study sections provide you with 

the opportunity to practice what you have learnt. 

• Act as adult learners 

 

The theory you are learning helps you to understand why you are doing things in a specific way. It also 

gives you a way to compare what you are doing to the way others do things. However, the only way to 

become competent is by doing the actual work according to the unit standards. This Learning 

programme provides you with a step-by-step method that you must apply to all unit standards. 

 

As all parties to this learning intervention have duties and responsibilities to fulfil, so do you, in your 

capacity as the learner. On the final page of this section, you will find a commitment letter which serves 

to confirm your commitment to this learning intervention. Please read it and sign it, if you agree 

thereto. Should you not agree, please notify your facilitator so that the matter can be resolved.  
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Use of the Learner Guide 

There are five (5) unit standards in this Learner Guide. 

Skills Programme 2: Co-ordination, bookings and business documents 

U/S number Unit Standard name Level Cr 

13929  Co-ordinate meetings, minor events and travel arrangements  Level 3  3  

7706  Maintain a Booking System  Level 3  3  

7573  Demonstrate ability to use the World Wide Web  Level 2  3  

7567  Produce and use spread sheets for business  Level 3  5  

7570  Produce word processing documents for business  Level 3  5  

 

A specific goal is given for each lecture or theme. You will have to attain a number of objectives to attain the goal 

of each session. First read the objectives to focus your thoughts on the information that may be relevant to attain 

the objectives. Once you have your thoughts focussed, skim or scan the course work prescribed for each theme to 

orientate you with the material you have to study. 

 

During classes an overview of a theme will be given, after which a number of problems and/or questions will be 

discussed. You are advised to develop a concept map of each theme that not only represents each theme visually, 

but also relates the different components. 
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M O D U L E  S T R U C T U R E  

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

Module 1  The office environment and its requirement 

 

 

Module 3  Meeting communication and information 

 

 

Module 4  The workplace and staff 

 

 

Module 5  Business calculations 

 

 

Module 6  Business Environment 

 

 

Module 2  Co-Ordination, bookings and business 

documents 
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Unit Standard 13929  
 

SPECIFIC	OUTCOMES	AND	RELATED	ASSESSMENT	CRITERIA	
SO	1	 IDENTIFY	A	DATE,	VENUE	AND	TIME	FOR	A	MEETING	OR	EVENT		
AC	1	 A	range	of	dates	for	meeting/event	are	provided	to	attendees.		

AC	2	 Suitable	dates	and	venues	are	determined	based	on	responses	to	range	of	dates	
provided.		

AC	3	 Meeting/event	is	booked	and	confirmed	with	attendees	in	writing.		
AC	4	 All	related	documentation	is	forwarded	to	the	attendees.		

SO	2	 ARRANGE	VENUE	AND	CATERING		
AC	1	 Venue	is	selected	and	booked.		
AC	2	 Process	of	selecting	venue	is	described.		

AC	3	 Special	arrangements,	logistics,	meeting	room	layout	and	equipment	required	are	
confirmed	with	the	venue	provider.		

AC	4	 Process	of	selecting	date,	caterer	and	menu	is	described,	taking	into	consideration	
religious	and	dietary	requirements.		

AC	5	 Agenda	for	meeting/event	is	forwarded	to	venue	provider	and	caterers	so	that	correct	
times	for	meals	and	breaks	can	be	adhered	to.		

AC	6	 Venue	and	caterers	are	notified	in	writing	and	deposits	paid.		
SO	3	 MAKE	TRAVEL,	CAR	HIRE	AND	ACCOMMODATION	ARRANGEMENTS		
AC	1	 Travel,	car	hire	and	accommodation	requirements	for	all	attendees	are	determined.		
AC	2	 Suitable	accommodation	is	secured	and	bookings	confirmed	in	writing.		
AC	3	 Car	hire	facilities	are	identified	and	confirmed	in	writing.		

AC	4	 Travel	arrangements	are	made	and	all	necessary	documentation	forwarded	to	the	
attendees.		

AC	5	 Invoices	relating	to	travel,	car	hire	and	accommodation	are	processed.		

AC	6	 Any	relevant	advance	disbursements	for	travel,	car	hire	or	accommodation	are	
processed.		

SO	4	 ASSEMBLE	AND	DISTRIBUTE	DOCUMENTATION	FOR	MEETING	OR	
EVENT	IN	GOOD/SUFFICIENT	TIME	TO	ATTENDEES		

AC	1	 Deadline	date	for	receipt	of	documentation	from	contributors	is	established	according	to	
agreed	time	frames.		

AC	2	 Deadline	date	is	communicated	to	contributors.		
AC	3	 Documents	are	assembled,	copied	and	collated.		
AC	4	 Relevant	documents	are	timeously	distributed	in	hard	or	electronic	form	to	participants.		

 



SDA | MODULE 2 | STUDENT GUIDE 7 

 

 

 

										CRITICAL	CROSS	FIELD	OUTCOMES	
UNIT STANDARD CCFO IDENTIFYING  
Identify and solve problems regarding specific meeting requirements.  
 
UNIT STANDARD CCFO WORKING  
Work effectively with others liaising and negotiating dates and venues.  
 
UNIT STANDARD CCFO ORGANISING  
Organise oneself and one`s activities to collect and collate information on venues and caterers.  
 
UNIT STANDARD CCFO COMMUNICATING  
Communicate effectively using assertive telephone techniques and negotiating skills.  
 
UNIT STANDARD CCFO SCIENCE  
Use science and technology to communicate meeting details (e-mail, fax and telephone). 
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All qualifications and unit standards registered on the National Qualifications Framework are public 
property. Thus the only payment that can be made for them is for service and reproduction. It is illegal to 
sell this material for profit. If the material is reproduced or quoted, the South African Qualifications 
Authority (SAQA) should be acknowledged as the source.  

SOUTH AFRICAN QUALIFICATIONS AUTHORITY  

REGISTERED UNIT STANDARD:  

 

Co-ordinate meetings, minor events and travel arrangements  

SAQA US 
ID 

UNIT STANDARD TITLE 

13929  Co-ordinate meetings, minor events and travel arrangements  

ORIGINATOR REGISTERING PROVIDER 

SGB Administration    

QUALITY ASSURING BODY 

-   

FIELD SUBFIELD 

Field 03 - Business, Commerce and Management Studies Office Administration  

ABET 
BAND 

UNIT STANDARD 
TYPE 

OLD NQF LEVEL NEW NQF LEVEL CREDITS 

Undefined  Regular-
Fundamental  

Level 3  NQF Level 03  3  

REGISTRATION STATUS REGISTRATION START 
DATE 

REGISTRATION END 
DATE 

SAQA DECISION 
NUMBER 

Reregistered  2009-05-05  2012-05-05  SAQA 0160/05  

LAST DATE FOR ENROLMENT LAST DATE FOR ACHIEVEMENT 

2013-05-05    2016-05-05    

 

In all of the tables in this document, both the old and the new NQF Levels are shown. In the text (purpose statements, 

qualification rules, etc), any reference to NQF Levels are to the old levels unless specifically stated otherwise.  

 
This unit standard does not replace any other unit standard and is not replaced by any other unit standard.  

 

PURPOSE OF THE UNIT STANDARD  
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Learners will be learning towards obtaining a national qualification at level 3 or are working in an administrative 
environment, including SMME`s (Small, Medium and Micro Enterprises), where the acquisition of competence 
against this standard will add value to the learner`s job, or chances of finding employment.  
 
Learners will be well positioned to extend their learning and practice into other areas in the business environment, 
or to strive towards professional standards and practice at higher levels.  
 
The qualifying learner is capable of:  
 
•  Identifying a date, venue and time for meeting or event  
•  Liasing or negotiating with meeting attendees regarding availability  
•  Booking venues and catering  
•  Finalising meeting room arrangements  
•  Making travel, car hire and accommodation arrangements  
•  Notifying and confirming arrangements with attendees or stakeholders  
•  Processing and distributing all documentation required for the meeting or event  

 

LEARNING ASSUMED TO BE IN PLACE AND RECOGNITION OF PRIOR LEARNING  

Learners accessing this unit standard will have demonstrated competence in numeracy and literacy at NQF Level 
2.  

 

UNIT STANDARD RANGE  

•  Working as part of an office support team includes contributing to the arrangements of meetings from lower 
level management to executive levels  
•  Principles will include data gathering, liaison and negotiation with outside parties and team members  
•  Details of meeting will include venue, date, reason and time of meeting  

 

Specific Outcomes and Assessment Criteria:  

 

SPECIFIC OUTCOME 1  

Identify a date, venue and time for a meeting or event  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. A range of dates for meeting/event are provided to attendees.  

 

ASSESSMENT CRITERION 2  

2. Suitable dates and venues are determined based on responses to range of dates provided.  
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ASSESSMENT CRITERION 3  

3. Meeting/event is booked and confirmed with attendees in writing.  

 

ASSESSMENT CRITERION 4  

4. All related documentation is forwarded to the attendees.  

 

SPECIFIC OUTCOME 2  

Arrange venue and catering  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Venue is selected and booked.  

 

ASSESSMENT CRITERION 2  

2. Process of selecting venue is described.  

 

ASSESSMENT CRITERION 3  

3. Special arrangements, logistics, meeting room layout and equipment required are confirmed with the venue 
provider.  

 

ASSESSMENT CRITERION 4  

4. Process of selecting date, caterer and menu is described, taking into consideration religious and dietary 
requirements.  

 

ASSESSMENT CRITERION 5  

5. Agenda for meeting/event is forwarded to venue provider and caterers so that correct times for meals and 
breaks can be adhered to.  

 

ASSESSMENT CRITERION 6  

6. Venue and caterers are notified in writing and deposits paid.  

 

SPECIFIC OUTCOME 3  

Make travel, car hire and accommodation arrangements  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  
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1. Travel, car hire and accommodation requirements for all attendees are determined.  

 

ASSESSMENT CRITERION 2  

2. Suitable accommodation is secured and bookings confirmed in writing.  

 

ASSESSMENT CRITERION 3  

3. Car hire facilities are identified and confirmed in writing.  

 

ASSESSMENT CRITERION 4  

4. Travel arrangements are made and all necessary documentation forwarded to the attendees.  

 

ASSESSMENT CRITERION 5  

5. Invoices relating to travel, car hire and accommodation are processed.  

 

ASSESSMENT CRITERION 6  

6. Any relevant advance disbursements for travel, car hire or accommodation are processed.  

 

SPECIFIC OUTCOME 4  

Assemble and distribute documentation for meeting or event in good/sufficient time to attendees  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Deadline date for receipt of documentation from contributors is established according to agreed time frames.  

 

ASSESSMENT CRITERION 2  

2. Deadline date is communicated to contributors.  

 

ASSESSMENT CRITERION 3  

3. Documents are assembled, copied and collated.  

 

ASSESSMENT CRITERION 4  

4. Relevant documents are timeously distributed in hard or electronic form to participants.  

 

UNIT STANDARD ACCREDITATION AND MODERATION OPTIONS  

Accreditation and Moderation:  
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The relevant Services Educational Training Quality Assurance Body (ETQA) will accredit providers offering learning 
towards these standard and register assessors.  

 

UNIT STANDARD ESSENTIAL EMBEDDED KNOWLEDGE  

•  Use and understanding of directories for telephone, venue and conference centers, restaurants, car rental, travel 
and accommodation  
•  Telephone techniques  
•  Map book  
•  Use of technology: photocopier, e-mail, fax machines, website for research  

 

Critical Cross-field Outcomes (CCFO):  

 

UNIT STANDARD CCFO IDENTIFYING  

Identify and solve problems regarding specific meeting requirements.  

 

UNIT STANDARD CCFO WORKING  

Work effectively with others liaising and negotiating dates and venues.  

 

UNIT STANDARD CCFO ORGANISING  

Organise oneself and one`s activities to collect and collate information on venues and caterers.  

 

UNIT STANDARD CCFO COMMUNICATING  

Communicate effectively using assertive telephone techniques and negotiating skills.  

 

UNIT STANDARD CCFO SCIENCE  

Use science and technology to communicate meeting details (e-mail, fax and telephone).  
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US 13929  CO-ORDINATE MEETINGS, MINOR EVENTS AND TRAVEL 

ARRANGEMENTS  

 

 Introduction 

A meeting is a gathering of individuals to organise, plan and control the activities of a business or organisation. 

The participants in a meeting may be part of a committee or may simply attend the meeting out of common 

interest. In order for meetings to be effective, members should arrive having done the necessary preparation for 

the items on the agenda.  

 

Millions of meetings take place in the business world every day. Run effectively, meetings are an important 

means of communication. The higher your position in the corporate structure, the more likely you are to spend 

time in meetings. Surveys have shown that managers can spend between two and four hours a day in meetings.  

 

Meetings, whether they be one-on-one discussions or gatherings of five, ten or twenty people are an important 

part of working life, but they are time consuming. They are often criticised for being unproductive, costly, boring 

and sometimes unnecessary. 

 

The quality of the finished product is directly related to the planning thereof. When approaching the task of 

organising an event, big or small, organisation and attention to detail enhance the professionalism of the 

outcome. As organiser or co-ordinator for an event, you will be responsible for the finished product and this can 

be an awesome responsibility.  

 

Before you can start with the planning for an event, there are five basic questions that need to be answered: 

1. Why	do	we	need	this	event?	

2. What	do	we	want	to	achieve?	

3. Who	should	attend?	

4. When	should	the	event	be	held?	

5. Where	should	it	be	held?	
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Why do we need this event? 

Why do we want to hold a particular event> this is probably the most important question that needs to be 

answered, but often is not even asked. Your superiors will decide whether the event is really necessary or if a lot 

more time or cost effective alternative exists.  

 

If the information can be put across in another way, for example by the means of a video conference instead of a 

formal meeting or event, this will seriously have to be considered.  

 

It is sometimes less expensive and more time effective to arrange all the equipment for a video conference, 

instead of getting all delegates to meet at a central point. Some delegates may have to travel over quite a 

distance to get to the meeting.  

 

Cost and time spent on organising a special event are not the only factors that should be taken into consideration 

when making a decision on whether or not to have a special event. Other consideration could include the fact 

that special events can: 

 

↘ Play	an	important	role	in	the	decision	making	process.	Senior	management	may	want	to	meet	away	
from	the	office	to	discuss	strategy	issues.		

	

↘ Satisfy	social	needs.	People	want	to	feel	part	of	an	organisation,	and	group	identity	needs	to	be	built.	
A	special	event	can	do	this	effectively.		

	
↘ Generate	publicity	for	the	organisation.	Good	examples	of	this	are	the	free	press	and	television	

coverage	associated	with	political	meetings	and	gatherings	on	social	problems,	for	example	the	

growing	AIDS	crisis	in	South	Africa.	

	
↘ Be	informative	and	allow	cross-pollination	of	ideas.	Networking	plays	an	important	role	at	these	

events	as	delegates	learn	from	each	other,	enough	time	for	networking	should	be	allowed	for	this	

particular	purpose.		
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What do you want to achieve? 
What is the purpose of this event? In other words, what are the objectives that you want to achieve? This will 

determine the type of event. Questions that can be asked to determine the purpose of a special event could 

include: 

• Do	you	want	to	convey	information?	

• Do	you	want	delegates	to	collect	information?	

• Do	you	want	to	change	attitudes?	

• Do	you	want	to	boost	the	morale	of	delegates?	

• Do	you	want	to	motivate	delegates?	

 

There must be a specific objective linked to the special event. For example the objective for a product launch 

might be to “introduce a new product to the market”. Or you may use a special event as a motivational tool for 

your employees. Another objective may be to make a profit.  

 

There are people who actually make a business out of organising special events. Once you have identified the 

objective for the special event, you will need to decide how to meet these objectives. The objectives will help you 

start with the planning of your special event. The next step is to decide who your target audience will be.  

 

Who should attend the event? 

Together with your boss and several other parties, you will need to draw up a list of delegates who will attend the 

meeting. Ask yourself: 

ü Are	there	special	people	that	need	to	be	invited,	or	are	you	just	going	to	promote	the	event	by	having	

and	advertising	campaign?	

ü Is	the	event	for	a	specific	group	of	people?	For	example,	if	you	are	going	to	organise	a	training	

programme	for	the	middle-level	managers,	there	will	be	specific	people	that	will	attend	the	training.		

ü However,	if	you	are	organising	a	commercial	event	that	you	want	to	make	a	profit	out	of,	you	will	

have	to	market	or	promote	the	event.		

 

You should draw up a demographic profile of your audience. What are their interests, education and skills level, 

age and professional status? This will assist you in planning the event to suit your target audience.  
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When should the event be held? 

Planning Time 

Remember the bigger the event, the more time it will take to plan and arrange it. Large events can take up to two 

years from initial planning to presentation.  

 

Key dates 

You will have to look at the availability of your target audience. When will be the best time for them to attend an 

event? Take note of Public Holidays as well as different seasons. This may sound strange but people will be more 

reluctant to attend a conference in the middle of winter in the Free State than when they would if the conference 

was held in the summer. Also make sure that you are aware of other events that may be taking place at the same 

time that could conflict with your event. They do not necessarily have to be work related. Scheduling the meeting 

for the same day as a world cup final will result in a poor attendance.  

 

Availability of Venues 

Check the availability of speakers, equipment and venues on the specific dates. Should you wish to build an event 

around a specific speaker or hold the event at a specific place, you may need to be flexible and fit in with their 

respective schedules.  

 

Tradition 

Often companies schedule their events on a fixed calendar in the beginning of the year. This helps a great deal 

with the planning and the events can be scheduled during the off-peak times of the year.  

 

One day events 

Many people schedule their one-day events on Tuesdays, Wednesdays and Thursdays. Mondays are problematic 

for some people and usually Fridays is seen as days to clear up all the work that piled up during the week.  

 

Where will the event be held? 

 This section refers to the venue selection, which is one of the most crucial decisions you will make. The right 

setting for your event sets the tone for the whole experience. Choosing the wrong venue can spoil even the best 

planned event.  
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Meeting Documentation 

A Notice of Meeting informs people of the date, place and time of a meeting. Notice is usually given 7-14 days 

before a meeting depending on the constitution or rules of the organisation/entity calling the meeting. However, 

in the case of an AGM, 21 days notice is given.  

 

In the Notice for a Business meeting, the company’s particulars are normally included in the notice. However, if 

notice is given for a meeting of a club or society, the secretary’s name, address and telephone number must be 

included. The date that the notice is issued must be reflected on the notice.  

 

The constitution of any organisation will set out what notice is required for specific meetings. It is important to 

note that the date on which the notice is posted and the day of the intended meeting are not included in the 

notice period. E.g. Notice of Meeting is dated 1st of June and 7 days notice are required, the earliest the meeting 

can be held is the 9th of June.  

 

Should a notice not be issued or not be sent out within the stipulated 

notice period, any decision taken at that meeting may be declared 

invalid. The Secretary will read the Notice of Meeting at the start of 

the meeting, thus making it part of the recorded minutes.  

 

Types of meetings 

↘ A	formal	meeting	is	controlled	by	a	chairperson	and	follows	a	definite	procedure. 	
o These	are	often	scheduled	at	least	a	week	in	advance,	but	can	also	be	called	at	short	notice	

when	the	situation	requires.	These	meetings	usually	take	place	in	a	controlled	environment	

such	as	a	boardroom	or	office	sizeable	enough	to	accommodate	all	the	required	participants.		

	

↘ An	informal	meeting	can	be	held	at	short	notice	to	discuss	important	issues	
o These	are	usually	called	at	very	short	notice	and	are	held	in	any	available	space,	large	enough	

to	accommodate	all	the	required	participants.		

	

↘ A	private	meeting	is	restricted	to	members	of	a	club,	society	or	company.	
o Private	meetings	are	scheduled	in	advance	and	the	area	required	for	it	will	be	large	enough	

to	accommodate	the	identified	participants.	These	meetings	are	usually	behind	closed	doors,	

as	its’	name	suggests.		
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↘ A	public	meeting	is	open	to	the	general	public	and	is	
advertised	on	billboards	or	in	the	media.	

o Public	meetings	must	be	scheduled	far	in	advance,	as	

the	public	needs	to	be	notified	about	the	meeting	and	

then	be	given	sufficient	time	to	make	the	necessary	

arrangements	for	the	meetings.	Most	often,	such	

meetings	are	arranged	in	conjunction	with	public	

transport	agencies	that	will	assist	in	the	transport	of	

the	general	public	to	and	from	the	meeting	places.	They	are	usually	held	in	large	halls	and	on	

big	open	areas	where	there	is	sufficient	space	for	everyone	to	attend.		

 

↘ A	routine	meeting	takes	place	weekly,	monthly	or	annually.	
o As	its’	name	suggests,	routine	meetings	are	structured	to	take	place	at	routine	times,	and	

therefore	will	have	routine	attendees.	This	makes	it	easier	for	the	time	and	place	to	be	set	as	

all	the	information	is	known	about	the	meeting	and	the	arrangements	can	be	made	

accordingly.		

	

↘ A	general	meeting	is	open	to	all	the	members	of	an	
organisation.	

o Once	again,	with	the	meeting	being	open	to	all	

the	members	of	the	organisation,	you	will	

always	find	some	people	who	will	not	be	

attending	the	meeting.	So	the	arrangements	

should	be	made	in	accordance	with	the	amount	

of	people	who	will	be	attending,	or	a	good	

estimate	thereof.	The	area	must	be	conducive	to	

the	size	and	the	seating	arrangements	for	the	estimated	attendees.	

	

↘ An	annual	general	meeting	(or	AGM)	is	held	once	a	year.		
o These	meetings	are	usually	planned	a	year	in	

advance,	with	regards	to	the	estimated	date	

thereof.	Attendees	are	invited	in	advance	and	will	

RSVP	to	ensure	that	the	proper	arrangements	can	

be	made	for	the	location	of	the	meeting.		
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The planning of effective meetings includes a variety of elements which need to be taken into consideration: 

i. The	purpose	of	the	meeting	must	be	clearly	defined	to	the	invited	attendees	so	that	they	understand	

what	will	be	discussed	and	so	that	they	can	complete	their	preparations	in	conjunction	with	the	

purpose	of	the	meeting.		

	

ii. The	agenda	for	the	meeting	must	be	well	planned	to	ensure	you	state	the	purpose,	items	to	be	

covered	and	the	allocated	timeframes	for	each	item.	Private	and	informal	meetings	won’t	always	

abide	by	these	as	they	are	usually	called	without	planning,	but	merely	to	discuss/resolve	a	matter	

which	requires	urgent/immediate	attention	or	an	outcome.		

	
iii. 	Selecting	the	participants	is	of	utmost	importance	to	the	outcome	of	the	meeting	as	this	will	ensure	

that	the	required	decision	makers	with	the	authority	to	do	so	or	the	expertise	to	assist	those	in	

making	the	correct	decisions	are	present	and	able	to	ensure	an	outcome	of	the	meeting.		

	
iv. Choosing	a	time	of	day	when	people	are	fresh	and	can	easily	concentrate,	is	of	utmost	importance.	

Timing	has	a	definite	impact	on	the	quality	of	the	meetings	and	the	outcome	thereof.	Tired	people	

who	attend	meetings	at	the	end	of	the	day	or	after	work	sometimes	find	concentration	difficult.	They	

tend	to	come	to	hasty	and	ill-advised	decisions	just	so	that	they	can	get	away	before	peak-hour	

traffic.	Don’t	confuse	attendance	with	performance!	However,	there	are	people	who	prefer	meetings	

at	this	time	rather	than	taking	the	time	during	the	day.		

	
v. What	is	the	purpose	of	the	meeting?	If	you	can’t	sum	the	purpose	of	the	meeting	up	in	one	sentence	

then	the	chances	are	that	you	don’t	need	to	have	the	meeting.	The	matters	to	be	discussed	at	a	formal	

meeting	are	found	on	the	agenda.	This	is	a	programme	of	the	subjects	to	be	discussed	in	the	order	in	

which	they	will	be	taken.	Send	the	agenda	to	members	of	a	group	7	to	14	days	in	advance	to	give	

them	the	time	to	study	the	items	in	detail.	The	secretary	in	consultation	with	the	chairperson	must	

prepare	the	agenda.	They	must	take	into	consideration	the	items	of	business	dealt	with	at	the	

previous	meeting.	Members	of	the	committee	or	board	can	submit	items	for	inclusion	before	the	

agenda	is	typed	and	circulated.		
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Arrange Venue and Catering 
Efficient organisation is essential in planning any major event. When starting to plan an event it is advisable to 

open a file in which everything relating to the event is kept. By working systematically through each of these key 

elements, an event of whatever size, nature and complexity can be successfully staged. The starting point is the 

preparation of a detailed checklist should go a long way towards ensuring a successful function/meeting. 

Whatever the event, some basic factors and decisions have to be taken into consideration, including: 

 

 Date	and	time	

Use	a	calendar	to	make	sure	there	is	clash	in	dates.	Be	aware	of	public	holidays	and	religious	

festivals.	Decide	on	the	time	the	event	should	start	and	finish.		

	

 Critical	path	

Prepare	an	overall	master	plan	and	develop	a	critical	path	plan,	identifying	decision	dates	for	all	key	

elements.		

	

 Theme	

Identify	a	theme;	brief	designers	who	will	interpret	this	theme	in	displays,	printed	matter	and	

exhibitions.	Select	relevant	speakers,	celebrities	and	special	guests.		

	

 Invitations	

Draw	up	a	list	of	people	who	is	required	to	attend	the	meeting	and	then	ensure	that	their	invitations	

are	sent	according	to	their	attendance	requirements.		

	

 Venue	

Book	a	suitable	venue	and	then	make	all	the	necessary	hotel	arrangements	for	lunches	and	overnight	

accommodation.	Confirm	these	arrangements	in	writing	as	well,	in	advance	and	provide	final	

numbers	by	telephone	48	hours	before	the	scheduled	arrival	time	of	the	attendees.		

	

 Printing	requirements	

Decide	on	the	printed	items	you	require	and	then	prepare	a	brief	and	allocate	the	task	to	an	allocated	

printer	or	internal	staff	member	if	the	organisation	has	the	capacity	to	do	the	printing.		

	

 Travel	

Confirm	all	the	travel	arrangements	with	the	relevant	parties	involved	and	ensure	that	all	the	VIP’s	

are	particularly	taken	care	of,	before,	during	and	after	their	parts	of	the	meeting.		
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 Catering	

Check	all	the	final	numbers	of	the	people	who	will	be	attending	and	then	advice	the	caterers	

accordingly.	Discuss	menus,	special	dietary	requirements,	special	table	settings	and	services	etc.	

With	the	caterers	so	that	every	person	present	is	properly	catered	for.		

	

 International	requirements	

In	becoming	a	more	and	more	popular	international	destination	for	meetings	and	gatherings,	South	

Africans	have	to	be	more	diligently	prepared	to	cater	for	the	international	needs	market.	People	such	

as	interpreters	and	meeting	communication	in	the	foreign	languages	must	be	prepared	for	as	well	to	

ensure	that	all	the	required	delegates	are	included	in	the	preparations.		

 

Once you have determined the date, size and number of delegates attending an event, the venue must be chosen 

and secured. You must elaborately research into the available venues and their suitability to your requirements. 

There are a number of sources of information you can access, including: 

• The	Yellow	Pages	

• Tourist	information	centres	in	the	relevant	areas	

• Conference	publications	

• Conference	placement	agencies	

• Conference	organisers	

• The	internet	

• Personal	recommendation	of	executives	who	have	attended	conferences	

 

The advantages of using a placement agency are the following: 

• You	will	save	time	and	money	by	researching	suitable	and	cost	effective	venues	

• The	agencies	can	usually	negotiate	better	prices	

• They	may	suggest	new	and	existing	venues	you	were	unaware	of	

• They	should	have	references	from	satisfied	clients.	Personal	recommendation	increases	the	safety	

margin	of	choosing	the	right	venue	

• They	can	provide	valuable	advice	regarding	possible	advantages	and	pitfalls	of	each	venue	

 

 

Types of venues 
There are several types of venues each with advantages and disadvantages.  

 

Hotels 
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The majority of conferences are held in hotels, they usually have conference rooms available, and meals and 

special functions like dinners and so on can easily be arranged. It is also easy to arrange accommodation since 

everything is on the same premises.  

 

Most of the larger hotels will have a conference organiser on staff that will assist you with all the arrangements. It 

is vitally important that clear lines of communication are put in place and that everything is confirmed in writing.  

 

Conference centres 

Centres specifically designed for conferences and meetings are growing in numbers; from well-equipped upper-

class centres to more informal bush-camp surroundings. South Africa has become a popular destination for 

international mega-conferences like the World AIDS conference and the Conference for Sustainable 

Development.  

 

Because these venues are specifically geared to conferences and meetings, they provide the ideal environment 

for medium to large events. They normally have an on-site conference organiser and can provide you with 

extensive published material on the centre.  

 

Universities 

Universities have excellent space available for conferences, meetings and other special events. Their lecture 

rooms are usually very modern and well equipped with audio-visual aids and other materials. University 

campuses can provide other facilities like art galleries, theatres, catering facilities and on-site accommodation. 

This environment is, in many ways, ideal for a conference. The major drawback of this venue is that it is only 

available when the university does not require the facilities.  

 

Business Schools 

Most Business Schools will accept outside bookings from time to time to fill up spare space. However this is not 

their core business and they do not assist or have the facilities for catering and administrative support.  

 

Other Venues 

There are a growing number of specialist venues, country houses and meeting rooms, which cater for the 

residential executive conference and meeting. Some are very exclusive and therefore very expensive. They vary in 

size but may be just what you require after some good investigation into the matter.  

Inspection Visits 

It is essential to visit the venue and inspect it before making your decision where to have the event. Contact the 

venue and discuss your requirements over the phone before you visit the establishment. If possible, try and 

arrange to see the facilities when they are being used for another event.  Insist on seeing everything and then 
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check everything against your required specifications. One way of making sure you do not miss anything is to 

draw up a checklist of what you need to see and establish.  

 

Amongst other things you need to keep the following in mind when visiting the venue: 

• Do	not	drop	your	standards	because	of	a	good	view	or	well	established	garden	

• Lecture	rooms	

• Accommodation	

• Restaurant	and	catering	facilities	

• Tables	and	chairs	

• Audio-visual	equipment	/	sound	reinforcement	/	fire	exits	/	air-conditioning	

• Kitchen,	restrooms	

• External	noise	factors	like	when	the	hotel	is	situated	close	to	the	airport	

• Administrative	support	that	is	offered	at	the	venue	

• Staff	at	the	venue;	is	there	sufficient	staff	to	cater	for	the	needs	of	your	delegated	and	are	they	well	

enough	trained	

 

It is wise to confirm everything in writing with the person at the venue you chose as most suitable. Give detailed 

instructions verbally but back it up in writing. Do not assume that something will be provided, request it and 

ensure that it is in line with your requirements. You will also then be sure of the costs and not be surprised with 

additional costs of equipment/items that you requested verbally.  

 

When you have chosen your venue, you must confirm this in writing. Some venues have a standard contract that 

you will be required to sign. It is essential that you are aware of their cancellation policy. Normally, they will 

require a deposit on the venue, which may or may not be refundable if the venue is cancelled.  

If you make a cancellation to close to the date of the vent, you may be liable for the whole fee. It is possible to 

obtain insurance against possible cancellation, for larger conferences this is advisable.  
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Travel, Car Hire and Accommodation Arrangements 
 

Travel, car-hire and accommodation requirements for all attendees must be established as soon as the RSVP’s 

have arrived back from the invitees. Travel arrangements should be made in groups to ensure that the best 

possible fares are obtained from the booking agents and that the invitees can travel in groups to ensure that their 

transport arrangements from the airport can be done in simultaneous form. This can help save on cost and can 

also be the start of a great team building situation.  

 

Accommodation must be arranged in accordance with the level of employees. When you are booking 

accommodation for sales representatives in masses, you may have to have two people sharing a large room in the 

hotel, rather than having each in their own room. But when dealing with executive directors and chief executive 

officers of multi-national corporations, it is suggested that you up the level of accommodation for them. In many 

instances when the amount of people attending large events are so great, the entire hotel may even be booked 

out, which could result in a better rate for the organiser/company but will definitely require a very large deposit 

to be paid, which will not be refundable in the event of cancellation.  

 

You are now ready to go through a check list. Be honest with yourself. 

 

Tick the box with either a √ or an X to indicate your response. 
	

□ I	am	able	to	identify	a	date,	venue	and	time	for	meeting	or	event		
□ I	am	able	to	liaise	or	negotiate	with	meeting	attendees	regarding	availability		
□ I	am	able	to	book	venues	and	catering		
□ I	am	able	to	finalise	meeting	room	arrangements		
□ I	am	able	to	make	travel,	car	hire	and	accommodation	arrangements		
□ I	am	able	to	notify	and	confirm	arrangements	with	attendees	or	stakeholders		
□ I	am	able	to	process	and	distribute	all	documentation	required	for	the	meeting	or	

event		
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You	must	think	about	any	point	you	could	not	tick.	Write	this	down	as	a	goal.	

Decide	on	a	plan	of	action	to	achieve	these	goals.	Regularly	review	these	goals.	

 

 

 

 

 

 

 

 

My	Goals	and	Planning:	
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________

________________________________________________________________________________________
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The learner will be able to maintain, determine, record and confirm bookings on a manual and computer system  

Unit Standard 7706  
 

SPECIFIC	OUTCOMES	AND	RELATED	ASSESSMENT	CRITERIA	

SO	1	
Explain	the	importance	of	giving	accurate	information	to	customers		
(Explain	the	importance	of	giving	accurate	information	to	customers	and	the	need	to	be	aware	of		
time.)	

SO	2	
Explain	the	reasons	for	providing	an	efficient	service		
(Explain	the	reasons	for	providing	an	efficient	service	in	terms	of	company	profitability	and	repeat		
guest	business.)		

SO	3	 Explain	the	need	to	meet	customer	expectations	in	terms	of	knowledge	of	services	and	
facilities.		

SO	4	
Explain	the	importance	of	taking	deposits	in	terms	of	'no	shows'		
(Explain	the	importance	of	taking	deposits	in	terms	of?	no	shows?	and	of	accurately	recording	and		
filing	details	of	bookings.)		

SO	5	
Explain	the	reasons	for	keeping	bookings	up	to	date	and	following	up	on	unconfirmed	
bookings.		
(Range	of	records:	daily,	weekly,	monthly)		

SO	6	 Explain	the	importance	of	keeping	other	departments	informed	of	current	and	future	
bookings.		

SO	7	

Given	a	range	of	customers,	deal	with	customers	politely	and	efficiently		
(Given	a	range	of	customers,	deal	with	customers	politely	and	efficiently	and	identify	their		
requirements	correctly.	(Range	of	customers:	booking	agencies,	customers	with	communication	
difficulties,	customers	with	mobility	difficulties,	regular	customers	or	VIPs,	customers	requiring	
bookings	for	groups	)	

SO	8	 Give	customers	accurate	information	and	meet	their	enquiry	needs.		

SO	9	

Promote	the	establishment’s	services	and	facilities	at	all	appropriate	times	and	explain	
why.		
(Range	of	services	and	facilities:	sleeping	accommodation,	conference,	function,	exhibition		
room,	and	restaurants	)	

SO	10	 Determine	the	availability	of	services	and	facilities	correctly	and	communicate	this	clearly.	
SO	11	 Offer	alternative	facilities	to	customers	and	explain	the	importance	of	doing	this.		

SO	12	
Given	a	range	of	bookings,	take	down	the	details	and	record	the	booking		
(Given	a	range	of	bookings,	take	down	the	details	and	record	the	booking	using	a	manual	or	
computerised	booking	system.	(Range	of	bookings:	telephone,	face-to-face,	letters,	fax,	internet.)		

SO	13	 Provide	customers	with	confirmations	of	bookings	and	all	relevant	information.		

SO	14	
Confirm	the	bookings	and	request	deposits	from	customers		
(Confirm	the	bookings	and	request	deposits	from	customers	as	appropriate	per	organisational		
requirements.)	

SO	15	

Given	a	range	of	amendments,	choose	a	procedure	and	give	reasons	for	the	method	chosen	
(Range	of	booking	amendments:	change	in	services	or	facilities	required,	change	in	date	or		
time	required,	change	in	customers	personal	details,	change	in	number	of	people,	booking		
cancellations	)	

SO	16	
Given	a	system	failure	or	error	in	manual	systems,	decide	what	action	to	take.			
(Given	a	system	failure	or	error	in	manual	systems,	decide	what	action	to	take	as	appropriate	and		
explain	why.	(Range	of	system	failure:	equipment	/system	failure	or	errors	in	manual	system	)	

SO	17	 Carry	out	all	work	in	an	organised	and	efficient	manner	taking	account	of	priorities.		

SO	18	
Describe	situations	where	a	guest's	booking	has	been	cancelled	incorrectly.		
(Describe	situations	where	a	guest's	booking	has	been	cancelled	incorrectly	and	how	the	problem		
could	be	solved.)		

SO	19 
In	a	different	type	of	establishment	describe	how	performance	would	be	adapted.		
(In	a	different	type	of	establishment	(B	&	B,	game	lodge)	describe	how	performance	would	be		
adapted	in	maintaining	a	booking	system.)	
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										CRITICAL	CROSS	FIELD	OUTCOMES	
Embedded	knowledge	and	Critical	cross-field	outcomes	have	been	included	within	the	specific	outcomes	
category.		
This	has	been	done	as	it	was	deemed	necessary	to	ensure	holistic	assessment	occurred.		
The	specific	outcomes	can	be	applied	in	a	range	of	contexts.		
Many	of	the	outcomes	have	been	written	in	such	a	way	that	competence	must	be	demonstrated	in	the	
context	as	opposed	to	in	isolation	from	a	context.		
The	specific	outcomes	are	comparable	to	outcomes	used	internationally.		
We	therefore	structured	outcomes	using	the	format	noun	+	verb	+	condition	(modifying	phrase)		
	
Specific	outcomes	have	been	split	into	three	categories		
a)	knowledge	and	understanding	(what	the	learner	must	know	and	understand		
b)	decision-making	and	acting	(what	the	learner	must	do)		
c)	adapting	performance	(	including	reflexive	competence)		
	
In	many	instances	there	are	more	than	six	specific	outcomes,	as	the	inclusion	of	critical	cross-field	
outcomes	and	embedded	knowledge	has	increased	the	number	of	specific	outcomes.	If	competencies	are	to	
be	clustered	in	a	meaningful	way,	then	these	unit	standards	cannot	be	split.		
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All qualifications and part qualifications registered on the National Qualifications Framework are public 
property. Thus the only payment that can be made for them is for service and reproduction. It is illegal to 
sell this material for profit. If the material is reproduced or quoted, the South African Qualifications 
Authority (SAQA) should be acknowledged as the source.  

SOUTH AFRICAN QUALIFICATIONS AUTHORITY  

REGISTERED UNIT STANDARD:  

 

Maintain a Booking System  

SAQA US ID UNIT STANDARD TITLE 

7706  Maintain a Booking System  

ORIGINATOR ORIGINATING PROVIDER 

SGB Hospitality,Tourism,Travel, Leisure 
and Gaming  

  

QUALITY ASSURING BODY 

-   

FIELD SUBFIELD 

Field 11 - Services Hospitality, Tourism, Travel, Gaming and 
Leisure  

ABET BAND UNIT STANDARD 
TYPE 

OLD NQF LEVEL NEW NQF LEVEL CREDITS 

Undefined  Regular  Level 3  NQF Level 03  3  

REGISTRATION STATUS REGISTRATION 
START DATE 

REGISTRATION END 
DATE 

SAQA DECISION 
NUMBER 

Reregistered  2009-11-03  2012-06-30  SAQA 0160/05  

LAST DATE FOR ENROLMENT LAST DATE FOR ACHIEVEMENT 

2013-06-30    2016-06-30    

 

In all of the tables in this document, both the old and the new NQF Levels are shown. In the text (purpose statements, 

qualification rules, etc), any reference to NQF Levels are to the old levels unless specifically stated otherwise.  

 
This unit standard does not replace any other unit standard and is not replaced by any other unit standard.  

 

PURPOSE OF THE UNIT STANDARD  
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The learner will be able to maintain, determine, record and confirm bookings on a manual and computer system  

 

LEARNING ASSUMED TO BE IN PLACE AND RECOGNITION OF PRIOR LEARNING  

None  

 

UNIT STANDARD OUTCOME HEADER  

Demonstrated knowledge and understanding  

 

Specific Outcomes and Assessment Criteria:  

 

SPECIFIC OUTCOME 1  

Explain the importance of giving accurate information to customers  

OUTCOME NOTES  

Explain the importance of giving accurate information to customers and the need to be aware of  
time.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner?s ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner?s ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 2  
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Explain the reasons for providing an efficient service  

OUTCOME NOTES  

Explain the reasons for providing an efficient service in terms of company profitability and repeat  
guest business.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner?s ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner?s ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 3  

Explain the need to meet customer expectations in terms of knowledge of services and facilities.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner?s ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
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•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner?s ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 4  

Explain the importance of taking deposits in terms of 'no shows'  

OUTCOME NOTES  

Explain the importance of taking deposits in terms of ?no shows? and of accurately recording and  
filing details of bookings.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner?s ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner?s ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 5  

Explain the reasons for keeping bookings up to date and following up on unconfirmed bookings.  
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OUTCOME RANGE  

Range of records: daily, weekly, monthly  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 6  

Explain the importance of keeping other departments informed of current and future bookings.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
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change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 7  

Given a range of customers, deal with customers politely and efficiently  

OUTCOME NOTES  

Given a range of customers, deal with customers politely and efficiently and identify their  
requirements correctly.  

OUTCOME RANGE  

Range of customers: booking agencies, customers with  
communication difficulties, customers with mobility difficulties, regular customers or VIPs,  
customers requiring bookings for groups  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  
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SPECIFIC OUTCOME 8  

Give customers accurate information and meet their enquiry needs.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 9  

Promote the establishment?s services and facilities at all appropriate times and explain why.  

OUTCOME RANGE  

Range of services and facilities: sleeping accommodation, conference, function, exhibition  
room, and restaurants  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  



SDA | MODULE 2 | STUDENT GUIDE 36 

 

questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 10  

Determine the availability of services and facilities correctly and communicate this clearly to the  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 11  

Offer alternative facilities to customers and explain the importance of doing this.  

 
ASSESSMENT CRITERIA  
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ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 12  

Given a range of bookings, take down the details and record the booking  

OUTCOME NOTES  

Given a range of bookings, take down the details and record the booking using a manual orcomputerised booking 
system.  

OUTCOME RANGE  

Range of bookings: telephone, face-to-face, letters, fax,  
internet  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
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•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 13  

Provide customers with confirmations of bookings and all relevant information.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 14  

Confirm the bookings and request deposits from customers  

OUTCOME NOTES  

Confirm the bookings and request deposits from customers as appropriate per organisational  
requirements.  
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ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 15  

Given a range of amendments, choose a procedure and give reasons for the method chosen.  

OUTCOME RANGE  

Range of booking amendments: change in services or facilities required, change in date or  
time required, change in customers personal details, change in number of people, booking  
cancellations  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
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•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 16  

Given a system failure or error in manual systems, decide what action to take  

OUTCOME NOTES  

Given a system failure or error in manual systems, decide what action to take as appropriate and  
explain why.  

OUTCOME RANGE  

Range of system failure: equipment /system failure or errors in manual system  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 17  
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Carry out all work in an organised and efficient manner taking account of priorities.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 18  

Describe situations where a guest's booking has been cancelled incorrectly  

OUTCOME NOTES  

Describe situations where a guest's booking has been cancelled incorrectly and how the problem  
could be solved.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
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•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

SPECIFIC OUTCOME 19  

In a different type of establishment describe how performance would be adapted  

OUTCOME NOTES  

In a different type of establishment (B & B, game lodge) describe how performance would be  
adapted in maintaining a booking system.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Arrange or create an environment in which the learner can be fairly assessed against the  
outcomes.  
•  This unit must be assessed in a realistic working environment.  
•  It is recommended that this unit standard be assessed in conjunction with other unit  
standards.  
2. Evaluate the learner's ability to meet the outcomes consistently.  
•  This unit standard can be assessed by a combination of observation, product sample and  
questioning.  
•  Observation to cover the monitoring, maintaining and confirmation of bookings.  
•  Simulation to cover amendments and system failure. (Range of booking amendments:  
change in services or facilities required, change in date or time required, change in customers  
personal details, change in number of people, booking cancellations)  
•  Product sample relevant documentation.  
3. Provide specific feedback to the learner on assessments and the learner's ability to meet the  
outcomes.  
4. Complete the declaration of competence and inform the appropriate ETQA once the learner has  
demonstrated the ability to meet all the outcomes.  
5. Counsel the learner on future assessments, necessary learning and further qualifications.  

 

UNIT STANDARD ACCREDITATION AND MODERATION OPTIONS  
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1. Anyone assessing a learner against this unit standard must be registered as an assessor with the relevant ETQA.  
 
2. Any institution offering learning that will enable achievement of this unit standard must be registered with the 
FE/HE Registrar.  
 
3.Any institution wishing to receive skill development grants must be accredited with the relevant ETQA. Such an 
institution will also be registered with the relevant SETA.  
 
4. Moderation of assessment will be done by the relevant ETQA at its discretion.  

 

UNIT STANDARD ESSENTIAL EMBEDDED KNOWLEDGE  

Embedded knowledge and Critical cross-field outcomes have been included within the specific outcomes category.  
 
This has been done as it was deemed necessary to ensure holistic assessment occurred.  
 
The specific outcomes can be applied in a range of contexts.  
 
Many of the outcomes have been written in such a way that competence must be demonstrated in the context as 
opposed to in isolation from a context.  
 
The specific outcomes are comparable to outcomes used internationally.  
 
We therefore structured outcomes using the format noun + verb + condition (modifying phrase)  
 
Specific outcomes have been split into three categories  
a) knowledge and understanding (what the learner must know and understand  
b) decision-making and acting (what the learner must do)  
c) adapting performance ( including reflexive competence)  
 
In many instances there are more than six specific outcomes, as the inclusion of critical cross-field outcomes and 
embedded knowledge has increased the number of specific outcomes.  
If competencies are to be clustered in a meaningful way, then these unit standards cannot be split.  
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US 7706: MAINTAIN A BOOKING SYSTEM 
 

Meeting Customers Needs and Expectations 
 

very organisation needs customers 

To survive, every organisation needs customers. A customer buys an organisation's products and 

services because these products and services give the 

customer ‘benefits’. For example, the benefit of buying a 

cool drink on a hot day is that it will quench your thirst. Here the drink 

seller offers you, as the cool drink buyer, the benefit of reducing your 

thirst. 

 

So, what is customer service? 

‘Customer service is about providing superior service to encourage 

customers to keep buying your product or service’ (Gerson RF (1992) 

Beyond customer service. Crisp Publishing Inc.: New York). 

 

Or is it? 

Henry Mintzberg, the eminent business strategy guru, delights in saying that: 

‘Customer service is when they smile at you in the front office while trying to figure out how to squeeze more 

money out of you in the back office.’ (See Mitzberg H (2001) Why I hate flying, Strategy + Business. Booz Allen & 

Hamilton, Issue 22, 1st Q 2001.) 

 

Most of the books and journal articles on customer service define it as the range of help and support offered to 

customers before, during and after a sale has been made. This may apply to a customer who buys goods, or uses 

the services of an organisation, for example an appliance repair service. 

 

Experts agree that the key steps to delivering quality customer service are: 

• determining customer needs 

• meeting customer needs 

• monitoring service and solving problems 

 

E 
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Who	are	your	customers?	

We	usually	think	of	organisational	customers	as	the	people	who	purchase	or	use	the	organisation's	products	

and	services.	However,	if	we	look	closely	there	is	a	range	of	customers	in	an	organisation.	These	include:	

	

Internal	customers	

Internal	customers	who	use	products	or	services	provided	by	the	organisation	and	belong	to	the	

organisation.	

	

External	customers	

External	customers	who	use	products	or	services	provided	by	the	organisation	but	come	from	outside	the	

organisation	

	

Direct	customers	

Direct	customers	who	deal	directly	with	an	organisation	

	

Indirect	customers	

Indirect	customers	who	use	an	organisation's	product	or	service	but	have	no	direct	involvement	with	the	

organisation	

	

Existing	customers	

Existing	customers	are	those	customers	who	already	use	the	organisations	products	or	services.	

	

Potential	customers		

Potential	customers	are	those	customers	the	organisation	would	like	to	gain.		

For	example,	when	you	buy	your	lunchtime	sandwich	from	a	milk	bar,	you	are	a	direct	customer	of	the	milk	

bar.	But	you	are	also	an	indirect	customer	of	the	bakery	that	has	supplied	the	bread	to	the	milk	bar.		

	

If	you	do	not	like	the	bread	you	may	complain	to	the	milk	bar	and	ask	them	to	use	different	bread,	but	you	

are	unlikely	to	talk	to	the	baker.	The	outcome	is	that	the	baker	may	lose	a	customer	(the	milk	bar)	and	never	

know	why.	

	

Indirect	customers	are	less	obvious	and,	on	occasions,	unknown,	but	they	are	still	customers.	

	

Good	vs	bad	customer	service	

Cole	(2001)	suggests	that	the	following	elements	make	up	‘horrible’	and	‘sensational’	customer	service.	
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Horrible	customer	service	

• use	of	jargon	or	acronyms	during	a	conversation	

• being	given	bad	advice	on	an	organisation’s	products	and	services	

• providing	insufficient	information	to	the	customer	during	communication	with	the	service	or	

product	provider	

• customers	needing	to	keep	asking	the	same	thing	

• difficulty	in	gaining	access	to	speak	to	a	responsible	person	who	can	help	

• not	returning	phone	calls	or	keeping	promises	

• incorrectly	filling	an	order.	

	

Sensational	customer	service	

• being	helpful	and	empathetic	to	the	customer	

• mistakes	are	fixed	quickly	—	no	questions	asked	

• being	attentive	to	the	customer,	e.g.	looking	at	the	customer	

• being	knowledgeable	about	the	product	or	service	

	

Customer	service	benchmarks	(levels	of	customer	service)	
Not	all	customer	service	is	the	same.	We	know	from	our	own	experience	that	customer	service	comes	in	

many	forms	and	at	different	levels.	Organisations	offer	four	general	levels	of	service:	

	

Minimum	

This	is	the	minimum	acceptable	standard	of	customer	service	a	customer	will	accept.	These	are	the	things	

that	the	customer	takes	for	granted	will	be	provided	by	the	organisation.	A	customer	may	elect	not	to	do	

business	with	an	organisation	if	this	basic	level	of	service	is	not	met.	For	example:	

‘Of	course	the	café	will	have	a	chair	for	me	to	sit	on.’	

	

Expectations	met	

This	is	the	service	that	a	customer	expects	from	an	organisation.	Customers	tend	to	do	business	grudgingly	

with	organisations	that	only	meet	but	do	not	exceed	the	‘expected’	level	of	service.	For	example:	‘I	expect	

that	chair	clean.’	

	

Expectations	exceeded	

This	is	the	service	that	a	customer	would	like.	When	the	desired	customer	service	needs	are	met,	a	customer	

tends	to	be	happy	to	do	regular	business	with	the	organisation.	Customers	will	tend	to	stay	with	the	

organisation	until	a	competitor	offers	sensational	customer	service.	For	example:	‘I’d	also	like	the	chair	to	be	

comfortable.’	
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Exceptional	

Exceptional	service	‘delights’	the	customer.	This	is	the	type	of	service	that	makes	a	customer	stand	back	and	

say	‘wow’.	This	type	of	service	wins	loyalty	from	customers	and	builds	the	business	via	word	of	mouth.	For	

example:	

‘Someone	holds	the	chair	for	me	as	I	sit	down,	brings	the	food	to	me,	and	treats	me	like	royalty!’	Think	about	

your	last	visit	to	your	local	butcher,	newsagency,	bakery	or	hotel	—	which	of	these	four	levels	were	met?	On	

what	did	you	base	your	response?	

	

Moments	of	truth	
One	of	the	basic	concepts	used	in	customer	service	is	that	of	moments	of	truth.	This	concept	was	developed	

by	Jan	Carlzon,	CEO	of	Scandinavian	Air	Services	(SAS)	in	the	1980s	to	describe	the	aspects	of	customer	

contact	that	the	organisation	needed	to	control	to	ensure	a	positive	impression	for	a	customer.		

	

What	is	a	moment	of	truth?	

A	moment	of	truth	is	defined	as:	

An	episode	in	which	a	customer	comes	into	contact	with	an	aspect	of	the	organisation,	however	

remote,	and	thereby	has	an	opportunity	to	form	an	impression	

Carlzon	J	(1989)	Moments	of	truth	—	new	strategies	for	today’s	customer-driven	economy,	Harper	Collins:	

New	York	p3	

	

Carlzon	also	said:		

Last	year	each	of	our	10	million	customers	came	in	contact	with	approximately	five	SAS	employees,	

and	this	contact	lasted	an	average	of	15	seconds	each	time.	Thus,	SAS	is	‘created’	15	million	times	a	

year,	15	seconds	at	a	time.	These	50	million	‘moments	of	truth’	are	the	moments	that	ultimately	

determine	whether	SAS	will	succeed	or	fail	as	a	company.	They	are	the	moments	when	we	must	

prove	to	our	customers	that	SAS	is	their	best	alternative.		

A	moment	of	truth	can	be	a	face-to-face	contact,	a	telephone	contact	or	an	electronic	contact	(eg	web	

page/	email).	The	important	point	about	a	moment	of	truth	is	that	it	is	a	critical	factor	in	building	

the	relationship	between	customers	and	organisations.	Moments	of	truth	allow	the	customer	to	

make	a	judgement	about	the	quality	of	customer	service	offered	by	an	organisation	and	therefore	

develop	a	personal	view	of	what	they	think	about	the	organisation.		

	

Carlzon	J	(1989)	Moments	of	truth	—	new	strategies	for	today’s	customer-driven	economy,	Harper	Collins:	

New	York,	p	3.	A	moment	of	truth	with	‘basic’	customer	service	can	therefore	colour	a	customer’s	view	of	the	

whole	organisation.	
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hy	customers	stop	doing	business	with	an	organisation	
If	a	customer	fails	to	form	a	positive	impression	during	a	moment	of	truth,	or	the	

organisation	fails	to	deliver	the	opportunity	for	a	positive	moment	of	truth,	the	

customer	may	choose	to	stop	doing	business	with	the	organisation.	

	

Why	do	customers	cease	to	do	business	with	an	organisation?	Some	of	the	reasons	are:	

• 1%	of	them	die	

• 4%	move	to	a	new	location	and	do	business	with	somebody	else	

• 6%	develop	new	relationships	and	move	their	custom	

• 9%	move	to	the	competition	that	are	offering	better	deals	

• 10%	for	an	unknown	reason	

• 70%	stop	being	customers	because	they	feel	undervalued	by	the	organisation	during	a	moment	of	

truth	with	that	organisation	(eg	indifference	by	an	employee	of	the	organisation	during	a	

transaction).	

	

Only	4%	of	the	customers	who	are	dissatisfied	complain;	96%	simply	melt	away	and	do	not	tell	you.	Of	those	

96%,	91%	will	never	do	business	with	you	again.		

Collis	J	(1992)	Your	business	is	your	customer,	McGraw	Hill	Book	Company:	Sydney.	

	

We	can	safely	say	that	the	bottom	line	is:		
Customer	service	is	only	as	good	as	the	customers	say	it	is.	And	customers	only	rate	service	as	‘good’	

if	their	needs	are	being	met.		

Now	let’s	look	at	general	categories	of	customer	needs,	and	how	to	determine	the	specific	needs	of	your	

customers.	

	

Meeting	customer	needs	

Delivering	great	service	relies	on	meeting	customers’	needs.	Let's	look	at	how	we	can	use	the	information	we	

have	about	customers	and	their	needs	to	develop	a	service	plan.	

	

Service	objectives	

The	first	step	in	planning	is	to	determine	your	goals	or	objectives.	The	customer	service	objective	will	

determine	the	level	of	customer	service	to	be	delivered.	Earlier	we	looked	at	the	four	levels	of	service:	

• minimum	

• expectations	met	

• expectations	exceeded	

W	
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• exceptional.	

While	we	might	like	to	aim	for	‘exceptional’	service	all	the	time,	we	know	that	service	at	this	level	comes	

with	a	cost,	for	example	staff	training	and	additional	resources.	However,	in	establishing	objectives	for	

service	you	need	to	consider	more	than	just	cost.	Other	issues	include	the	infrastructure	of	the	business,	the	

type	of	work	performed,	the	type	of	customers,	activities	of	competitors,	and	the	nature	of	the	industry.	

	

Planning		

Once	the	objectives	are	established	and	accepted,	the	planning	process	to	achieve	them	commences.	

Planning	is	the	framework	that	provides	the	direction	for	what	needs	to	be	done,	how	it	will	be	done	and	the	

standards	against	which	results	will	be	assessed.	

	

Involving	your	team	in	this	process	is	perhaps	to	most	powerful	way	to	motivate	them	to	work	towards	its	

success.	And	because	they	are	the	people	closest	to	the	customers,	you’ll	also	get	some	great	ideas	about	how	

to	meet	the	service	objectives.	

	

Planning	tools	

There	are	many	planning	tools	to	help	you	ensure	that	you	are	delivering	service	that	matches	your	

customers’	needs.	One	of	the	most	useful	for	frontline	managers	to	use	with	their	teams	is	called	the	cycle	of	

service.	

	

Service	process	mapping	/	service	blueprinting	

The	cycle	of	service	is	a	form	of	service	process	mapping,	or	customer	service	blueprinting.		

	

What	is	the	cycle	of	service?	

It	is	all	of	the	‘moments	of	truth’	that	make	up	the	customer’s	experience	in	a	service	interaction.	

Remember	the	definition	of	‘moment	of	truth’:		

An	episode	in	which	a	customer	comes	into	contact	with	an	aspect	of	the	organisation,	however	

remote,	and	thereby	has	an	opportunity	to	form	an	impression	

	

Start	by	thinking	about	moments	of	truth,	and	think	about	the	quality	of	service	you	are	providing.	Examine	

your	customers’	experiences	and	focus	on	how	the	customer	sees	these	experiences	in	terms	of	the	

organisation.	If	you	can	see	things	as	the	customer	sees	them,	then	you	have	arrived	at	a	moment	of	truth.	

From	there,	you’ll	be	in	a	much	better	position	to	define,	deliver	and	measure	the	quality	of	service	you	are	

offering.	

	

Customers	don’t	consciously	look	for	moments	of	truth	—	what	they	want	is	to	have	their	needs	met.	You	

can	meet	these	needs	by	going	through	a	whole	process	from	beginning	to	end	—	a	cycle	of	service.		
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Cycle	of	service	example	

Let’s	relate	the	cycle	of	service	map	to	the	simple	

example	of	going	to	the	movies.	The	cycle	begins	at	

some	identifiable	point	of	customer	experience,	such	

as	seeing	an	advertisement	for	the	film	or	talking	to	a	

friend	who	recommends	it.		

What	does	the	customer	experience?	Arriving	at	the	

theatre,	finding	a	parking	place,	standing	in	line	to	

buy	tickets,	and	waiting	in	line	to	enter	the	theatre	

are	just	some	of	them.	As	you	trace	the	experiences	of	

the	customer	such	as	visiting	the	rest	room,	standing	in	line	for	refreshments,	and	searching	for	a	seat,	you	

begin	to	realise	that	the	experience	of	visiting	a	cinema	includes	much	more	than	just	sitting	in	a	seat	

watching	a	movie.		

 

We	can	say	that	each	part	of	the	customer’s	experience	is	a	moment	of	truth	for	the	organisation.	Each	point	

on	the	cycle	of	service	has	an	impact	on	the	customer	—	not	just	the	final	service	of	seeing	a	movie.	If	the	

movie	itself	is	enjoyable	but	the	place	is	dirty,	

parking	is	a	problem,	the	theatre	is	located	in	a	

dangerous	neighbourhood,	or	noisy	patrons	

interfere	with	the	enjoyment	of	the	other	

customers,	the	theatre	will	be	perceived	as	

having	a	service	quality	problem.	The	customer	

came	to	the	theatre	to	see	a	movie	but	also	

experienced	some	less	desirable	things.	Some	

customers	will	complain	about	the	dirt	and	the	

noisy	patrons,	but	other	customers	will	simply	

never	return	to	that	cinema.	

For	each	experience	the	customer	has	in	the	cycle	

of	service,	the	customer	consciously	or	

unconsciously	rates	the	experience	as	satisfactory,	unsatisfactory	or	superior.	This	assessment	will	

determine	whether	the	customer	will	use	the	service	again	or	choose	to	go	elsewhere.	Taking	a	holistic	

approach	to	interactions	with	customers,	we	can	help	to	deliver	customer	service	that	will	meet	or	exceed	

customers’	needs.	
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sing	the	cycle	of	service	map	
Here	is	a	guide	to	using	the	cycle	of	service	map	with	your	team	as	a	way	of	determining	

customer	needs	and	planning	service	delivery	to	meet	those	needs.	

	

1.	Map	a	typical	service	experience	from	the	customer’s	point	of	view	

Using	a	blank	cycle	of	service	map	(a	large	circle	with	a	defined	beginning	and	end	point),	map	a	typical	

service	experience	or	interaction	from	the	customer’s	point	of	view.		

	

Start	by	asking:	‘When	does	the	customer’s	interaction	with	us	begin?	What	does	the	customer	experience	at	

this	point?’	Then	follow	the	customer’s	experience	to	the	end	of	that	interaction,	noting	each	action	until	the	

end	of	that	experience.		

	

For	example,	the	following	points	might	represent	the	typical	experience	that	a	customer	has	when	having	a	

drink	in	a	bar:	

1. customer	walks	into	the	bar	

2. customer	stands	at	the	bar	service	area	

3. customer	is	greeted	by	the	bar	attendant	

4. customer	gives	drink	order	

5. customer	receives	drink	order	

6. customer	takes	a	seat	at	the	bar	or	a	table	

7. customer	drinks	the	drink	

8. customer	leaves	the	bar	

	

Now,	look	at	each	point	on	the	cycle	of	service	and	ask:	‘What	does	the	customer	need	at	that	point?’	This	

will	give	you	an	indication	of	what	the	customer	regards	as	either	‘basic’	or	‘expected’	service.		

	

For	example,	when	the	customer	receives	the	drink	order	he	or	she	probably	expects	that	the	drink	is	in	a	

clean	glass	on	a	coaster	and	that	it	is	the	drink	that	was	ordered.	For	most	customers,	this	would	be	basic	

service.	These	first	two	steps	involve	you	putting	yourself	in	the	customer’s	shoes.		

	

Now	put	the	focus	back	on	you	and	your	team.	

U	
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2.	Recognise	that	each	point	on	the	cycle	of	service	is	a	moment	of	truth	for	your	service	team.		

Ask:	‘What	does	your	team	need	to	DO	to	meet	the	customer’s	needs	at	each	point?’	Using	the	example	

above,	we	can	say	that	to	meet	the	customer’s	needs	the	bar	attendant	should:	

1. ensure	that	the	drink	order	is	correct	

2. present	the	drink	to	the	customer	in	a	clean	glass	

3. present	the	drink	to	the	customer	on	a	coaster	

	

In	this	instance,	the	moment	of	truth	has	been	managed	well	by	the	bar	attendant.	

	

3.	Ask	‘What	is	your	service	objective	for	this	interaction?”	

Also	ask	‘What	do	you	need	to	do	to	fulfil	this	objective?’	For	instance,	if	your	objective	involves	delivering	

sensational	service	in	this	interaction,	what	do	you	need	to	do	in	addition	to	meeting	the	customer’s	basic	

needs	and	expectations?	What	will	‘wow’	the	customer?	For	example,	to	exceed	a	customer’s	basic	service	

expectations	a	bar	attendant	might	give	the	customer	a	complimentary	bowl	of	nuts	or	pretzels	with	the	

drink	order.	

	

4.	Agree	on	the	service	objectives	and	what	you	need	to	do	as	a	team	to	achieve	them.	

Develop	an	action	plan	with	team	input.	This	template	might	be	helpful.	

Sample	action	plan	to	achieve	service	objective	

Service objective: Reduce customer waiting time in the ticket queue by an average of two minutes per customer. 
Action	Step	 	 Est.	Time	 Target	Date	 Responsible	
1	 Review	ticket	issuing	software	 1	week	 31	May		 JW	
2		 Train	staff	in	effective	selling	and	customer	

management	techniques	
3	days	 15	June		 MB	

3	 Review	queuing	system	 3	days	 18	June		 TL	
4	 Investigate	pre-purchase	options	 1	week	 20	June		 SL	
5	 Implement	and	monitor	new	initiatives	 4	weeks	 end	July	 All	
6	 Evaluate	new	initiatives	 2	weeks	 15	August		 MB	
7	 Present	recommendations	from	evaluation	to	team	 1	day	 20	August		 MB	
	

5.	Achieve	the	objectives	—	willingly	and	consistently.	
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ealing with customers 

It is easy to work with people you like, and it is even easier to work with people who like you. But 

that's not always the case. Sooner or later, you'll have to deal with a difficult customer. Difficult 

customers come in a wide variety. There are those whose personality rubs you the wrong way.  

 

They may not be difficult for someone else, but they are for you. And then there are those who are difficult for 

everyone: Picky people, know-it-alls, egocentrics, fault-finders, constant complainers, etc. Every salesperson can 

list a number of the types.  

 

But perhaps the most difficult for everyone is 

the angry customer. This is someone who feels 

that he or she has been wronged, and is upset 

and emotional about it. These customers 

complain, and they are angry about something 

you or your company did.  

 

There are some sound business reasons to 

become adept in handling an angry customer. 

Research indicates that customers who complain are likely to continue doing business with your company if they 

feel that they were treated properly. 

 

 It's estimated that as many as 90% of customers who perceive themselves as having been wronged never 

complain, they just take their business elsewhere. So, angry, complaining customers care enough to talk to you, 

and have not yet decided to take their business to the competition. They are customers worth saving.  

 

Not only are there benefits to your company, but you personally gain as well. Become adept at handling angry 

customers, and you’ll feel much more confident in your own abilities. If you can handle this, you can handle 

anything. While any one can work with the easy people, it takes a real professional to be successful with the 

difficult customers. Your confidence will grow, your poise will increase, and your self-esteem will intensify.  

 

On the other hand, if you mishandle it, and you'll watch the situation dissolves into lost business and upset 

people. You may find yourself upset for days. So, how do you handle an angry, complaining customer? Let's begin 

with a couple tools you can use in these situations.  

 

D 
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RESPECT 

It can be difficult to respect a person who may be yelling, swearing or behaving like a two-year-old. I'm not 

suggesting you respect the behaviour, only that you respect the person. Keep in mind that 99 times out of 100 

you are not the object of the customer's anger. You are like a small tree in the path of a swirling tornado.  

 

But unlike the small tree, you have the power to withstand the wind. What is the source of your power? Unlike 

the customer, you are not angry, you are in control, and your only problem at the moment is helping him with his 

problem.  

 

If you step out of this positioning, and start reacting to the customer in an emotional way, you'll lose control, 

you’ll lose your power, and the situation will be likely to escalate into a lose-lose for everyone. So, begin with a 

mind-set that says, "No matter what, I will respect the customer."  

 

EMPATHY 

Put yourself in the customer's shoes, and try to see the situation from his/her perspective. Don't try and cut him 

off, don't urge him to calm down. Instead, listen carefully. If someone is angry or upset, it is because that person 

feels injured in some way.  

 

Your job is to let the customer vent and to listen attentively in order to understand the source of that frustration. 

When you do that, you send a powerful unspoken message that you care about him and his situation.  

 

Often, as the customer comes to realize that you really do care and that you are going to attempt to help him 

resolve the problem, the customer will calm down on his own, and begin to interact with you in a positive way. 

Here's how you can use these two tools in an easily-remembered process for dealing with angry customers.  

 

CRACK THE EGG  

Imagine that you have a hard-boiled egg. The rich 

yellow yolk at the center of the egg represents 

the solution to the customer's problem, the 

hardened white which surrounds the yolk 

represents the details of the customer's situation, 

and the hard shell represents his/her anger.  
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In order to get to the yolk, and resolve the situation, you must first crack the shell. In other words, you have got to 

penetrate the customer’s anger. Then you've got to cut through the congealed egg white. That means that you 

understand the details of the customer’s situation. Finally, you're at the heart of the situation, where you can 

offer a solution to the customer's problem.  

 

So, handling an angry customer is like cutting through a hard-boiled egg. Here's a four-step process to help you do 

so 

 

1. LISTEN - Let's say you stop to see one of your regular customers. He doesn't even give you time to finish 

your greeting before he launches into a tirade. At this point, about all you can do is LISTEN. And that's what you 

do. You don't try and cut him off, you don't urge him to calm down.  

 

Not just yet. Instead, you listen carefully. And as you listen, you begin to piece together his story. He ordered a 

piece of equipment three weeks ago. You quoted him X price and delivery by last Friday for a project that's 

starting this week. Not only is the equipment not there, but he received an invoice for it at a different price than 

was quoted.  

 

"What kind of shoddy operation is this?" he wants to know. Do you understand how important his project is? Do 

you know how much time and money is at stake? If he doesn't get his equipment and something happens to this 

project, you're going to pay for it.  

 

He knew, he just knew he should have ordered the equipment from your competitor. What are you going do 

about it? Now you have the basic story. Hopefully, after this gush of frustration, there will be a pause while he 

comes up for air.  

 

More often than not, once the customer has had an initial chance to vent his rage, it's going to die down a little, 

and that's your opportunity to take step in. Even if he has started calming down on his own, there comes a 

moment - and I can almost guarantee you'll sense it - to help calm him down.  

 

Try something along the lines of: "It sounds like something has gone wrong, and I can understand your 

frustration. I'm sorry you're experiencing this problem. Let's take a look at the next step."  

 

Try to calm yourself first, and then to acknowledge his feelings. Say, "I can tell you're upset..." or, "It sounds like 

you're angry..." then connect to the customer by apologizing, or empathizing. When you say something like "I'm 

sorry that happened. If I were you, I'd be frustrated, too." It's amazing how much of a calming effect that can 
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have. Remember, anger is a natural, self-defensive reaction to a perceived wrong. If there is a problem with your 

company’s product or service, some frustration and disappointment is justified.  

This is so important, let me repeat it. First you listen carefully and completely to the customer. Then you 

empathize with what the customer is feeling, and let him or her know that you understand. This will almost 

always calm the customer down. You've cracked the shell of the egg. Now, you can proceed to deal with the 

problem.  

 

2. IDENTIFY THE PROBLEM - Sometimes while the angry customer is venting, you'll be able to latch right 

on to the problem because it's clear-cut. Something is broken. Or late. Or he thinks a promise has been broken.  

But sometimes in the middle of all that rage, it's tough to comprehend the bottom-line issue. This is a good place 

for some specific questions. Ask the customer to give you some details.  

 

"What day did he order it, when exactly was it promised. What is his situation at the moment?" These kind of 

questions force the customer to think about facts instead of his/her feelings about those facts. So, you interject a 

more rational kind of conversation. Think of this step of the process as cutting through the white of the egg to get 

to the yolk at the center.  

 

It's important, when you think you understand the details, to restate the problem. You can say, "Let me see if I 

have this right. You were promised delivery last Friday, because you need it for an important project this coming 

week. But you haven't received our product yet. Is that correct?"   

 

He will probably acknowledge that you've sized up the situation correctly. Or, he may say, "No, that's not right" 

and then proceed to explain further. In either case the outcome is good, because you will eventually understand 

his situation correctly, and have him tell you that "Yes, that's right."  

 

And at that point you can apologize. Some people believe that an apology is an acknowledgment of wrongdoing. 

But you can appreciate and apologize for the customer's inconvenience without pointing fingers. Just say, "Mr. 

Brady, I'm sorry this has happened." Or "Mr. Brady. I understand this must be very frustrating. Let's just see what 

we can do fix it, OK?"  

 

3. AVOID BLAME - You don't want to blame the customer by saying something like "Are you sure you 

understood the price and delivery date correctly?" This will just ignite his anger all over again because you are 

questioning his credibility and truth-telling.  
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And you don't want to blame your company or your suppliers Never say, "I’m not surprised your invoice was 

wrong. It's been happening a lot." Or, "Yes, our backorders are way behind."  

 

In general, you AVOID BLAME. Which is different than acknowledging responsibility. For example, if you know, for 

a fact, a mistake has been made, you can acknowledge it and apologize for it.  

 

"Mr. Brady, clearly there's a problem here with our performance. I can't change that, but let me see what I can do 

to help you out because I understand how important your project is."   

 

4. RESOLVE THE PROBLEM - Now you’re at the heart of the egg. You won't always be able to fix the 

problem perfectly. And you may need more time than a single phone call. But it's critical to leave the irate 

customer with the understanding that your goal is to resolve the problem.  

 

You may need to say, "I'm going to need to make some phone calls." If you do, give the customer an idea of when 

you’ll get back to him: "Later this afternoon." Or "First thing in the morning."  Then do it. Make the phone calls. 

Get the information.  

 

Find out what you can do for this customer and do it. Then follow up with the customer when you said you would. 

Even if you don't have all the information you need, call when you said you would and at least let him know what 

you've done, what you're working on and what your next step will be.  

 

Let the customer know that he and his business are important to you, that you understand his frustration, and 

that you're working hard to get things fixed. 
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Taking Customer Bookings 
 

ow to Take Reservation on Phone  

Telephone plays an important role in times of 

reservation on phone. Perfect telephone 

handling ensures efficiency of the reservation 

agent which at the same time upholds hotel’s standard. All 

the time you should follow proper telephone manner.  

 

These are some basic tips you should follow while you are taking reservation on phone. 

• Pick	up	the	phone	within	3	rings.		

• Greet	the	caller	according	to	the	time.	Try	to	keep	very	fresh,	clear	and	friendly	voice	tone	so	that	

guest	from	other	side	of	the	phone	may	feel	comfortable.	Remember	First	Impression	is	the	Last	

Impression.	

• It	is	advisable	to	greet	in	this	way	“Good	Morning.	This	is	Hotel	X.	Thank	you	for	calling.	How	may	I	

help	you,	sir?”	

• Try	to	identify	caller	gender	by	his	or	her	sound.	Listen	to	the	name	properly.	Repeat	the	name	with	

Mr.	or	Ms.	Caller	may	be	hurt	if	you	by	mistake	call	him	wrongly.	

• Try	to	understand	why	the	caller	calls.	In	a	hotel	people	call	not	only	for	making	reservation	but	also	

for	getting	information,	arranging	party,	sending	message	to	a	guest	or	making	business	deal	etc.	So,	

first	listen	carefully	to	identify	what	sorts	of	assistance	the	caller	wants	from	you.	

• If	the	caller	calls	for	room	reservation	and	if	he	is	not	a	repeated	guest		then	you	should	try	to	give	a	

short	overview	on	your	hotel	including	hotel’s	feature	and	amenities,	specialty,	special	offer	you	are	

offering	etc.	

• In	the	meantime,	look	at	the	room	status	or	reservation	chart.	It	will	be	so	bad	if	after	informing	

everything,	guest	becomes	convinced	and	wants	to	have	a	room	booked	but	you	don’t	find	any	room	

to	sell	as	all	are	occupied.	So,	always	be	updated	specially	about	room	status.	

• If	callers	requested	date	indicates	“SOLD	OUT”	which	means	you	are	unable	to	sell	the	room	for	that	

specific	date,	then	very	politely	say	sorry	to	the	guest	and	let	him	know	why	you	are	unable	to	sell	

the	room.	

• If	the	requested	date	indicates	“WAIT-LISTED”	then	politely	inform	the	guest	about	the	situation	and	

inform	him	that	reservation	on	that	day	is	wait-listed	for	that	reason	you	are	taking	his	reservation	

but	not	giving	full	guarantee	and	request	him	to	check	again	closer	to	that	requested	date.	

• After	giving	an	overview	of	you	hotel,	now	try	to	identify	what	sorts	of	room	the	caller	wants	and	try	

to	offer	him	some	options	so	that	he	can	decide	from	his	own	or	if	he	needs	then	assist	him.	

H 
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• If	the	guest	wants	to	book	the	room	then	say	that	we	are	very	pleased	to	reserve	a	room	for	you.	May	

I	have	some	information	from	you	please?	Now	try	to	collect	the	following	information	with	proper	

spelling:	

o Name	of	the	Guest	

o His	Contact	Address	

o Room	Types	

o Room	Rates	

o Date	of	Arrival	

o Date	of	Departure	

o Date	of	Reservation	Made	

o Mode	of	Payment	

o Special	Remark	(if	any)	

o Reservation	Made	by	Person	or	

Company	

• Repeat	all	the	information	caller	gives	and	at	the	same	time	give	him	a	reservation	confirmation	

number.	

• If	you	have	any	objection	about	guest’s	mode	of	payment	or	anything	then	inform	the	guest	about	

your	rules	and	request	him	to	give	you	another	option.	

• After	settling	everything	thanks	the	caller	for	his	patience	and	calling	you.	End	up	the	call	as	

warmly	as	you	start	and	try	to	make	him	feel	that	he	just	have	made	a	perfect	decision.	

 

When taking a reservation form a guest it is of utmost importance to ensure that a deposit is also taken. Most 

organisations require at least a 50% payment of the room when the booking is made others require the full 

amount to be settled immediately upon booking. By ensuring that the room has either been paid for, or a 

deposit has been taken in lieu of the room, the hotel can rest assured that they will not keep the room and 

suffer a loss in the event that the guest does not arrive for their booking.  

 

Such losses can amount to thousands of Rands in a short time period and can place immense financial strain on 

the organisation when there are open rooms available and they are showing other guests away. Deposits secure 

rooms and ensure that the hotel is guaranteed of the guests’ arrival.    
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aking a Room Reservation on the telephone 

For a front desk agent making proper reservation is the most important job. Generally most 

of the reservation has been done by phone. Here you will learn exactly what steps a front 

desk agent needs to follow to make a reservation in phone. Steps you should follow: 

Step-1:  

Answer the telephone within 3 rings. 

 

Step-2:  

Greet the guest properly. “Good Morning, Front Desk. This is XXX hotel. How may I assist you?” 

 

Step-3:  

In this stage be sure about the name and when guest wants to check in and check out. Try to understand this 

conversation: 

Guest: “I want to make a reservation” 

Agent: Certainly sir. How should I address you? 

Guest: I am Robert Temple. 

Agent: Good morning/afternoon/evening Mr Temple, are you our priority Club Member? Or “Have you stayed 

with us before?” (If guest says yes then ask following question) 

“May I have your previous check in & check out date, please?” (Ask this question to know what price was 

offered before and what is guest preference and other information related to that particular guest) 

 

Step-4:  

After confirming about guest proceed to the next level. In this case, first look for room inventory. You may either 

find any vacant room or no room for sale. Now, follow these steps in those cases. 

 

If you don’t find any room Available:  

Agent: I am terribly sorry, Mr Temple. All our rooms are booked on XXX date. If you wish then I can put your 

reservation on waiting list or would you like me to recommend another hotel? Now if guest want his reservation 

to be put on waiting list then take full details about the guest and give him a reservation confirmation number. 

 

If you find a room Available:  

Now your approach will be to know which room will best match with guest. Follow these steps: Agent: Mr 

Temple, will you be travelling alone? Your duty is to book a room matching the guests’ needs. If guests travel 

M 
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with their families, a single room will not suffice; vice versa: if they are travelling with family/friends then you 

should look for family room.  

  

Agent: MR. Temple, currently we have deluxe room, suit and studio room to accommodate your family. (If you 

have different types of rooms vacant then give some options to guest.) Alternatively you may recommend inter 

leading rooms, adjoining rooms or rooms opposite one another.  

 

Step-5:  

Highlight and explain the different features of each type of room your organisations has as well as indicating 

their prices. If there are any discounts/discounted offers, offer it to the guest immediately. Be ready all the time 

for up selling. 

 

Step-6:  

Make reservation properly. First be sure about guest name. 

Agent: How should I spell your name sir? 

Guest: It is R-O-B-E-R-T Robert and Then T-E-M-P-L-E Temple  

Agent: Is it R-O-B-E-R-T then T-E-M-P-L-E?  

Guest: Yes, you are right. Then politely request him for guaranteed booking. 

Agent: Mr Temple our hotel is quite busy. I would like to recommend you to guarantee your booking as we have 

very high occupancy rate around your specified dates. 

 

Step-7:  

Explain your procedure for guaranteed reservation. 

Agent: Mr Temple, your reservation is guaranteed, ensuring your booking. Should you not be able to come on 

XXX date, without informing us, one nights’ room rate will be charged from your credit card. If you like to 

change your reservation, please inform us 24 hours in advance. 

 

Step-8:  

Get contact details. 

Agent: May I have your contract number and address, please. 

 

Step-9:  

Offer more services to your guest. 

Agent: Mr Temple, may we offer you a collection service from the airport? 

Guest: Yes, that’s great. 
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Agent: Thank you sir. For transportation facility, we require both fax/telephone and credit card guarantees. 

Once we received confirmation from you, our concierge will contact you and make all the arrangements. 

 

Step-10:  

At this stage you close down the selling. Repeat all required information to ensure that you have all the proper 

information. 

Agent: If you don’t mind Mr Temple, I would just like to confirm your reservation details. You will be checking in 

on XXX and your checking out date is XXX. You preferred non-smoking, twin bedded supreme room for you and 

your family. Room rate is XXX (rand) per night which included complimentary breakfast.” 

 

Step-11:  

Thank the guest for calling and his time, completing the conversation. 

Agent: Thank you Mr Temple for choosing XXX hotel. Wed will certainly take care of you. Should you require any 

further assistance, before or during your stay, please ask for me by name and I will assist you personally.  

 

uest registration procedures 

Always remember that guest should be registered within 10 minutes, with complete information. 

The greeting must be warm and personalized.  

 

Greet	the	Guest:	

Ø When	you	see	the	arrival	guest	coming	in,	open	the	main	entrance	by	using	switch	beside	of	the	

front	desk.		

Ø Greet	with	a	smile	and	say:”	Good	morning/afternoon/evening	(according	to	the	right	time	of	the	

day)	Mr/Ms	Patron	(guest	if	known)	or	sir/ma’am,	welcome	XYZ.”	

Ø If	guest	name	is	not	known,	ask	the	guest	for	their	name	by	saying:	“May	I	have	your	name	please.”	

 

Check	current	day’s	check-in	list	for	the	guest’s	name	and	retrieve	the	guest	folder:	

Ø Open	guest	folio/file	in	Comanche	system	and	review	file.	

Ø Retrieve	the	Guest	Registration	Card	and	key.		Guest	registration	should	be	complete	with	guest	

details	at	least	one	day	prior	to	guest	arrival.	

 

Present	the	guest	registration	card	and	lease	agreement	(if	any):	

Ø Show	guest	where	to	sign	or	fill-in	those	areas	requiring	information	on	Registration	Card	and	

Lease	Agreement,	by	saying:	“Mr/Ms	Patron,	please	check	the	information	and	complete	these	

areas	and	sign	here”.	

G 
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Ø Ask	for	guest’s	business	card.	If	you	could	get	it,	guest	does	not	need	to	fill	up	the	form	except	

signature.	

Ø Do	not	interrupt	guest	while	they	are	filling	in	the	forms		

Ø When	receiving	completed	form,	say:	“Thank	you	Mr/Ms	Patron”.	

Ø Check	that	all	necessary	areas	of	name,	passport	number,	address	&	signature,	are	completed	

accordingly.	

 

Request	credit	card	from	guest:	

Ø Check	the	payment	status.	If	the	company	is	paying	all	expenses,	it	is	not	necessary	to	ask	for	credit	

card.	

Ø Show	Invoice	if	any.	

Ø Say:	“Mr/Ms	____,	may	I	have	your	credit	card	please.”		“Thank	you.”		Receive	credit	card	with	both	

hands.	

Ø Charge	amount	according	to	guest	paperwork	

Ø Take	credit	card	imprint/swipe	for	incidental	charges,	if	the	company	is	paying	the	Rent.	

Ø Return	the	credit	card	to	the	guest,	saying:	“Thank	you,	Mr/Ms	_______”	

Ø Present	the	print	out	of	the	slip	to	the	guest	for	signature.	

Ø Present	a	copy	of	credit	card	slip,	attach	to	“PAID”	stamped	original	invoice.	Pass	it	to	the	guest.	

Ø Clip	the	other	signed	slip	to	the	copy	of	Invoice	and	attach	both	to	the	back	of	the	guest	registration	

card.	

 

Request	passport	from	guest:	

Ø Ask	guest	for	their	passport/identity	card	for	photocopying,	saying:	“Mr/Ms____,	may	I	have	your	

passport/identity	card	please.”	“Thank	you.”	

Ø Make	a	copy	of	the	passport	(page	with	their	photograph	and	personal	details	as	well	as	the	page,	if	

applicable,	of	their	visa	for	entry	into	the	country).	

Ø Check	name,	passport	number,	visa	details.	

Ø Return	passport	to	the	guest,	saying:	“Thank	you.”	

Ø Clip	the	copy	of	the	passport/identity	card/visa	behind	the	completed	guest	registration	card	and	

behind	the	credit	card	slip.		This	ensures	that	the	property	has	a	photo	of	the	guest	for	guest	

security	purposes.	

 

Outstanding	items/Incomplete	guest	file:	

Ø Inform	guest	by	saying:	“Mr/Ms	Patron,	on	review	of	your	file,	we	have	not	received	your	{name	of	

missing	document,	for	example	Reservation	Confirmation	Form	etc.},	do	you	have	it	available?”	

Ø If	the	document	is	not	available,	say:	“Mr/Ms	Patron	might	we	follow	up	with	you	tomorrow?”	

Ø Log	into	logbook	for	Front	Office	Manager	to	follow-up	
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Ask	guest	if	they	require	newspaper	service:	

Ø Ask:	“Mr/Ms	Patron,	would	you	like	one	of	the	local	newspapers	or	one	of	the	international	

papers?”	

Ø Provide	the	appropriate	information	and	rate	schedule	as	requested	by	the	guest.	

Ø Say:	“Mr/Ms	Patron,	the	{name	of	newspaper	subscribed}	will	be	delivered	to	your	residence	daily.		

We	will	bill	your	account	{price	of	subscription}	per	month.”	

 

Ask	guest	if	they	require	a	car	parking	space:	

Ø Ask:	‘Will	you	be	requiring	a	car	park	space?”	

Ø If	guest	requires	car	park,	check	availability	and	ask	for	the	car	type	to	assign	inside	or	outside	car	

park.	

Ø If	the	parking	is	not	available,	apologize	and	advise	that	we	will	contact	guest	as	soon	as	it	become	

available,	and	note	it	on	the	list	accordingly.	

Ø Prepare	the	car	admission	card	and	advise	guest	to	place	it	in	front	of	the	driver’s	seat.	

 

Ask	guest	if	they	require	Broadband	Connection	(ADSL):	

Ø Ask	“Will	you	be	requiring	Broadband	Connection	in	your	apartment?”	If	guest	requires	Broadband,	

provide	appropriate	information.	

Ø Provide	the	appropriate	information	and	rate	schedule	as	requested	by	the	guest.	

Ø If	guest	requires	Broadband,	set	the	hub	in	the	apartment	and	provide	LAN	cable. 

 

fter the booking: 

Confirming the booking two weeks in advance of the guests’ arrival (if they have booked that long in 

advance) after the initial booking ensures the guests’ arrival. It also assists with the room allocations 

sheet where the various rooms required by the guests arriving on the date, guaranteeing that the 

guests get their specified rooms.  

 

It assists the Housekeeping department in setting up the rooms in accordance with the guests’ specifications 

and gives the Housekeeping department sufficient time to make the necessary changes to the rooms, should the 

guests need it and make arrangements for specified items, should they not have them. Examples of these are 

when guests requires cots or cribs for babies. Some hotels do not have these and may rent them from an 

external supplier, but advance preparations are needed. Not only does booking confirmations assist the 

Housekeeping department, but it also assists the Food and Beverage departments to plan in advance for the 

amount of guests which will be at the hotel, so that they can prepare for the numbers and order sufficient goods 

in, to ensure that there is enough stock to cater for all the guests.  

A 
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Promoting Services 
 
Promoting the Organisation 

Promotion of your establishment enables the guests to spend more money on items that are available at your 

organisation, rather than at another. If you do not offer the guests the dessert menu, or tell them about the 

desserts, they might go somewhere else for desserts, when they could have spent their money at your 

organisation. Failing to promote your establishment, will lead to a loss of income to your establishment and 

yourself.  

 

You can promote your establishment in various ways: 

 Being personally well prepared in your appearance 

 Always having a welcoming attitude 

 Being pleasantly polite, courteous and helpful 

 Handling complaints efficiently and professionally 

 Developing good relationships with your customers 

 Providing excellent service by informing the guests of specials and items that you think they might 

enjoy 

 Being aware of, and treating their special needs in advance of their requests  

 Coping well with pressure and not allowing the guests to see you are under pressure 

 Your ability to communicate well with the guests and your fellow workers to explain the guests 

needs and ensure they are taken care of 

 Good listening skills to determine what the guests want and then acting accordingly 

 Good knowledge of your organisations’ policy to advise your guests on their requests and how they 

will be handled 

 

In any organisation that one works in, it is very important 

to promote the organisation. Taking care of customers in 

that organisation will ensure them coming back over and 

over again. Whether you are serving food in a restaurant 

or if you are selling goods next to the road and even when 

you are a farmer.  

 

In any way that the guests come into contact with you and your organisation, they will require the best service. 

Remember that there are more than one company offering the same product as what you are, if you do not 

maintain your relationships with your customers, you will definitely lose them.  
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Information for customers and information not for customers 

In any organisation there is a flow of information. Many people talk about educating their customers in ways 

that will enrich the customers as to the policies and offerings of their products and services. Educating the 

customers will enable them to make educated decisions about the products and services available at your 

company, and how they will satisfy the needs of the guests. One would want to give as much as possible 

information to the guests with regards to services and products your company has to offer.  

 

Yet at the same time, you must withhold any information about your company, which does not have anything to 

do with the guests. This is a difficult decision to make, but simply ask yourself one question:  does this 

information assist the guest in the products and services my company renders or not. If it does then you should 

give it out.  

 

If not, then it does not pertain to the guests. It is important to communicate with the guests in a courteous and 

professional matter. There are however certain issues that should never be disclosed to customers and other 

factors that you should bear in mind when conversing with a customer: 

 Conversations with guests should be warm and friendly 

 Keep your comments and topics positive in nature 

 Never discuss your personal lives or ask the guests about theirs. 

 Do not become overly chatty. Answer the guests’ questions and make short, positive comments 

 Do not discuss other guests, politics or any sensitive issues 

 Do not give out any information about other guests 

 Never use bad, degrading language 

 Never give out any information regarding the business, how it operates, who is responsible for what 

duties etc.  

 Never give out information regarding the security and safety of the organisation 

 

The trick is to promote the correct items at the correct times. During winter, it is good to promote hot 

chocolates and Irish coffee’s for desserts, rather than frozen yoghurts or ice-cream cakes. The best way to go 

about is to ask yourself, what would you have if you were the guests, what would suit the situation? Answer 

that, suggest the same and you are more than likely to sell additional items, and in that way promote the 

organisation, in the way that suits the situation.  
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You are now ready to go through a check list. Be honest with yourself. 

Tick	the	box	with	either	a	√	or	an	X	to	indicate	your	response.	

	

� I	am	able	to	maintain,	determine,	record	and	confirm	bookings	on	a	manual	and	computer	
system		

	

	

 

	

 

 

 

 

 

 

 

 

 

 

	

You	must	think	about	any	point	you	could	not	tick.	Write	this	down	as	a	goal.	

Decide	on	a	plan	of	action	to	achieve	these	goals.	Regularly	review	these	goals.	
 

 

 

 

 

 

 

 

 
 
 

My	Goals	and	Planning:	
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________

________________________________________________________________________________________



SDA | MODULE 2 | STUDENT GUIDE 68 

 

 

 

 

 

 

NATIONAL CERTIFICATE: BUSINESS ADMIN 

SERVICES  

MODULE 2 | US 7567  PRODUCE AND USE SPREAD SHEETS 

FOR BUSINESS 
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People	credited	with	this	unit	standard	are	able	to:		

• Plan	and	design	computer	spreadsheet	documents	to	solve	a	business	problem	

• Format	data	in	a	spreadsheet	

• Create	graphs	

• Write	macros	

• Solve	problems	using	a	spreadsheet		

	

Unit Standard 7567  
 

SPECIFIC	OUTCOMES	AND	RELATED	ASSESSMENT	CRITERIA	

SO	1	 PLAN	AND	DESIGN	COMPUTER	SPREADSHEET	DOCUMENTS	TO	SOLVE	A	BUSINESS	
PROBLEM.		

AC	1	 The	problem	is	identified	as	being	solvable	by	a	spreadsheet.		
AC	2	 The	spreadsheet	is	designed	and	documented	in	keeping	with	the	nature	of	the	problem.		
SO	2	 PRODUCE	A	COMPUTER	SPREADSHEET	FILE	TO	SOLVE	A	BUSINESS	PROBLEM.		
AC	1	 Data	is	entered	into	the	spreadsheet	using	labels	and	values.		

AC	2	 Data	is	formatted	to	produce	the	required	spreadsheet	in	terms	of	cell	width,	alignment,	
number	and	date	and	time	formats.		

AC	3	 Spreadsheet	formulae	are	applied	in	order	to	produce	the	required	spreadsheet	in	terms	of	
statistical,	time	and	date,	financial	and	logical	functions.		

AC	4	 Absolute	cell	referencing	is	used	in	order	to	copy	formulae	across	and	down.		
AC	5	 Template	files	are	created,	used	and	documented	to	meet	the	user	requirements.	

AC	6	 Data	integrity	practices	are	demonstrated	in	terms	of	comparison	with	original	information	
sources,	audited	formulae,	check-totals	and	sort.	

AC	7	 The	spreadsheet	contains	cells,	which	are	sorted	numerically	and	alphabetically.		
SO	3	 USE	A	COMPUTER	SPREADSHEET	FILE	TO	SOLVE	A	BUSINESS	PROBLEM.		
AC	1	 Cell	ranges	within	the	spreadsheet	are	charted	to	meet	user	requirements.		
AC	2	 Cell	range	within	a	spreadsheet	is	graphed	to	user	requirements.	
AC	3	 The	problem	is	solved	by	the	spreadsheet	created.		

AC	4	 "What	if"	exercises	are	applied	to	the	spreadsheet	in	order	to	accommodate	changes	in	
requirements?		

AC	5	 Where	available,	the	use	of	the	onscreen	help	facility	is	demonstrated.		

AC	6	
File	management	techniques	are	demonstrated	in	terms	of	creating,	naming,	saving,	copying,	
renaming,	deleting,	locating	directory	(folder),	displaying	directory	contents	printing	and	
relocating.	

AC	7	
The	file	is	previewed	and	printed	using	page	setup	appropriate	to	the	layout.		
(Showing	gridlines,	setting	printing	range,	shrinking	to	one	page,	alignment.	Headers	and	
footers.)	

SO	4	 MANIPULATE	THE	DATA	IN	A	SPREADSHEET.		
AC	1	 The	appearance	of	spreadsheet	is	modified	to	user	requirements	using	formatting	facilities.		

(Alignment,	cell	widths,	text	style,	font,	colour,	number,	date	and	time	formats.)	
AC	2	 Selected	cells	within	an	existing	spreadsheet	file	are	sorted	numerically	and	alphabetically.		
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•  

•  

All qualifications and part qualifications registered on the National Qualifications 
Framework are public property. Thus the only payment that can be made for them is for 
service and reproduction. It is illegal to sell this material for profit. If the material is 
reproduced or quoted, the South African Qualifications Authority (SAQA) should be 
acknowledged as the source.  

SOUTH AFRICAN QUALIFICATIONS AUTHORITY  

REGISTERED UNIT STANDARD THAT HAS PASSED THE END DATE:  

 

Produce and use spreadsheets for business  

SAQA US 
ID 

UNIT STANDARD TITLE 

7567  Produce and use spreadsheets for business  

ORIGINATOR ORIGINATING PROVIDER 

SGB Information Systems and 
Technology  

  

QUALITY ASSURING BODY 

-   

FIELD SUBFIELD 

Field 10 - Physical, Mathematical, Computer and Life Sciences Information Technology and Computer 
Sciences  

ABET 
BAND 

UNIT STANDARD 
TYPE 

OLD NQF LEVEL NEW NQF LEVEL CREDITS 

Undefined  Regular-
Fundamental  

Level 3  NQF Level 03  5  

REGISTRATION STATUS REGISTRATION START 
DATE 

REGISTRATION END 
DATE 

SAQA DECISION 
NUMBER 

Passed the End Date -  
Status was "Reregistered"  

2003-12-03  2004-12-02  SAQA 1351/03  

LAST DATE FOR ENROLMENT LAST DATE FOR ACHIEVEMENT 

2005-12-02    2008-12-02    

 

In all of the tables in this document, both the old and the new NQF Levels are shown. In the text (purpose statements, 

qualification rules, etc), any reference to NQF Levels are to the old levels unless specifically stated otherwise.  
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This unit standard is replaced by:  

US ID Unit Standard Title 
Old NQF 
Level 

New NQF 
Level 

Credits 
Replacement 
Status 

116940  
Use a Graphical User Interface (GUI)-based 
spreadsheet application to solve a given problem  

Level 3  
NQF Level 
03  

6  Complete  

 

PURPOSE OF THE UNIT STANDARD  

People credited with this unit standard are able to:  
 
•  Plan and design computer spreadsheet documents to solve a busi-ness problem  
•  Format data in a spreadsheet.  
•  Create graphs  
•  Write macros  
•  Solve problems using a spreadsheet  

 

LEARNING ASSUMED TO BE IN PLACE AND RECOGNITION OF PRIOR LEARNING  

Open.  
 
The credit value of this unit is based on a person having the prior knowledge and skills to use a PC, to produce 
and use spread-sheets using basic functions, and an understanding of basic business principles and practises  

 

UNIT STANDARD OUTCOME HEADER  

Plan and design computer spreadsheet documents to  

 

Specific Outcomes and Assessment Criteria:  

 

SPECIFIC OUTCOME 1  

Plan and design computer spreadsheet documents to solve a business problem.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. The problem is identified as being solvable by a spreadsheet.  

 

ASSESSMENT CRITERION 2  

2. The spreadsheet is designed and documented in keeping with the nature of the problem.  

 

SPECIFIC OUTCOME 2  
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Produce a computer spreadsheet file to solve a business problem.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Data is entered into the spreadsheet using labels and values.  

 

ASSESSMENT CRITERION 2  

2. Data is formatted to produce the required spreadsheet in terms of cell width, alignment, number and date and 
time formats.  

 

ASSESSMENT CRITERION 3  

3. Spreadsheet formulae are applied in order to produce the required spreadsheet in terms of statistical, time and 
date, financial and logical functions.  

 

ASSESSMENT CRITERION 4  

4. Absolute cell referencing is used in order to copy formulae across and down.  

 

ASSESSMENT CRITERION 5  

5. Template files are created, used and documented to meet the user requirements.  

 

ASSESSMENT CRITERION 6  

6. Data integrity practices are demonstrated in terms of comparison with original information sources, audited 
formulae, check-totals and sort.  

 

ASSESSMENT CRITERION 7  

7. The spreadsheet contains cells, which are sorted numerically and alphabetically.  

 

SPECIFIC OUTCOME 3  

Use a computer spreadsheet file to solve a business problem.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Cell ranges within the spreadsheet are charted to meet user requirements.  

 

ASSESSMENT CRITERION 2  
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2. Cell range within a spreadsheet is graphed to user requirements.  

 

ASSESSMENT CRITERION 3  

3. The problem is solved by the spreadsheet created.  

 

ASSESSMENT CRITERION 4  

4. "What if" exercises are applied to the spreadsheet in order to accommodate changes in requirements.  

 

ASSESSMENT CRITERION 5  

5. Where available, the use of the onscreen help facility is demonstrated.  

 

ASSESSMENT CRITERION 6  

6. File management techniques are demonstrated in terms of creating, naming, saving, copying, renaming, 
deleting, locating directory (folder), displaying directory contents printing and relocating.  

 

ASSESSMENT CRITERION 7  

7. The file is previewed and printed using page setup appropriate to the layout.  

ASSESSMENT CRITERION RANGE  

Showing gridlines, setting printing range, shrinking to one page, alignment. Headers and footers. 
  

 

SPECIFIC OUTCOME 4  

Manipulate the data in a spreadsheet.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. The appearance of spreadsheet is modified to user requirements using formatting facilities.  

ASSESSMENT CRITERION RANGE  

Alignment, cell widths, text style, font, colour, number, date and time formats. 
  

 

ASSESSMENT CRITERION 2  

2. Selected cells within an existing spreadsheet file are sorted numerically and alphabetically.  
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Critical Cross-field Outcomes (CCFO):  

 

UNIT STANDARD CCFO IDENTIFYING  

Identify and solve problems.  

 

UNIT STANDARD CCFO WORKING  

Work effectively with others as a member of a team, group, organisation and community.  

 

UNIT STANDARD CCFO ORGANISING  

Organise and manage oneself and one`s activities responsibly and effectively.  

 

UNIT STANDARD CCFO COLLECTING  

Collect, organise and critically evaluate information.  

 

UNIT STANDARD CCFO COMMUNICATING  

Communicate effectively using visual, mathematical, and language skills in modes of oral and written 
presentations.  

 

UNIT STANDARD CCFO SCIENCE  

Use science and technology effectively and critically (showing responsibility towards the environment and health 
of others).  

 

UNIT STANDARD CCFO DEMONSTRATING  

Demonstrate an understanding of the world as a set of related systems.  

 

UNIT STANDARD CCFO CONTRIBUTING  

Contribute to the full personal development of each learner and the social and economic development of society 
at large, by making it the underlying intention of any programme of learning to make an individual aware of the 
importance of:  
•  reflecting on exploring a variety of strategies to learn more effectively  
•  participating as responsible citizens in the life of local, national and global communities  
•  being culturally and aesthetically sensitive across a range of social contexts  
•  exploring education and career opportunities and  
•  developing entrepreneurial opportunities.  
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THE BASICS OF SPREAD SHEETS 
 

he Excel Worksheet and Workbook 

An Excel worksheet, or spreadsheet, is a two-dimensional grid with columns and rows. Look at the 

worksheet below. The column names are letters of the alphabet starting with A, and the rows are 

numbered chronologically starting with the number one.  

 

The cells in the first row are A1, B1, C1, and so on. And the cells in the first column are A1, A2, A3, and so on. 

These are called cell names or cell references. We use cell references when creating math formulas or functions. 

For example, the formula to add the contents of cells B2 and B3 together is: =B2+B3. 

 

Excel math basics 

Once you understand how to create basic math formulas in Microsoft Excel, your next step is to learn some of 

Excel's cool functions that provide the ability to count, round numbers, find averages, calculate square roots, 

use logic, and so on.  

 

Basic Math Calculations in Excel 

Whenever the contents of the cells referenced in a math formula change, Excel will automatically recalculate 

the answer for you. That is what makes this software program so powerful. As some formulas can get extremely 

complicated, it is a good idea to lock those cells that contain the formulas and protect the worksheet.  

 

The 5 basic rules to remember as we discuss Excel formulas are: 

1. All	Excel	formulas	start	with	an	equal	(=)	sign.	This	tells	Excel	that	it	is	a	formula.	

2. The	answer	to	the	formula	displays	in	the	cell	into	which	the	formula	is	entered.	

3. Cells	are	referenced	in	a	formula	by	their	column-row	identifier,	i.e.	A1,	B2.	

4. The	symbols	for	addition,	subtraction,	multiplication,	and	division	are:	+	-	*	/		

5. You	do	not	have	to	enter	capital	letters	in	your	formula;	Excel	will	automatically	capitalize	them.	

T 
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Example of simple math formulas: 

=A1+A6   this Excel formula adds the contents of cell A1 and A6 

=A1+A2+A3   this Excel formula adds the contents of the three cells specified. (See the SUM function for adding 

multiple numbers) 

=A3-A1   this Excel formula subtracts the contents of cell A1 from the contents of cell A3 

=B2*B3   this Excel formula multiples the numbers in cells B2 and B3 

=G5/A5   this Excel formula divides G5 by A5. (NOTE: If you see the error message #DIV/O! in a cell, you are 

trying to divide by zero or a null value - which is not allowed.) 

=G5^2   this formula tells Excel to square the value in cell G5. The number after the caret is the exponent. 

Likewise, the formula H2^3 would cube the value in cell H2. 

We can combine multiple operations in one formula. Make sure you use parentheses where needed or you may 

not get the correct results (see Order of Operations below).  

 

Here are some examples: 

=(C1+C3)/C4   This Excel formula adds the value in C1 to the value in C3, and then divides the result by the value 

in C4 

=4*(A2+A5)+3   This Excel formula adds the contents of A2 and A5, multiples this sum by 4, and then adds 10. 

 

Order of Operations 

Remember the Order of Operations by remembering the phrase Please Excuse My Dear Aunt Sally. The letters 

stand for: Parentheses, Exponents, Multiplication, Division, Addition, and Subtraction. And all operations are 

carried out from left to right.  

 

Here is how the order is applied: 

1. First,	any	math	inside	of	parentheses	is	calculated.	

2. On	the	second	pass,	all	exponents	are	resolved.	

3. Then	any	multiplication	OR	division	is	performed.	

4. Lastly,	any	addition	OR	subtraction	is	performed.	

 

Note: Even though the Aunt Sally phrase may imply that multiplication is done before division, and addition is 

done before subtraction, that is not true. They are performed during the same step, or pass, through the 

formula. 
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Let's illustrate with a simple formula:  4+2*3 

Pass 1 - Since the multiplication must be done first, our expression resolves itself to 4+6=10. 

 

Let's practice with a more complex formula:  (2*4)+3^2-8/4 

Pass 1 - Parentheses: 2*4 = 8. Now our expression reads: 8+3^2-8/4 

Pass 2 - Exponents: 3^2=9. Now our expression reads: 8+9-8/4 

Pass 3 - Multiply and Divide: 8/4=2. Now our expression reads: 8+9-2 

Pass 4 - Add and Subtract: The answer is 15 

 

Now test your skill on a complicated formula!  3^(6/3)+(3*3)-2*(6-3) 

Pass 1 - Parentheses: 6/3=2, 3*3=9, and 6-3=2. So now our formula reads: 3^2+9-2*3 

Pass 2 - Exponents: 3^2=9. So now our formula reads: 9+9-2*3 

Pass 3 - Multiply and Divide: 2*3=6. So now our formula reads: 9+9-6 

Pass 4 - Add and Subtract: 12 

 

Calculate Percentages in Excel 

There are two ways to calculate percentages in Excel, depending on how the worksheet is designed. 

 

Display a Percent Sign in the Cell 

To calculate a percentage and have the percent sign display in the cell, just enter the formula in the cell and 

format the cell as a Percentage. Let's suppose the formula in cell C2 is =A2/B2. If A2=25 and B2=50, then 

25÷50=.5 and .5 will display in cell C2. However, format C2 as a Percentage and 50% will display instead. 

 

To format a cell or group of cells, right-click in the cell and click "Format Cells...." Click "Percentage" on the 

Number tab, indicate the number of decimal points, if any, and click "OK." 

 

Use a Column Heading of Percent and No Percent Sign in the Cell 

Let‘s suppose you're dividing the values in column A by the values in column B, putting the answers in column C, 

and column C has a column heading of PERCENT. Using the example above, we would want "50" to display in 

cell C2, not .5. To express percentages in a cell, multiply by 100. In our example, our new formula would be 

=(A2/B2)*100. Excel will divide A2 by B2 and get .5, then multiple .5 by 100 and display the answer, 50, in cell 

C2. 
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How Excel Interprets Cell References in Formulas 

Excel interprets cell references in formulas in a ‘relational’ manner. It looks at how cells relate to each other, 

positionally, on the grid. This is good news! Let's see why. Let's calculate some simple column totals. We will add 

the contents of A1 to A2, and put the answer in A3. So in cell A3 we will type the formula =A1+A2. See the image 

below. This is how Excel interprets the formula in cell A3: Take the number in the cell two cells above my 

current position, add it to the number in the cell one cell above my current position, and put the answer here in 

this cell! 

 

This is handy is because now you can copy the formula in A3, paste it into cells B3 through E3, and Excel will 

automatically change the cell references in the formulas. In cell B3, Excel will write the formula =B1+B2, and so 

on. The same method is used by Excel when performing calculations on rows of numbers. So, we have not only 

learned how Excel interprets formulas, but we have learned a fabulous timesaver! Notice how a cell's contents, 

including the formula, are always displayed in the white box at the top of the Excel spreadsheet. 

 

Copying and Pasting Formulas 

To copy the contents of a cell, click in the cell, right-click, and click Copy. (Or use the keyboard shortcut Ctrl+C.) 

Then place the cursor in the receiving cell, right-click, and click Paste. (Or use the keyboard shortcut Ctrl+V.) To 

remove the animated border on the original cell, press Enter, press the Esc key, or click in another cell and begin 

typing. When pasting the contents of a cell into multiple cells, the cell contents need only be copied once. Use 

the arrows on the keyboard to move to the other cells and paste. 

 

How to Use an Absolute Cell Reference in Excel 

What if you want to copy a formula but DON'T want Excel to automatically change one of the cell references? In 

the sample below, we want to divide each number in Row 2 by the number in A1, and place the answers in Row 

3. Normally, the formula in cell A3 would 

be =A2/A1. However, if you copy and 

paste this formula into B3, Excel will 

change the formula to =B2/B1.  

 

We can easily tell Excel NOT to change A1 

in the formula by using an absolute cell reference for A1. To specify an absolute cell reference, place a $ before 

the column letter and row number of the cell. The formula in cell A3 should now read: =A2/$A$1. When copying 

and pasting the formula into other cells, Excel will keep A1 constant. Look at the formula in cell B3 in the 

worksheet below; the formula displays in the Formula Bar. 
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Structure of a Microsoft Excel Worksheet 

  

Name Box: displays 

the cell name or 

cell reference↓ 

Formula Bar: 

displays contents 

of selected cell ↓  

 

Column 

Letters→ 

 

  

    ↑ Row Numbers   ↑ Selected Cell 

The Name Box is located in the area above Column A, and displays the selected cell - the cell you've clicked in 

and where the cursor is resting. In our worksheet above, the selected cell is C2. Notice that the column letter (C) 

and the row number (2) change colour. The beginning of the Formula Bar can be seen in the area above Column 

D on our worksheet. The Formula Bar displays the contents of the selected cell. A workbook is a collection of 

worksheets. When the Excel program is opened, a workbook opens with three blank worksheets. The names of 

the worksheets are displayed on tabs at the bottom of the Excel window. 

 

Moving From Cell to Cell 

The arrow keys can be used to move left, right, up, and down from the current cell. Press the Enter key to move 

to the cell immediately below the current cell, and press the Tab key to move one cell to the right. 

Selecting Cells 

There are a variety of ways to select cells in an Excel worksheet: 

• To	select	one	cell,	click	in	the	cell.	

• To	select	one	or	more	rows	of	cells,	click	on	the	row	number(s).		

• To	select	one	or	more	columns	of	cells,	click	on	the	column	letter(s).	

• To	select	a	group	of	contiguous	cells,	click	in	a	corner	cell	and,	with	the	left	mouse	button	

depressed,	drag	the	cursor	horizontally	and/or	vertically	until	all	of	the	cells	you	want	selected	are	

outlined	in	black.	

• To	select	multiple	cells	that	are	not	contiguous,	press	and	hold	the	Ctrl	key	while	clicking	in	the	

desired	cells.	

• To	select	every	cell	in	the	worksheet,	click	in	the	upper	right	corner	of	the	worksheet	to	the	left	of	

"A."	
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Entering Data into Cells 

To enter data into a cell, just click in the cell and begin typing. What you type also displays in the Formula Bar. 

When entering dates, Excel defaults to the current year if the year portion of the date is not entered. 

 

You may edit cell contents from the Formula bar, or from directly inside the cell. To edit from the Formula Bar, 

select the cell and click inside the Formula Bar. When done typing, either press the Enter key or click inside 

another cell. To edit directly inside a cell, either double click inside the cell, or select the cell and press the F2 

key. 

 

Propagating Cell Contents 

There are multiple ways to propagate or fill data from one cell to adjacent cells. Let's begin with two popular 

keyboard shortcuts that allow us to fill down, or fill to the right: 

• To	fill	adjacent	cells	with	the	contents	of	the	cell	above,	select	the	cell	with	the	data	and	the	cells	to	

be	filled	and	press	Ctrl	+	D	(the	Ctrl	key	and	the	D	key)	to	fill	down.	

• To	fill	adjacent	cells	with	the	contents	of	the	cell	to	the	left,	select	the	cell	with	the	data	and	cells	to	

be	filled	and	press	Ctrl	+	R	(the	Ctrl	key	and	the	R	key)	to	fill	to	the	right.	

• To	propagate	in	any	direction,	use	the	Fill	Handle.	Click	in	a	cell	with	data	to	be	copied,	hover	the	

cursor	over	the	cell's	lower	right	corner	until	the	cursor	changes	to	a	thin	plus	sign	(+)	or	a	dark	

square,	and	drag	up,	down,	left,	or	right	to	fill	the	cells.	

 

If the data to be copied is a date, number, time period, or a custom-made series, the data will be incremented 

by one instead of just copied when the Fill Handle is used. For example, to display the months of the year in 

column A, type January in cell A1, drag the Fill Handle down to cell A12, and the months will display, in order, in 

column A! 

 

Moving and Copying Cells 

To move cell contents, right-click in the selected cell and click Cut. To copy cell contents, click Copy. Then right-

click in the new location and click Paste.  

 

To paste a group of cells, right-click in the cell where the top left cell of the group should be located, and click 

Paste. Remove the animated border around the original cell by pressing the ESC key, or start typing in a new 

cell.
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Adding and Deleting Rows and Columns 

To insert a new row in a spreadsheet, right-click on a row number, and click Insert. Excel always inserts the row 

ABOVE the row that was clicked on. To delete a row, right-click on the row number, and click Delete. To insert a 

new column, right-click on a column letter and click Insert. Excel always inserts the column to the LEFT of the 

column that was clicked on. To delete a column, right-click on the column letter, and click Delete. 

 

About Cell Formats 

Each cell in a worksheet can be formatted with many properties. The six tabs of the "Format Cells" window 

contain all of the formatting options. Multiple cells can be formatted in one step by first selecting the cells as 

discussed in Selecting Cells above.  

 

The "Format Cells" window can be accessed in all versions of Excel from the right-click menu. In Excel 2007 and 

2010, some formatting options are available on the Home Tab on the Font, Alignment, and Number groups. To 

see formatting options not displayed, click the little arrow in the lower right corner of the group and the 

"Format Cells" window displays. 

 

How to Format Cells 

Number:  The first tab is Number and contains categories for the type of data that is in the cell. The default 

category is General, and other popular categories are Number, Currency, Date, Percentage, and Text. Some 

categories have additional options, such as the number of decimal places, how to display negative numbers, and 

which currency symbol to display, if any.  

 

The categories Fraction, Scientific, Accounting, Special, and Custom are also available. The default category, 

General, is very flexible. Dates display as dates, text displays as text, and numbers display as numbers. Don't 

indiscriminately format large portions of a worksheet with a different category or you may end up reformatting 

cells and re-entering data.  

 

For example, if a date is entered into a cell formatted for currency, the date's serial number will display. If a 

formula is entered into a cell formatted for a date, the answer will not display. The cell will have to be 

reformatted and the formula re-entered. 

 

Alignment:  The second tab is Alignment. Use the options on this tab to align text in the cell, indent text, wrap 

text, and merge cells. Text direction and text orientation in degrees can also be specified. Font:  The third tab is 

Font and the usual options are presented. Font, font style, colour, size, underline style, and special effects. 
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Border:  The fourth tab is Border. The Border tab provides a variety of border styles, and any colour may be 

selected for a border. A border style and border colour can be set for each side of an individual cell or a group of 

cells.  

 

Many people have trouble applying a border style or colours because Excel is fussy about the order in which 

steps are taken. Always select the border style and colour first; then select the side or sides of the cell to receive 

the border by clicking one of the pre-sets or clicking one or more sides of the box. A cell or group of cells can 

have four borders - each with a different colour and style. 

 

Patterns or Fill:  The fifth tab is called Patterns or Fill - depending on the version of Excel. The background of 

cells can be filled with any imaginable colour, a coloured pattern, or a custom gradient. These options can make 

a worksheet more attractive, and techniques like shading every other row with a light grey colour or simple 

pattern can make worksheet data easier to read. 

 

Protection:  The last tab is Protection. This feature allows the user to define certain cells as Locked and/or 

Hidden. A Locked cell cannot be formatted, nor can its contents be changed or deleted. This is a great feature 

for preventing formulas and functions from being accidently changed or erased.  

 

When a Hidden cell is selected, its contents do not display in the Formula Bar, but they can still be deleted. All 

cells are locked by default. To unlock all but a few cells, click in the top-left cell of the worksheet to select all 

cells, right-click and select "Format Cells," and remove the checkmark in the Lock box.  

 

Then lock individual cells that need protection. IMPORTANT: In order for the Lock or Hidden option to go into 

effect, the worksheet or workbook must be Protected. 

 

Protecting a Worksheet or Workbook 

To protect a worksheet or workbook in Excel 2007, click the Review tab, click Protect Worksheet or Protect 

Workbook, and click OK (entering a password first, if desired). When a worksheet or workbook is already 

protected, the icons in the Review tab are Unprotect Worksheet and Unprotect Workbook. 

 

In earlier versions of Excel, click Tools > Protection, click Protect Sheet or Protect Workbook, and click OK 

(entering a password first, if desired). When a worksheet or workbook is already protected, the menu items 

read Unprotect Sheet and Unprotect Workbook.  
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Don't enter a password unless absolutely necessary. If you forget the password, you won't be able to unprotect 

the worksheet, so you won't be able to change, delete, or format any of the Locked cells! 

 

orking with Worksheets 

Viewing, Renaming, Inserting, and Deleting Worksheets 

Worksheet tabs are found in the bottom left area of the workbook. To view a worksheet, 

click on its tab. If the workbook window is not wide enough to display all of the tabs, use 

the arrows to the left of the tabs to navigate left or right, or right-click on any of the arrows and select the tab 

from the list that displays.  

 

To rename a worksheet, right-click on the worksheet tab, select Rename from the context menu, and type a 

new name. Or, double-click on the worksheet tab and type a new name. To insert a worksheet, right-click on a 

worksheet tab and select Insert from the menu. Excel always inserts the worksheet to the left of the current 

worksheet. To delete a worksheet, right-click on the worksheet tab and select Delete from the context menu. 

 

Moving Worksheets 

Sometimes we want our worksheets to be arranged in a different order. To move a worksheet in the same 

workbook, right-click on the tab of the source worksheet and click "Move or Copy." In the Move or Copy 

window, click the name of the worksheet that you want the sheet to be inserted before, and click OK.  

 

To move a worksheet to a new workbook, right-click on the tab of the source worksheet and click "Move or 

Copy." In the Move or Copy window, click the drop-down arrow under “To Book:” and click (new book). Excel 

removes the worksheet from the existing workbook and opens a new workbook containing the moved 

worksheet. 

 

To move a worksheet to another existing workbook, we recommend copying the worksheet as instructed below, 

and then deleting the original worksheet when the worksheet has been successfully pasted. Using cut and paste 

is an option, but if something happens to the PC before pasting occurs, a valuable worksheet could be lost. 

 

Copying Worksheets 

Rather than start from scratch, it is often easier to copy, and then modify, an existing worksheet. To copy a 

worksheet in the same workbook, right-click on the tab of the source worksheet and click "Move or Copy." In 

the Move or Copy window, check the “create a copy” box, click the name of the worksheet that you want the 

sheet to be inserted before, and click OK.  

 

W 
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To copy a worksheet into a new workbook, right-click on the tab of the source worksheet and click "Move or 

Copy." In the Move or Copy window, click the drop-down arrow under “To Book:” and click (new book). Excel 

opens a new workbook containing the copied worksheet. 

 

To copy a worksheet from one workbook to another existing workbook, right-click the top left corner cell to 

select all cells and click Copy. Open the other Excel workbook, find an empty worksheet, right-click the top left 

corner cell to select all cells, and click Paste. Return to the first worksheet and press ESC to remove the 

animated border. 
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Producing a Spread Sheet for a Problem Situation 
 
Spread sheets are surprisingly helpful when given mathematical problems are faced, in everyday life situations. 

In this unit we will find out how you can use a spread sheet to calculate a problem, which many people will face 

in their adult lifetime.  Mary has to face the fact that she requires to start a fund for her old age. She has to 

determine if she can afford the premiums throughout the policy, as well as calculate what the premiums will 

cost her, in the years to come until she retires. Mary will also like to know what the final amount is that she will 

be paid out, once the policy matures. 

 

So let’s start with the simple solution of drawing up a spreadsheet which is going to depict the growth of the 

monthly premiums for the next ten years which Mary’s policy requires to mature and give her a payout which 

she requires for her retirement. ABC Insurers’ Blue policy package guarantees a 12% annual payout for every 

year which the policy is maintained at the agreed rate. This is calculated on the amount that the policy holder 

has paid into their policy and is calculated on an annual basis, and then added to the total sum payable at the 

end of the policy term.  

 

Before we start, let’s summarise what there is to calculate: 

1. An	annual	increase	for	the	policy	must	be	calculated	to	show	Mary	what	her	monthly	premiums	will	

be	

2. The	annual	calculation	of	the	premiums	paid	as	well	as	the	12%	added	by	ABC	Insurers	

3. The	total	amount	which	Mary	will	receive,	on	maturation	of	the	policy	

 

Now let’s start with the first of the three problems we require answers to, by making use of a spreadsheet. We 

will use the following step-by-step process to setup the spreadsheet for the calculation of Mary’s problem: 

1. Create	a	new	spreadsheet	from	the	program,	Microsoft	Excel	(we	will	create	the	spreadsheet,	

change	where	the	spreadsheet	is	saved	as	well	as	add	a	user	name	to	the	spreadsheet)	

2. Alter	and	change	the	view	of	the	spreadsheet	so	that	it	is	comfortable	for	us	to	use	(we	will	adjust	

the	view,	toolbars,	freeze	cells	and	columns	as	well	as	resize	the	window)	

3. We	will	add	and	manipulate	the	formulae	required	to	complete	the	problem	in	the	spreadsheet	(we	

will	make	use	of	all	five	of	the	following	calculation	methods	(Addition,	Subtraction,	Multiplication,	

Division,	Percentage)	

4. We	will	change	the	data	to	test	possible	solutions	to	the	given	problem	without	having	to	change	

formulae	we	have	used.		

5. We	will	use	hypothetical	scenarios	which	will	demonstrate	different	possible	outcomes	
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Part 1 - Create a new spreadsheet from 

the program, Microsoft Excel (we will 

create the spreadsheet, change where 

the spreadsheet is saved as well as add a 

user name to the spreadsheet) 

1. Start	off	with	creating	a	new	

spreadsheet	document	from	

Microsoft	Excel	

 

2. Then	go	to	the	File,	Save	As,	and	

then	select	the	place	where	you	

would	like	to	save	the	document.	

For	now,	let’s	just	keep	it	simple	by	

making	the	default	file	location,	the	

desktop	of	the	computer.		

 

3. You	then	need	to	select	the	Desktop	

and	then	type	in	the	name	of	the	file	

which	you	are	creating;	“Mary’s	

Pension	Premiums”.		

 

4. Once	you	have	completed	that,	then	

you	need	to	open	the	file	from	

where	you	have	saved	it	and	select	

the	File,	Prepare,	Properties	path	to	

get	to	the	area	where	you	can	

complete	your	personal	details	as	

the	User	of	this	file.	Once	completed,	

you	can	save	the	file	and	then	close	

it.	(As	seen	in	the	picture	below) 
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Part 2 - Alter and change the view of the spreadsheet so that it is comfortable for us to use (we will 

adjust the view, toolbars, freeze cells and columns as well as resize the window) 

1. In	order	for	us	to	see	the	spreadsheet	properly,	we	might	need	to	resize	the	window	where	

spreadsheet	is	displayed.	This	can	be	done	by	maximising	the	document,	by	simply	clicking	on	the	

middle	icon	on	the	top	right	hand	corner	of	the	window	where	the	spreadsheet	is	displayed		

 

2. To	adjust	the	view	of	the	spreadsheet,	if	the	view	is	

still	not	comfortable,	you	can	change	the	size	of	the	spreadsheet’s	

view	by	increasing	the	percentage	in	the	bottom	right	hand	corner	of	

the	spreadsheet.	You	will	find	that	next	to	the	percentage	selector	at	

the	bottom	of	the	window,	there	are	three	icons	depicting	different	

views	which	can	be	selected	for	the	current	spreadsheet.	They	are	

Normal,	Page	Layout	and	the	Page	Break	views.	Once	you	have	

selected	the	Page	Break	area	(where	the	pages	are	separated	from	

one	another)	you	will	be	able	to	view	the	pages	individually.	The	

Normal	view	is	the	default	view,	which	is	the	one	that	you	will	be	working	on	when	the	spreadsheet	

opens.		

 

3. By	selecting	the	View,	Toolbar	option,	you	are	able	to	select	and	de-select	the	

Toolbars	which	you	would	like	to	view	at	the	top	of	the	document.	Sometimes	when	all	the	

Toolbars	are	selected,	it	becomes	cluttered	and	the	usage	of	these	very	functional	items	becomes	

confusing.	Select	the	Toolbars	you	require	and	de-select	those	not	needed.		
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4. Freezing	rows	and	columns	assists	us	with	the	consistent	view	of	certain	

elements	of	data	which	are	in	these	areas	(rows	and	columns).	When	you	have	a	lot	of	data	to	enter	

along	a	range	of	columns	or	rows,	you	may	require	the	data	in	the	first	row	or	column	to	remain	in	

view,	to	ensure	that	you	enter	the	data	in	the	correct	row	or	column.	This	action	is	known	as	the	

freezing	of	rows	or	columns	and	can	be	done	as	follow:	

Ø To	

freeze	a	column,	you	

need	to	firstly	select	

the	column	where	

you	would	like	to	

freeze	the	selection,	

by	clicking	on	the	

column’s	alphabetical	

number.	

 

Ø Once	

you	have	selected	the	

column	where	the	

freeze	will	keep	the	

view,	you	need	to	

select	the	Freeze	

Frames	icon	from	the	

View	toolbar.	

 

 

Ø Once	you	have	selected	the	

freeze	column	selection	on	the	menu,	you	

will	find	that	the	area	which	you	have	

stipulated	is	now	shown	with	a	solid	black	

line.	When	you	scroll	further	to	the	right,	

you	will	find	that	the	letters	of	the	columns	

will	continue	scrolling,	but	the	area	which	

you	selected	for	the	freeze,	will	remain	in	

view.		
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Ø By	following	exactly	the	same	steps,	but	instead	of	selecting	a	column,	you	can	

select	a	row,	you	will	be	able	to	freeze	that	row	and	scroll	through	the	next	rows,	while	still	

having	the	data	in	that	row,	visible.		

 

Part 3 - We will add and manipulate the formulae required to complete the problem in the 

spreadsheet (we will make use of all five of the following calculation methods (Addition, Subtraction, 

Multiplication, Division, Percentage) 

 

Getting back to Mary’s requirements for calculating by how much her premiums will increase and what the total 

amount is that she will receive at the maturation date of her policy, we need to fill the spreadsheet with the 

information as well as the calculation formulae which will assist us with the calculations. Mary’s premiums will 

start as R200 per month and increase with 10% annually, her Insurance company will add 12% to the total 

amount she has saved, per year. Upon maturity, they will pay out a bonus of 22% of all premiums paid by Mary.  

 

Now let’s firstly start to enter the relevant information into a spreadsheet. In the picture below, you will find 

how the rows and columns have been used to enter the data, in preparation for the calculations which has to be 

done: 

 

Now that we have the headings, let’s enter the data into the spreadsheet and formulate it so that it can assist 

with the calculations. You will see that in this picture, we have added the formula (in the formula bar) for what 

we would like to have calculated.  
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Cell B2 will be the premium for the 

first year. Here we are using cell A1 as 

the cell where the initial premium is 

entered. Cell C2 will give us the total 

premiums paid for year 1; as you can 

see in the formula, we have asked for 

the answer of the sum of the premium 

multiplied by 12, for the amount of 

months that it will be paid.  
 

Before we can start that, we need to 

prepare the cells which we are going 

to be working with, according to the 

type of information which will be 

displayed in them. For this particular 

purpose, Mary’s premium calculations, 

we will require the cells in accounting 

purposes.  
 

In order to format them you need to 

firstly select the cells which must be in 

accounting format by highlighting 

them and then right-clicking and 

selecting the Format Cells option.  

 

From this window, you need to select 

the Number tab, then select the 

Accounting option under Category. 

Finally you need to ensure that your 

decimal places is set at 2, as there are 

two decimals after the comma and 

lastly, you need to select the South 

African Rand sign “R” as the Symbol 

used for the answers to the formulae 

we will be using in our spreadsheet.  
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Continuing to the formulation of the cells where 

we will be entering the data, we start off with the 

formulation of the first cell.  

 

Firstly, we start by adding the formula we require 

the first cell B2 to depict. As the heading says, this 

cell will show the total premium for the first year 

of the policy.  

 

As cell A1 will show the starting premium, this cell 

will show the total amount paid by Mary for the 

first year. Therefore is has to multiply the total 

amount of the premium for that year, by twelve. 

Therefore the formula in the cell being B2 

(current premium for the year, multiplied by 12 

(the amount of premiums to be paid in that year.  

 

 

The next thing we need to calculate is the amount 

of savings which Mary’s insurance company will 

add to her total after every year of her 

maintaining her premiums for the policy. In cell 

D1 we show the formula where the total amount 

paid for the year is taken and 12% is added to 

that total to get the annual amount for Mary.  

 

 

Once we add the starting premium in cell A1, you 

will see that the spreadsheet will calculate the 

totals in the cells where you have stipulated the 

formulas. As you can see from the first row, Mary 

would have paid R2 400.00 in premiums for the 

year, and she earned an additional R 288.00 over 

and above her premiums paid, in interest.  
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We continue with the second year, by adding 

the formula to cell B3 where we state that the 

amount in B3 will be the previous years’ 

premium, plus 10% added to it for it to maintain 

its current worth, in line with inflation.  

 

 

 

We then go on to cell C3 where we enter the 

formula for the total amount of premiums paid 

for that year.  

 

 

 

 

 

In cell D3, we have to add the total amount of 

premiums paid, plus the previous years’ 

earnings and add 12% onto that, to show the 

interest which Mary has earned for the second 

year of her policy at ABC Insurers.  

 

 

 

Finally we can ascertain that Mary has earned 

R316.80 just in interest for the second year. 

 

 

 

 

 

On Your Own 

Complete the spreadsheet from years three to ten in columns A, B and C.  
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Once completed, your spreadsheet 

should like this: 

 

 

 

 

 

 

 

 

Now we need to add the areas 

where the totals will be calculated 

to; add the following items, as per 

the picture below, to your 

spreadsheet: 

 

 

 

 

 

 

 

And change the formulation of the 

cells to Accounting, ensure the 

decimal is correct as well as the 

currency indicator. Use the cells as 

highlighted in the picture to the 

right: 

C13, D13, D15, D17 
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Now that we have the totals of the formulas, we can 

continue to complete the grand totals of the various 

columns, so that Mary can see what her total pay-

out will be, as well as determine what the total 

amount is she paid into the policy, the interest she 

earned as well as what the 22% bonus payment will 

be.  

 

Firstly, we will determine what the total payable 

amounts are for the premiums Mary has paid; this is 

done by simply adding the formula in cell C13, as 

shown in the picture to the right. 

 

Then the interest she has earned; 

 

The 22% bonus payment from her insurer; 

 

 

 

 

 

And lastly the total amount her of her policies’ 

maturation. 

 

 

 

 

Looking at the completed spreadsheet, we can 

ascertain that Mary will be paid out a total amount 

of R52 264.55; we can also see that Mary paid in a 

total of R38 249.82 in premiums throughout the ten 

years of the policy, meaning that she would have 

earned a total of R 14014.73 in interest and bonus 

payments alone.  
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Part 4 - We will change the data to test possible solutions to the given problem without having to 

change formulae we have used.  

Let’s say, hypothetically, Mary was able to afford R300 per month, calculate what her totals will be with regards 

to the: 

Total amount she paid in premiums:  R     

Interest she has earned:    R     

The bonus amount payable:   R     

The total amount of the mature policy:  R     

 

And if Mary’s employer said that he will pay R250 towards the policy, if Mary matches his amount, what will her 

totals be then? 

Total amount she paid in premiums:  R     

Interest she has earned:    R     

The bonus amount payable:   R     

The total amount of the mature policy:  R     

 

Part 5 - We will use hypothetical scenarios which will demonstrate different possible outcomes 

If Mary decided to extend the lifetime of the policy from 10 to 15 years keeping her initial premium amount, 

what would her totals be then? 

Total amount she paid in premiums:  R     

Interest she has earned:    R     

The bonus amount payable:   R     

The total amount of the mature policy:  R     

 

And then instead of 15 years, what will it be if she kept it for 25 years when she can afford R300 as an initial 

premium? 

Total amount she paid in premiums:  R     

Interest she has earned:    R     

The bonus amount payable:   R     

The total amount of the mature policy:  R     
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ctivity – On your own 

In this activity, you are required to identify which of the mentioned situations can be solved by 

the use of a spreadsheet and then prepare a spreadsheet to assist in solving the problem. Out 

of the possible situations, identify one which you feel the solution is best suited when solved 

with a spreadsheet and then plan and prepare your spreadsheet accordingly.  

 

Situations: 

XYZ Printers 

Danny and Mary are the buyers for the printing company XYZ Printers. The company has in the past been 

buying supplies from six different suppliers, but the prices are not the same. They have seen similar products 

from different suppliers, some costing 30% more than others! In order to save their company money, they 

need to identify the various suppliers and their goods as well as a pricing structure to identify the cheapest 

products from each supplier. They need to get a pricing sheet from their suppliers, match it up with all the 

products they require and assemble it and then identify which supplier has the most competitive rates for 

the products they use. 

 

CC Optometrists 

Patient cards of CC Optometrists are still completed in pen and then manually filed. This system, although 

somewhat effective, have though got its own problems. Sometimes cards are not filed correctly or go 

missing. CC Optometrists require a system where they can file all their patients’ details electronically and 

then recall them as necessary. All the fields are the same, they just require diriment cards (sheets) for every 

patient to be able to track the patients’ requirements and meetings.  

 

Jambo Cash and Carry 

Jambo Cash and Carry (JCC) is a small, individually run company which sells products to people on a 

wholesale basis. They have been working on an “Invoice Book” system for many years, but tallying the 

invoices at the end of the day is a long and tedious affair. They require an invoicing system whereby they can 

invoice products, the amounts are automatically tallied and can then be printed for their customers. These 

invoices can then also be saved and automatically tallied at the end of the day to ensure that the invoicing 

amounts and payment amounts balance.  

 

A 
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Use Simple Built-in Functions to Format the Spread Sheet 
 

Excel's formatting options is a way to make your spreadsheets easier to read and to understand the important 

data. This section takes you through the basics of using Excel's formatting features to improve the look and 

effectiveness of your spreadsheets. 

 

Formatting Numbers in Excel 

Number formatting in spreadsheets, such as Excel, is used to change the appearance of a number or value in a 

cell in the spreadsheet. Formatting numbers does not change the actual number that you enter, but just the 

way it appears in the spreadsheet. Formatting is done to improve the appearance of the spreadsheet and to 

make the numbers easier to read and understand.  

 

Commonly Used Number Formats 

Commonly used number formats include adding percent symbols (%), commas (,), decimal places, and Rand 

signs (R). As mentioned, number formatting is attached to the cell and not to the value in the cell. For Example - 

If you select a cell containing a number formatted for currency, the plain number, the one used in calculations, 

is displayed in the formula bar.  

 

Number formatting can be applied to a single cell, entire columns or rows, a select range of cells, or the whole 

worksheet. The default format for cells containing a value is the General style. This style has no specific format 

and displays values as plain numbers – no Rand signs, commas etc.  

 

Adding Numbers in Excel  

To add two or more numbers in Excel you need to create a formula. Two important points to remember about 

Excel formulas:  

Ø formulas	in	Excel	always	begin	with	the	equal	sign	(	=	)		

Ø the	equal	sign	always	goes	in	the	cell	where	you	want	the	answer	to	go	
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Use Cell References in Formulas  

Even though you can use numbers directly in a formula, it is much better to use the references or addresses of 

the cells containing the numbers you want to add. If you use the cell references rather than the actual data, 

later, if you need to change the data in either cell, the results of the formula will update automatically without 

you having to rewrite the formula.  

 

Setting Up the Addition Formula  

As an example, let’s create a formula in cell C1 that will add the contents of cell B1 from cell A1.  

 

Our formula:  

=A1 + B1 

 

Our data:  

Ø Place	the	number	20	in	cell	A1		

Ø Place	the	number	10	in	cell	B1	

 

Formula Steps  

To add 10 to 20 and have the answer appear in cell C1:  

Ø Type	an	equal	sign	in	cell	C1.		

Ø Click	on	cell	A1	with	the	mouse	pointer.		

Ø Type	the	plus	sign	(	)	in	cell	C1.		

Ø Click	on	cell	B1	with	the	mouse	pointer.		

Ø Press	the	ENTER	key	on	the	keyboard.		

Ø The	answer	30	should	be	present	in	cell	C1.		

Ø Even	though	you	see	the	answer	in	cell	C1,	if	you	click	on	that	cell	you	will	see	our	formula	in	the	

formula	bar	above	the	work	area.		

 

To expand your formula to include additional operations - such as subtraction, multiplication, or more additions- 

just continue to add the correct mathematical operator followed by the cell reference containing your data.  
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Subtracting Numbers in Excel 

To subtract two or more numbers in Excel you need to create a formula. 

Two important points to remember about Excel formulas:  

Ø Formulas	in	Excel	always	begin	with	the	equal	sign	(=)		

Ø The	equal	sign	always	goes	in	the	cell	where	you	want	the	answer	to	appear	

 

Use Cell References in Formulas  

Even though you can use numbers directly in a formula, it is much better to use the cell references of the 

numbers you want to subtract. If you use the cell references rather than the actual data, later, if you need to 

change the data in either cell, the results of the formula will update automatically without you having to rewrite 

the formula.  

 

Setting Up the Subtraction Formula  

As an example, let’s create a formula in cell C1 that will subtract the contents of cell B1 from cell A1.  

 

Our formula:  

=A1 - B1 

 

Our data:  

Ø Add	the	number	20	in	cell	A1		

Ø Add	the	number	10	in	cell	B1	

 

Formula Steps  

To subtract 10 from 20 and have the answer appear in cell C1:  

Ø Type	an	equal	sign	in	cell	C1.		

Ø Click	on	cell	A1	with	the	mouse	pointer.		

Ø Type	a	minus	sign	(	-	)	in	cell	C1.		

Ø Click	on	cell	B1	with	the	mouse	pointer.		

Ø Press	the	ENTER	key	on	the	keyboard.		

Ø The	answer	10	should	be	present	in	cell	C1.		

Ø Even	though	you	see	the	answer	in	cell	C1,	if	you	click	on	that	cell	you	will	see	our	formula	in	the	

formula	bar	above	the	work	area.		

To expand your formula to include additional operations - such as addition, multiplication, or more subtractions 

- just continue to add the correct mathematical operator followed by the cell reference containing your data.  
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Multiplying Numbers in Excel  

To multiply two or more numbers in Excel you need to create a formula. Important points to remember about 

Excel formulas:  

Ø Formulas	in	Excel	always	begin	with	the	equal	sign	(=)		

Ø The	equal	sign	always	goes	in	the	cell	where	you	want	the	answer	to	go		

Ø The	multiplication	sign	in	Excel	is	the	asterisk	(*)	

 

Use Cell References in Formulas  

Even though you can use numbers directly in a formula, it is much better to use the references or addresses of 

the cells containing the numbers you want to add. By using cell references rather than the actual data in your 

formula, later, if you need to change your data, the results of the formula will update automatically without you 

having to rewrite the formula.  

 

Setting Up the Multiplication Formula  

As an example, let’s create a formula in cell C1 that will multiply the contents of cell B1 from cell A1.  

 

Our formula:  

= D1 * D2  

 

Our data:  

Ø Type	the	number	20	in	cell	D1		

Ø Type	the	number	10	in	cell	D2	

 

Formula Steps  

Ø To	multiply	10	to	20	and	have	the	answer	appear	in	cell	E1:		

Ø Type	an	equal	sign	in	cell	E1.		

Ø Click	on	cell	D1	with	the	mouse	pointer.		

Ø Type	an	asterisk	sign	(*)	in	cell	E1.		

Ø Click	on	cell	D2	with	the	mouse	pointer.		

Ø Press	the	ENTER	key	on	the	keyboard.		

Ø The	answer	200	should	be	present	in	cell	E1.		

Ø Even	though	you	see	the	answer	in	cell	E1,	if	you	click	on	that	cell	you	will	see	our	formula	in	the	

formula	bar	above	the	work	area.		
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Excel Division  

To divide two numbers in Excel you need to create a formula. Important points to remember about Excel 

formulas:  

Ø formulas	in	Excel	always	begin	with	the	equal	sign	(=)		

Ø the	equal	sign	always	goes	in	the	cell	where	you	want	the	answer	to	go		

Ø the	division	symbol	is	the	forward	slash	(/)	

 

Use Cell References in Formulas  

Even though you can use numbers directly in your division formula, it is much better to use the references or 

addresses of the cells containing your data. If you use the cell references rather than the actual data, later, if you 

need to change the data in either cell, the results of the formula will update automatically without you having to 

rewrite the formula.  

 

Setting Up the Division Formula  

As an example, let’s create a formula in cell E1 that will divide the contents of cell C1 by cell D1.  

 

Our formula:  

=C1 / D1 

 

Our data:  

Ø place	the	number	20	in	cell	C1		

Ø place	the	number	10	in	cell	D1	

 

Division Formula Steps  

Ø To	divide	20	by	10	and	have	the	answer	appear	in	cell	E1:		

Ø Type	an	equal	sign	in	cell	E1.		

Ø Click	on	cell	C1	with	the	mouse	pointer.		

Ø Type	the	division	sign	(	/	)	in	cell	E1.		

Ø Click	on	cell	D1	with	the	mouse	pointer.		

Ø Press	the	ENTER	key	on	the	keyboard.		

Ø The	answer	2	should	be	present	in	cell	E1.		

Ø Even	though	you	see	the	answer	in	cell	E1,	if	you	click	on	that	cell	you	will	see	our	formula	in	the	

formula	bar	above	the	work	area.		
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To expand your formula to include additional operations - such as subtraction or addition - just continue to add 

the correct mathematical operator followed by the cell reference containing your data. 

 Changing Cell Formats 

To change a cell's format, you can use one of the buttons on the Formatting toolbar, such as comma, percent or 

currency which apply pre-set styles to the selected cells. Another option is to use the Format Cells dialog box.  

 

The Number tab in the Format Cells dialog box includes the styles on the formatting toolbar as well as other 

number categories such as time, date, and fraction.  

 

There are also options for changing the currency symbol displayed to those used in other countries, the number 

of decimal places shown in a number, and how negative numbers are displayed.  

 

What are Excel Headers and Footers? 

In Microsoft Excel, headers and footers are lines of text that print at the top (header) and bottom (footer) of 

each page in the spreadsheet. They contain descriptive text such as titles, dates, and/or page numbers. They are 

used to add information to a spreadsheet that is being printed.  

 

View Headers and Footers  

Ø Headers	and	footers	are	not	visible	in	the	normal	worksheet	view.	

Ø To	view	a	header	or	footer	before	printing	the	spreadsheet,	use	the	Print	

Preview	option.	Note:	To	use	Print	Preview	in	Excel,	you	must	have	a	printer	installed	on	your	

computer.		

 

Headers and Footers Locations  

Ø A	header	or	footer	can	contain	up	to	three	pieces	of	information.	This	

information	can	appear	in	three	locations	on	the	page.	

Ø For	headers,	the	locations	are	the	top	left	corner,	the	top	centre,	and	the	top	right	

corner	of	the	page.	

Ø For	footers,	the	locations	are	the	bottom	left	corner,	the	bottom	centre,	and	the	

bottom	right	corner	of	the	page.	

 

Pre-set or Custom Headers and Footers  

Ø Excel	has	several	pre-set	headers	and	footers	that	you	can	use.	

Ø These	standard	options	include	the	sheet	name,	date,	time,	page	number,	and	file	

name.		
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Ø There	is	also	an	option	for	creating	your	own	custom	headers	or	footers	that	can	

include	text,	graphics,	or	other	spreadsheet	data.	

 

How to add headers and footers to a worksheet:  

Ø Choose	File	>	Page	Setup	from	the	menu	to	open	the	Page	Setup	dialog	box.	

Ø Select	the	Header-Footer	tab.	

Ø Select	from	the	pre-set	or	custom	header	-	footer	options.	

Ø Create	the	header	or	footer.	

Ø Preview	in	Print	Preview.	

 

Excel Formulas 

Writing the Formula  

Writing Excel formulas is a little different than the way it is done in math class. Excel formulas starts with the 

equal sign (=) rather than ending with it. The equal sign always goes in the cell where you want the formula 

answer to appear. The equal sign informs Excel that what follows is part of a formula, and not just a name or a 

number.  

 

Excel formulas look like this: 

=3 + 2 

Rather than:  

3 + 2 = 

 

Cell References in Formulas  

While the formula in the previous step works, it has one drawback. If you want to change the data being 

calculated you need to edit or rewrite the formula. A better way would be to write formulas so that you can 

change the data without having to change the formulas themselves.  

To do this, you need to tell Excel which cell the data is located in. A cell's location in the spreadsheet is referred 

to as its cell reference. To find a cell reference, simply look at the column headings to find which column the cell 

is in, and across to find which row it is in. The cell reference is a combination of the column letter and row 

number -- such as A1, B3, or Z345. When writing cell references the column letter always comes first.  

 

So, instead of writing this formula in cell C1:  

= 3 + 2  

Write this instead:  

= A1+A2  
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Note: When you click on a cell containing a formula in Microsoft Excel, the formula always appears in the 

formula bar located above the column letters  

Updating Excel Formulas  

When you use cell references in Excel formulas, the formulas will automatically update whenever the relevant 

data in the spreadsheet changes. For example, if you realize that the data in cell A1 should have been an 8 

instead of a 3, you only need to change the contents of cell A1.  

 

Excel updates the answer in cell in cell C1. The formula, itself, doesn't need to change because it was written 

using cell references.  

 

Changing the data  

• Click	on	the	cell	A1		

• Type	8		

• Press	the	ENTER	key	on	the	keyboard		

• The	answer	in	cell	C1	where	the	formula	is,	immediately	changes	from	5	to	10,	but	the	formula	itself	

is	unchanged.	

 

Mathematical Operators  

Creating formulas in Microsoft Excel is not difficult. Just combine the cell references of your data with the 

correct mathematical operator. The mathematical operators used in Excel formulas are similar to the ones used 

in math class.  

• Subtraction	-	minus	sign	(	-	)		

• Addition	-	plus	sign	(	+	)		

• Division	-	forward	slash	(	/	)		

• Multiplication	-	asterisk	(*	)		

• Exponentiation	-	caret	(^	)		

 

Order of Operations  

If more than one operator is used in a formula, there is a specific order that Excel will follow to perform these 

mathematical operations.  

 

This order of operations can be changed by adding brackets to the equation. An easy way to remember the 

order of operations is to use the acronym: 



SDA | MODULE 2 | STUDENT GUIDE 105 

 

 

BEDMAS 

The Order of Operations is:  

• Brackets	

• Exponents	

• Division	

• Multiplication	

• Addition	

• Subtraction	

 

Add the Equal (=) Sign  

When creating formulas in Microsoft Excel, you ALWAYS start by typing the equal sign. You type it in the cell 

where you want the answer to appear.  

• Click	on	cell	C1	(outlined	in	black	in	the	image)	with	your	mouse	pointer.	

• Type	the	equal	sign	in	cell	C1.	

 

Add Cell References Using Pointing  

After typing the equal sign in step 2, you have two choices for adding cell references to the spreadsheet 

formula.  

• You	can	type	them	in	or,	

• You	can	use	an	Excel	feature	called	Pointing	

 

Pointing allows you to click with your mouse on the cell containing your data to add its cell reference to the 

formula.  

 

After typing an equal sign in cell E3 in step 2:  

• Click	on	cell	A1	with	the	mouse	pointer	to	enter	the	cell	reference	into	the	formula		

• Type	a	plus	(+)	sign		

• Click	on	cell	A2	with	the	mouse	pointer	to	enter	the	cell	reference	into	the	formula	

• Press	the	ENTER	key	on	the	keyboard		

• The	answer	5	should	appear	in	cell	C1.		

 

If you have more than one row or column of data that you need to perform calculations on, it is often possible 

to copy the first formula to other cells. The easiest way to do this is to copy formulas with the fill handle. 
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How the Order of Operations Works  

Any operation(s) contained in brackets will be carried out first followed by any exponents. After that, Excel 

considers division or multiplication operations to be of equal importance, and carries out these operations in 

the order they occur left to right in the equation. The same goes for the next two operations – addition and 

subtraction. They are considered equal in the order of operations. Whichever one appears first in an equation, 

either addition or subtraction is the operation carried out first. 

 

Formatting Spreadsheets using Format Painter  

Adding formatting to your spreadsheet not only makes it more attractive and easier to read, but it can make it 

easier for users to find the information they are after. To quickly copy formatting from one part of a sheet to 

another, or to another sheet in the same workbook, use the Format Painter. Format Painter is very useful when 

you are extending a spreadsheet to accommodate new data and need to format the new cells to match the 

original data area.  

 

To use Format Painter to copy formatting options to one cell  

Ø Add	all	the	formatting	options	you	want	to	use	to	at	least	one	cell.		

Ø Click	on	that	cell	with	the	mouse	pointer	to	make	it	the	active	cell.		

Ø Click	on	the	Format	Painter	icon	on	the	formatting	toolbar.		

Ø Click	on	the	cell	that	you	want	to	copy	the	formatting	to.	

 

To use Format Painter to copy formatting options to adjacent cells  

Ø Add	all	the	formatting	options	you	want	to	use	to	at	least	one	cell.		

Ø Click	on	that	cell	with	the	mouse	pointer	to	make	it	the	active	cell.		

Ø Click	on	the	Format	Painter	icon	on	the	formatting	toolbar.		

Ø Click	on	the	first	cell	and	then	drag	the	mouse	pointer	to	select	additional	cells.	

 

To use Format Painter to copy formatting options to non-adjacent cells  

Ø Add	all	the	formatting	options	you	want	to	use	to	at	least	one	cell.		

Ø Click	on	that	cell	with	the	mouse	pointer	to	make	it	the	active	cell.		

Ø Double	click	on	the	Format	Painter	icon	on	the	formatting	toolbar.		

Ø Click	on	the	first	cell	you	want	to	copy	the	formatting	to	and	then	continue	

clicking	on	additional	cells	to	copy	the	formatting	to	these	cells	as	well.		

Ø Click	on	the	Format	Painter	icon	on	the	formatting	toolbar	to	turn	it	off.	
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Formatting Spreadsheets using AutoFormat  

Spreadsheets usually contain a lot of data. This can make it difficult, if not impossible for users to find the 

information they are looking for. Formatting a spreadsheet effectively can change that. A good choice of 

background colour, font style and font size, plus other formatting options can make most important information 

on the spreadsheet stand out from the rest of the data. If you are new to Excel, and not yet comfortable with all 

the formatting options available, you can use the AutoFormat option to give your spreadsheets a professional 

look and make them easy to read. There are 17 AutoFormat styles available. These styles affect six main 

formatting areas: number formatting, borders, fonts, patterns and background colour, alignment, and column 

and row size.  
 

Choose an Appropriate Style  

Not all the styles are appropriate for all spreadsheets. Keep in mind how the spreadsheet will be used when 

selecting an AutoFormat style:  

Ø Printed	off	and	given	to	the	audience	as	a	hand	out	

Ø Used	solely	in	a	slide	show	presentation	

Ø Emailed	to	just	a	few	associates	
 

Some of the styles are very "graphic intensive" and would not print well, and some are just not appropriate for 

business reports. Be sure to choose a style in keeping with your subject and your audience. If none of the styles 

are quite to your liking, you can modify them either before or after they have been applied to your worksheet. 

To modify a style before applying it, click on the options button in the AutoFormat dialog box. In doing so, will 

allow you to deselect any of the six formatting areas such as font, borders, or alignment before applying the 

style. The spreadsheet example in the dialog box will show you what the style will look like with the different 

options deselected.  
 

Fine-Tune Your Style Choice  

Once you have applied a style you can modify it further using Excel’s regular formatting options located under 

the Format menu and on the formatting toolbar. Many people use the AutoFormat options as a starting point 

and then use the regular formatting options to fine-tune their selection so that it meets their needs exactly. To 

apply an AutoFormat style to your worksheet  

Ø Select	only	the	data	on	the	worksheet	that	you	want	formatted.		

Ø Choose	Format	>	AutoFormat	from	the	menus	to	bring	up	the	AutoFormat	dialog	

box.		

Ø Scroll	through	the	list	of	styles.		

Ø Click	on	the	one	you	want	to	use	and	click	OK.	
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ample formatting functions in Excel: 

In Excel there are endless functions which can be used in Cells and Columns; these can also be 

adjusted to suit your needs in just about any type of sheet you want to create, suiting your needs just 

about exactly. In this section, we will take a look at some of the basic formatting options.  

 

1 - To change the cell formatting from date to number: 

• Press Ctrl + Shift + ~.  

 

Example: 

1. Enter today's date into a cell by pressing Ctrl+; the 

result is 3/10/2004. 

2. Press Ctrl + Shift + ~ to change the format to General 

formatting. 

 

2 - To round numbers to thousands:  

1. Press Ctrl+1 to open the Format Cells dialog 

box. 

2. Select the Number tab, and from Category, 

select Custom. 

3. In the Type box, enter the following Custom 

Formatting syntax:  

#,##0, ;[Red](#,##0,);- ; 

Result: 

• Original number: 5,645,625 

• The displaying formatted number: 5,646 

 

Note:  

The number formatting syntax is: 

Positive; Negative; 0; Text 

S 
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3 - To round a numbers to millions:  

1. Press Ctrl+1 to open the Format Cells dialog box. 

2. Select the Number tab, and from Category, select 

Custom. 

3. In the Type box, enter the following Custom 

Formatting syntax:  

#,##0,, ;[Red](#,##0,,);- ;  

 

Result: 

• Original number: 5,645,625 

• The displaying formatted number: 6 

 

Note:  

The number formatting syntax is: 

Positive; Negative; 0; Text 

 

4 - There are two ways to colour numbers according to 

criteria:  

■Custom formatting for a number with criteria  

■Conditional formatting 

Using custom formats for numbers with criteria 

Your options for colouring a number are not limited to 

displaying negative numbers red. You can colour positive 

and/or negative numbers in any colour you wish (do not get 

excited - the number of colours is limited to eight, and most 

are difficult to read). Do this by adding the name of the colour 

to the number format in brackets. 

Example: [BLUE] #,##0 ;[RED](#,##0) 

 

A positive number is displayed in blue; a negative number is 

displayed in red; and 0 is displayed in blue (since there is no 

third section, 0 receives the format of the positive number by 

default). Add a condition to the formatting, and have each 

section be displayed in a different colour: [BLUE] [>5000]#,##0 ;[RED](#,##0); #,##0 
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5 - To colour rows based on text criteria:  

1. Select a cell in the region, and press Ctrl + Shift+ to select the Current Region. 

2. From the Format menu, select Conditional Formatting. 

3. In Condition 1, select Formula Is, and type =$C1="Amazon". 

 

 

 

 

 

 

 

 

 

 

 

 

4. Click Format, select the Font tab, select a colour, and then click OK. 

5. In Condition 2, select Formula Is, and type =$C1="Intel". 

 

 

 

 

 

 

 

 

 

 

6. Repeat step 4, select a different colour than you selected for Condition 1, and then click OK. 

7. In Condition 3, select Formula Is, and type =$E1="Excel Tip".  

8. Repeat step 4, select a different colour than you selected for Condition 1 and Condition 2, and then click OK 

twice. 

 

Note:  

Be sure to distinguish between absolute reference and relative reference when entering the formulas. 
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6 - To prevent text from extending beyond the report width: 

In this example, enter a statement into cell A59, without the text spilling over into cells outside the report range 

(the report goes from column A to D). 

1. First, ensure that the typed text was typed in cell A59 only. 

2. Select cells A59:D59. 

3. Select Home -> Fill (in Editing Group) -> Justify.  

4. The following message appears: Text will extend below selected range. (Note: Before clicking OK, ensure that 

the cells below row 59 are blank.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

7 - To apply formatting to cells containing text only, use Conditional Formatting:  

1. Select a range of cells containing text. 

2. Select Home-> Conditional Formatting (in Styles Group). 

3. Select New Rule -> Use a formula to determine which 

cells to format. 

4. In Format values where this Formula is True enter the 

formula: =ISTEXT(A1) 

5. Click Format, select the desired format from the 

Format Cells dialog Box, and then click OK. 

6. Click OK to close the New Formatting Rule dialog box. 



SDA | MODULE 2 | STUDENT GUIDE 112 

 

 

8 - To change the number formatting:  

Using the mouse 

1. Select	Home	->	open	Number	Format	dropdown	

box	(in	Number	Group).	

2. Using	keyboard	shortcuts	

3. To	open	the	Number	dropdown	box	press	

Alt+H+N+Down	Arrow,	and	press	the	Down	Arrow	

again.	

4. To	change	the	number	format:	

5. From	date	to	number	press	Ctrl+Shift+~		

6. From	number	to	date	&	time	press	Ctrl+Shift+@	

7. From	number	to	date	press	Ctrl+Shift+#	

 

 

 

 

9 - To automatically wrap text:  

1. Type the following text into a 

cell: Get the Most out of Excel 

2007. 

2. Select Home -> Wrap Text (in 

Alignment Group). 

Or 

Click the dialog box Launcher 

arrow symbol in the bottom-right 

corner of the Alignment Group to 

open the Format Cells dialog box 

-> Alignment tab  

Or  

Press Ctrl+1. 

3. In the Alignment tab in Text control section check the Wrap text box and click OK. 
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10 - To color a unique record in a range, use Conditional Formatting: 

 

Option 1: 

1. Select the range of cells (or 

select the entire column). 

2. Select Home -> Conditional 

Formatting (in Styles Group) -> 

Highlight Cells Rules -> Duplicate 

Values. 

3. Select Unique, and from Values 

with dropdown list select the 

format and click OK. 

 

Option 2: 

1. Select the range of cells (or 

select the entire column). 

2. Select Home -> Conditional 

Formatting (in Styles Group) -> 

New Rule. 

3. Select Use a formula to 

determine which cells to format. 

4. In Format values where this formula is true text box enter the following formula (ensure the Absolute and 

Relative references): 

=COUNTIF($A$1:A1,A1)=1 

5. Click Format, and select the Patterns tab. 

6. Select a color, and then click OK twice 
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You are now ready to go through a check list. Be honest with yourself. 

 

Tick the box with either a √ or an X to indicate your response. 

 

� I	am	able	to	plan	and	design	computer	spread	sheet	documents	to	solve	a	business	

problem		

� I	am	able	to	format	data	in	a	spread	sheet	

� I	am	able	to	create	graphs		

� I	am	able	to	write	macros		

� I	am	able	to	solve	problems	using	a	spread	sheet	

 

 

	

 

 

 
 
 
 
 

	
	

You	must	think	about	any	point	you	could	not	tick.	Write	this	down	as	a	goal.	

Decide	on	a	plan	of	action	to	achieve	these	goals.	Regularly	review	these	goals.	
 

 

 

 

 

 

 

 

 

My	Goals	and	Planning:	
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________

________________________________________________________________________________________
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NATIONAL CERTIFICATE: BUSINESS 

ADMINSERVICES  

MODULE 2 | US 7570  USE INTERFACE (GUI)- BASED WORD 

PROCESSOR TO FORMAT DOCUMENTS 
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People credited with this unit standard are able to :  

• demonstrate	knowledge	of	the	uses	and	advanced	features	of	a	word	processing	package	on	a	

personal	computer	(including	use	of	spell-check	and	grammar	checking	tools)		

• create	and	use	bulleted	and	numbered	lists	and	tables		

• import	and	position	pictures,	images	and	objects	into	a	word	processing	document	

• use	the	mail	merge	feature		

• Save	the	document	in	a	format	that	it	can	be	used	in	other	applications		

Unit Standard 7570  
 

SPECIFIC	OUTCOMES	AND	RELATED	ASSESSMENT	CRITERIA	

SO	1	 WORK	WITH	MULTIPLE	DOCUMENTS	WITHIN	A	WORD	PROCESSING	
APPLICATION.	(Minimum	2	documents.)	

AC	1	 A	number	of	documents	are	opened,	in	order	to	switch	control	between	them.		
AC	2	 Documents	are	sized	so	that	at	least	two	documents	can	be	seen	at	the	same	time.		
AC	3	 Text	is	manipulated	between	active	documents.		
SO	2	 FORMAT	TEXT	USING	A	WORD	PROCESSING	APPLICATION.	
AC	1	 A	border	is	applied	to	text	and	removed	from	text	to	enhance	the	look-and-feel	of	a	document.		
AC	2	 Shading	is	applied	to	text	and	removed	from	text.	(Shading	is	also	refers	to	a	filling.)	
AC	3	 The	current	date	and	time	is	added.		

AC	4	
The	use	of	an	automatic	field	added	capability	of	the	word	processor	is	demonstrated,	in	terms	
of	its	purpose	and	use	to	speed	up	typing	of	words	and	sentences.	(Date,	time,	document	
information.)	

AC	5	 Special	characters	and	symbols	are	inserted	into	an	existing	word	processing	document.		

AC	6	 Hyphenation	is	activated	and	applied	into	an	existing	word	processing	document.		
(At	least	one	of	the	following:	Automatic,	soft,	optional.)	

AC	7	 Special	effects	are	applied	to	text	in	an	existing	word	processing	document.	(Animation,	text	
border.)	

AC	8	 Character	Spacing	is	changed	in	an	existing	word	processing	document.		
SO	3	 FORMAT	PARAGRAPHS.	

AC	1	
Tabs	are	set,	reset	and	removed	from	an	existing	word	processing	document.	(Tabs:	left	tab,	
right	tab,	center	tab,	decimal	align	tab,	leading	character	tab;	at	least	2	methods	of	setting	tabs	
are	demonstrated.)	

AC	2	 The	default	tab	setting	is	changed	in	an	existing	word	processing	document.		

AC	3	 Bullets	are	applied	to	and	removed	from	an	existing	word	processing	document.	(Automatic	
while	entering,	to	existing	text.)	

AC	4	 Bullet	formats	are	changed	within	an	existing	word	processing	document.	(Bullet	character,	
bullet	position,	text	position.)	

AC	5	 The	difference	between	numbered	text	and	outline	numbered	text	is	explained	in	terms	of	
their	use	in	an	existing	word	processing	document.		

AC	6	

Numbering	is	applied	to	and	removed	from	selected	text	in	an	existing	word	processing	
document.		
(Automatic	while	entering,	to	existing	text;	single	level	numbering,	multi-level	numbering	to	at	
least	three	levels.)	

AC	7	 Numbering	formats	are	changed	within	existing	paragraph.	(Number	format,	number	style,	
number	position,	text	position.)	

AC	8	 A	border	is	applied	to	and	removed	from	an	existing	word	processing	document.		
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AC	9	 Paragraph	spacing	is	changed	in	an	existing	word	processing	document.	(Line	spacing,	before	
and	after	paragraph.)	

SO	4	 FORMAT	PAGES	WITHIN	AN	EXISTING	WORD	PROCESSING	DOCUMENT.		
AC	1	 The	page	format	of	a	document	is	changed	according	to	given	specifications.	(Page	size,	page	

orientation,	margins,	layout.)	
AC	2	 Manual	Page	breaks	are	inserted	into	an	existing	word	processing	document.		
AC	3	 Page	breaks	are	deleted	from	an	existing	word	processing	document.		
AC	4	 A	border	is	applied	to	and	removed	from	an	existing	word	processing	document.		

 

SO	5 FORMAT	AN	EXISTING	WORD	PROCESSING	DOCUMENT	
AC	1	 Methods	of	automatically	formatting	a	document	are	explained.	(Templates,	styles,	manual.)	
AC	2	 A	header	is	added	to	and	removed	from	a	document.		
AC	3	 A	footer	is	added	to	and	removed	from	a	document.	
AC	4	 Page	numbers	are	added	to	a	document.		
AC	5	 A	document	is	split	into	sections	according	to	given	specifications	(Minimum	2	sections.)	
AC	6	 Endnotes	and	footnotes	are	inserted	into	a	document.		
AC	7	 A	Section	Break	is	inserted	into	and	deleted	from	an	existing	word	processing	document.		

SO	6 

TEMPLATES	ARE	USED	AND	CREATED	TO	FACILITATE	EASE	OF	USE	IN	
FUTURE,	BY	HAVING	DEFAULT	OPTIONS	WHEN	STARTING	A	NEW	WORD	
PROCESSING	DOCUMENT.		

AC	1 A	document	is	created	using	an	existing	template.		
AC	2 A	document	is	saved	as	a	new	template	with	a	specific	name	and	in	a	specific	folder.		

AC	3 
A	created	template	is	used	to	have	pre-defined	default	options	when	starting	a	new	word	
processing	document.	(Default	options	include	but	is	not	limited	to:		
Document	type,	document	format	depending	on	type	chosen	

 

										CRITICAL	CROSS	FIELD	OUTCOMES	
UNIT	STANDARD	CCFO	IDENTIFYING		
Identify	and	solve	problems	in	which	responses	display	that	decisions	using	critical	and	creative	thinking	
have	been	made	by	working	with	multiple	documents,	and	applying	special	formatting	to	a	document.		
	
UNIT	STANDARD	CCFO	ORGANISING		
Organize	and	manage	oneself	and	one`s	activities	responsibly	and	effectively	by	switching	control	between	
documents	and	manipulating	text	between	documents.		
	
UNIT	STANDARD	CCFO	COLLECTING		
Collect,	analyse,	organise,	and	critically	evaluate	information	by	selecting	graphics,	symbols	and	special	
characters	to	be	included	in	the	text.		
	
UNIT	STANDARD	CCFO	COMMUNICATING		
Communicate	effectively	using	visual,	mathematical	and/or	language	skills	in	the	modes	of	oral	and/or	
written	persuasion	when	engaging	with	the	subject	by	organizing	and	formatting	documents	
appropriately.		
	
UNIT	STANDARD	CCFO	SCIENCE		
Use	science	and	technology	effectively	and	critically,	showing	responsibility	towards	the	environment	and	
health	of	others	by	using	a	word	processing	application	to	format	documents.  
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All qualifications and part qualifications registered on the National Qualifications Framework are public 
property. Thus the only payment that can be made for them is for service and reproduction. It is illegal 
to sell this material for profit. If the material is reproduced or quoted, the South African Qualifications 
Authority (SAQA) should be acknowledged as the source.  

SOUTH AFRICAN QUALIFICATIONS AUTHORITY  

REGISTERED UNIT STANDARD THAT HAS PASSED THE END DATE:  

 

Produce word processing documents for business  

SAQA US 
ID 

UNIT STANDARD TITLE 

7570  Produce word processing documents for business  

ORIGINATOR ORIGINATING PROVIDER 

SGB Information Systems and 
Technology  

  

QUALITY ASSURING BODY 

-   

FIELD SUBFIELD 

Field 10 - Physical, Mathematical, Computer and Life Sciences Information Technology and Computer 
Sciences  

ABET 
BAND 

UNIT STANDARD 
TYPE 

OLD NQF LEVEL NEW NQF LEVEL CREDITS 

Undefined  Regular-
Fundamental  

Level 3  NQF Level 03  5  

REGISTRATION STATUS REGISTRATION START 
DATE 

REGISTRATION END 
DATE 

SAQA DECISION 
NUMBER 

Passed the End Date -  
Status was "Reregistered"  

2003-12-03  2004-12-02  SAQA 1351/03  

LAST DATE FOR ENROLMENT LAST DATE FOR ACHIEVEMENT 

2005-12-02    2008-12-02    

 

In all of the tables in this document, both the old and the new NQF Levels are shown. In the text (purpose statements, 

qualification rules, etc), any reference to NQF Levels are to the old levels unless specifically stated otherwise.  
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This unit standard is replaced by:  

US ID Unit Standard Title 
Old NQF 
Level 

New NQF 
Level 

Credits 
Replacement 
Status 

116938  
Use a Graphical User Interface (GUI)-based word 
processor to create and edit documents  

Level 1  
NQF Level 
01  

4  Complete  

116942  
Use a GUI-based word processor to create merged 
documents  

Level 3  
NQF Level 
03  

3  Complete  

117924  
Use a Graphical User Interface (GUI)-based word 
processor to format documents  

Level 2  
NQF Level 
02  

5  Complete  

119078  
Use a GUI-based word processor to enhance a 
document through the use of tables and columns  

Level 3  
NQF Level 
03  

5  Complete  

 

PURPOSE OF THE UNIT STANDARD  

People credited with this unit standard are able to :  
 
•  demonstrate knowledge of the uses and advanced features of a word processing package on a personal 
computer (including use of spell-check and grammar checking tools)  
 
•  create and use bulleted and numbered lists and tables  
 
•  import and position pictures, images and objects into a word processing document  
 
•  use the mail merge feature  
 
•  Save the document in a format that it can be used in other applications  

 

LEARNING ASSUMED TO BE IN PLACE AND RECOGNITION OF PRIOR LEARNING  

Open.  
 
The credit value of this unit is based on a person having the prior knowledge and skills to produce and use word 
processing documents using basic functions.  

 

UNIT STANDARD OUTCOME HEADER  

Change appearance of document  

 

Specific Outcomes and Assessment Criteria:  

 

SPECIFIC OUTCOME 1  

Change appearance of document.  
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OUTCOME RANGE  

Page and section numbers, date author, file name, symbol  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Borders are added to a document.  

 

ASSESSMENT CRITERION 2  

2. An appropriate document template is chosen or created and used for a specific task.  

 

ASSESSMENT CRITERION 3  

3. Existing styles are applied to document.  

 

ASSESSMENT CRITERION 4  

4. Headers and footers are inserted into document and formatted.  

 

ASSESSMENT CRITERION 5  

5. Page breaks and section breaks are inserted.  

 

ASSESSMENT CRITERION 6  

6. Symbols, date and time and page numbers are inserted in the text.  

 

ASSESSMENT CRITERION 7  

7. Endnotes and footnotes are inserted.  

 

SPECIFIC OUTCOME 2  

Check document for spelling and grammar.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Spell-check tool is used and appropriate changes are made.  

 

ASSESSMENT CRITERION 2  

2. Grammar tool is used and changes are made where appropriate.  
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ASSESSMENT CRITERION 3  

3. Thesaurus is used.  

 

SPECIFIC OUTCOME 3  

Create lists and tables in document.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Bulleted or numbered lists are inserted into document.  

 

ASSESSMENT CRITERION 2  

2. Bullets and numbers are formatted.  

 

ASSESSMENT CRITERION 3  

3. A standard table is created.  

 

ASSESSMENT CRITERION 4  

4. Table cell attributes are changed.  

 

ASSESSMENT CRITERION 5  

5. Rows and columns are inserted and deleted.  

 

ASSESSMENT CRITERION 6  

6. Borders are added to table.  

 

ASSESSMENT CRITERION 7  

7. Automatic table formatting tool is used.  

 

SPECIFIC OUTCOME 4  

Add and manipulate Pictures, Images and Objects in a document.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. A picture, image or graphics file is added to document.  

ASSESSMENT CRITERION RANGE  
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Change line colours, line style, width and fill colours 
  

 

ASSESSMENT CRITERION 2  

2. Autoshapes are added to document and manipulated.  

ASSESSMENT CRITERION RANGE  

Move, Re-size, Re-orientate 
  

 

ASSESSMENT CRITERION 3  

3. A spreadsheet or derived image, chart or graph is added to a document.  

 

ASSESSMENT CRITERION 4  

4. An image within a document is manipulated.  

 

SPECIFIC OUTCOME 5  

Use Mail Merge feature.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. A mailing list or data file is created.  

 

ASSESSMENT CRITERION 2  

2. A letter or label list is created by merging mailing or data list with letter, label document or envelope.  

 

SPECIFIC OUTCOME 6  

Document is saved in a different file format.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Document is saved in a different file format.  

ASSESSMENT CRITERION RANGE  

Text file (.txt), Rich Text Format (.rtf), Document Template, Software type, Version 
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ASSESSMENT CRITERION 2  

2. Document is saved in format appropriate for viewing by a web browser.  

ASSESSMENT CRITERION RANGE  

Hyper Text Markup Language (.htm or .html) 
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Getting Started with Word 2007 
 

 

 

 

The New Word Screen Layout 

 

 

 

Curser 
Word 
count  
 

Current Page and 
number of pages 
 

Page View 
Buttons 
 Zoom 

Control 
 

Vertical 
Scrollbar 
 

Office 
Button 
 

Quick 
Access 
tool bar 
 Tab List 

 

Title Bar 
 

Ribbon 
 

Minimize 
button 
 

Application close button 
 

Maximize/restore button 
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Word 2007 

The old look of Word menus and buttons has been replaced with this new Ribbon, with tabs you click to get to 

commands. The Ribbon was developed to make Word simpler to use, and to help you quickly find and work with 

the commands you need. 

 

What's changed, and why 

The ribbon brings together all of the options and commands that traditionally were buried in menus at the top 

of the Outlook window. Instead of searching for every command or trying to remember which menu had the 

options dialogue box that is 

needed, Word 2007 uses graphic 

and text representations in an 

organized task bar which is the 

Ribbon. 

 

What’s on the Ribbon? 

There are three basic components to the Ribbon: 

1  Tabs – Each tab is related to specific types of work that you do in Outlook. Tabs group commands and 

buttons that are related to specific types of work done in Outlook. 

2 Groups – Each tab has several groups that show related items together. Basic Text is a group that 

contains commands. 

3 Commands – A 

command is a 

button, a box 

to enter 

information, or 

a menu. The 

most 

commonly 

used 

commands 

have the largest buttons. Other examples of commands are the Bold button and Font list. 
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The principle 

commands in 

Word are 

gathered on 

the first tab, 

the Home tab.  

 

Temporarily hide the Ribbon 

Full Ribbon 

 
 

Minimized Ribbon 

 
Sometimes you just want to work on your document, and you'd like more space to do that. So it's just as easy to 

hide the Ribbon temporarily as it is to use it. Here's how: Double-click the active tab.  

 

The groups disappear, so that you have more room. Whenever 

you want to see all of the commands again, double-click the 

active tab to bring back the groups. 

 

Microsoft Office Button 

The Office Button is located in the left top corner of the Ribbon, 

which replaces the 2003 File Menu and contains most of the same 

commands.  

 

Click on the Office Button to show the menu commands Save, 

Save As, Delete, Move, Permission, Print, Properties and Close.  
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The Mini toolbar 

It is a small floating toolbar that appears right next to the text 

that is highlighted.  You can easily click on tools such as Bold, 

Italic, or Font Size without having to move your mouse up to 

the ribbon and back to the text again. 

• The Mini Toolbar shows up when text is highlighted 

and the cursor (mouse) is over the text. 

• When the text is highlighted, the Mini toolbar appears 

(faded, not shown) 

• If the mouse is pointed on the Mini toolbar, it will become solid (shown above), click to format text. 

 

The Dialog box launchers 

Click the Dialog Box Launcher  to see more options for that 

particular group. 

When you first look at a group, you may not see a certain 

command from a previous version of Word that you need.  

You can still access them.  Some of the groups have a small 

diagonal arrow in the lower-right corner . The arrow is 

called a Dialog Box Launcher. When you click it, you'll see more options related to that group. Sometimes those 

options will appear in the form of a dialog box that you may recognize from a previous version of Word, or they 

may appear in a familiar-looking task pane. Please note, the larger your monitor and the higher the resolution 

will allow more commands to be displayed in a group than in a smaller, lower resolution monitor. 

 

Additional tabs appear when needed 

In Word 2007, certain tabs appear only when you need 

them. For example, let's say you've inserted a picture. But 

now you want to do more with it. Maybe you want to change 

how text wraps around it or you want to crop it. Where are 

those commands found?  

1. Click on the image with your mouse arrow. 

2. The Picture Tools tab appears. Click that tab. 

3.  Additional groups and commands appear for working with pictures; like the Picture Styles group. 

When you click away from the picture, the Picture Tools tab disappears, and the other groups come back.  

Note:   On-demand tabs appear for other activity areas, like tables, drawings, diagrams, and charts. 
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The Quick Access Toolbar 

The Quick Access Toolbar is the small area to the 

upper left of the Ribbon. It contains the things 

that you use over and over every day: Save, 

Undo, and Repeat. If you find yourself frequently 

clicking around the ribbon to get to the same 

handful of commands, you can add them to 

Word's Quick Access Toolbar, and you will not 

have to hunt for it again. 

 

For example, if your job often entails reviewing document comments, follow these steps to add the most 

frequently used reviewing tools to the top of the screen. In the Quick Access Toolbar to the right of the Office 

button, click the Customize Quick Access list arrow. 

   

1. Click More Commands.  

 

 

2. Select All Commands from the drop-down list.  

 

 
 

 

 

 

 

 

 

 

 

 

3. In the left column, click <Separator> and then click the Add 

button. 
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4. Scroll to and click Accept And Move To Next, then click the Add button. 

5. Click <Separator> and then click the Add button. 

6. Scroll to and click Reject and Move to Next, then click the Add button. 

Click OK.  Those functions are now on the quick access toolbar. 

Once you add a tool, you can remove it from 

the toolbar by right-clicking the tool and 

selecting Remove From Quick Access 

Toolbar. 

 

 

 

Use the keyboard Shortcuts 

Shortcuts that start with the 

CTRL key (for example, CTRL+C 

for copy, or CTRL+ALT+1 for 

Heading 1), remain the same as 

in previous versions of Word. 

But the Ribbon design comes 

with new shortcuts. This change 

brings two big advantages over 

previous versions:  

• Shortcuts for every single button on the Ribbon.  

• Shortcuts that often require fewer keys.  

 

The new shortcuts also have a new name: Key Tips. Press ALT to make the Key Tip badges appear for all Ribbon 

tabs, the Quick Access Toolbar commands, and the Microsoft Office Button. Then you can press the Key Tip for 

the tab you want to display; for example, press H for the Home tab. This makes all the Key Tips for that tab's 

commands appear. Then you can press the Key Tip for the command you want.  

 

Note    You can still use the old ALT+ shortcuts that accessed menus and commands in previous versions of 

Word, but because the old menus are not available, you'll have no screen reminders of what letters to press, so 

you need to know the full shortcut to use them.  Remember that you must first highlight the text in order to use 

the shortcut. 
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Work with Multiple Documents 
 

ow to View Multiple Documents Simultaneously in Word 2007 

Word 2007 keeps 

each document 

you create or 

open in its own, separate 

window. You can display two 

or more documents on the 

screen at the same time, using 

the Arrange All feature 

 

 

 

 

 

Click the Arrange All 

button, located in the 

Window group of the 

View tab 

 

 

H 
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Immediately, Word organizes all its windows, 

by placing them on the screen like a jigsaw 

puzzle. This arrangement is fine for a few 

documents, but for too many, you end up 

with a mess.  

 

Because Word doesn't arrange minimized 

windows, one way to keep multiple windows 

open yet arrange only two is to minimize the 

windows you don't want arranged. Then click 

the Arrange All button. 

 

Here are some things to remember when using the Arrange All feature: 

• Yes,	the	Ribbon	disappears	when	the	document	window	gets	too	small.	

• Although	you	can	see	more	than	one	document	at	a	time,	you	can	work	on	only	one	at	a	time.	The	

document	with	the	highlighted	title	bar	is	the	one	“on	top.”	

• After	the	windows	are	arranged,	you	can	manipulate	their	size	and	change	their	positions	with	the	

mouse.	This	is	a	Windows	thing,	not	a	Word	thing.	

 

Clicking a window’s Maximize button restores the document to its normal, full-screen view 
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Format Text Using a Word Processing Application 

orders 

You can add borders to a document or to selected text to 

accentuate parts of the document or the entire document. Borders 

can be lines of varying thicknesses or they can be lines of objects 

such as trees or pencils.  

 

Quick Line Borders  

1. Select the paragraph(s) or line that you want to add a line border to. 

2. On the Home tab of the Ribbon, in the Paragraph group, use the All Borders 

button. 

3. Use the options to add lines to the selected text. The lines will appear to the 

selection. For example, if you have three paragraphs selected and you choose 

the option for Bottom Border, a line will only be drawn below the last paragraph 

in the selection. 

 

If you want more options available for adding 

borders, such as changing the colour or weight of 

a line you will open the Borders and Shading box. 

1. On the Home tab of the Ribbon, in the 

Paragraph group, use the All Borders button. 

2. Select the option for Borders and Shading. 

3. Use the options to select a Style for the line. 

Click on the Preview picture to select where you 

want borders drawn. Remember, what you see is 

what you get! 

4. You can adjust the colour and weight of a 

line by use the Colour and Width fields. 

5. Click on the OK button to return and apply 

the borders. 

 

 

Page Borders 

B 
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You can access the Page Border tab by using the Page Borders button on the Page Layout tab on the Ribbon, in 

the Page Background group.  

1. On the Home tab of the Ribbon, in the Paragraph group, use the All Borders button. 

2. Select the option for Borders and Shading. 

3. Click on the Page Border tab. 

4. Make your selections using the Style, Colour, Width, and Art frames as desired. 

5. Click on the OK button. 

 

hading 

Quick Paragraph Shading  

1. Select the paragraph(s) or line that you want to add shading 

to. 

2. On the Home tab of the Ribbon, in the Paragraph group, use the Shading 

button. 

3. Select the colour from the Gallery that you want to use to shade the 

selection. 

 

Shading 

1. Select the paragraphs that you want to apply shading 

to.  

2. On the Home tab of the Ribbon, in the Paragraph 

group, use the All Borders button. 

3. Select the option for Borders and Shading, click on 

the Shading tab. 

4. Use the Fill field to select a colour for the shading. 

5. Click on the OK button. 

Page Shading You can shade or change the page colour by going to the Page Layout tab on the Ribbon. Then, use 

the Page Colour button. 

 

ate and Time 

Inserting Date & Time  

1. Place the cursor in the Header 

or Footer where you want the 

Date and Time to display. 

S 

D 



SDA | MODULE 2 | STUDENT GUIDE 134 

 

2. On the Header & Footers contextual tab, click on the Date & Time button 

3. In the Available formats frame, make a selection for the date and/or time. 

4. Select the option for Update automatically if you want the date and/or time to adjust when you reopen the 

file. 

5. Click on the OK button. 

 

ymbols and Characters 

You are able to insert symbols into a document that you do not see on the 

keyboard. Some examples of symbols are: ©, ™, �, — (Em Dash). The symbols that 

can be inserted depend on the font that you choose.  

 

Inserting Symbols 

1. Put the cursor in the document where you want the symbol to appear. 

2. On the Insert tab, and in the Symbols group, 

click on the Symbols button.  

3. Make a selection from the drop down list or 

click on the option for More Symbols. 

4. In the Font box, select a Font from the drop 

down list. 

5. Locate the symbol that you want to insert 

and select it. 

6. Click on the Insert button. The Symbol box 

will remain open. 

7. Click on the Close button to close the 

Symbol box. 

You can also insert special characters, such as an Em Dash by using the Special Characters tab

S 
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sing AutoCorrect to Insert Symbols 

You can use the AutoCorrect feature to automatically insert 

symbols into the document when you type using text. See the 

table on the right for some examples.  

 

 

 

Turn on AutoCorrect 

1. Click on the Office Button.  

2. Click on the Word Options button. 

3. Go to the Proofing page. 

4. Click on the AutoCorrect button. 

5. Click, to select, the Replace text as you type checkbox. Click on 

the OK button. 

 

 

 

 

 

haracter spacing 

Spacing characters gives a different look to the characters 

when you do not want to use headers etc. this can be 

done by selecting the drop down arrow on the Font menu, 

selecting the Advanced tab and then selecting the Scale and Spacing 

sizes.  

 

The various sizes can either be selected by a set percentage, given on 

the selections, or by adding your own percentage in the “By” area. A 

preview window in the bottom of the window will give you an 

indication of what the spacing of the characters will look like, after the 

spacing has been applied. 

U 

C 
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Format Paragraphs 
 

There have been changes made to the defaults in Word other than the default font and font size. The new 

default line spacing is 1.15 (the Word 2003 default was 1) and there is now 10 point spacing after paragraphs 

(the Word 2003 default was 0 point). Below are two sample paragraphs that show the difference between the 

new 2007 defaults and 

Word 2003. 

Word 2007 

 

 

 

 

 

Word 2003 

 

 

 

You can use the new 

defaults, change the line and paragraph spacing per document, or you can create new default 

spacing for all documents. 

 

hange Line Spacing  

Line spacing determines the amount of vertical space between the lines of text in a 

paragraph. 

1. Click anywhere in the paragraph you want to adjust line spacing. If you want to 

apply new line spacing to multiple paragraphs, select them.  

2. There is more than one way to adjust line spacing. The quickest way is to use the Line Spacing 

button on the Home tab, in the Paragraph group. Click on the button to see the following choices:  

3. With the mouse, click on the line spacing you want applied. 

4. You can also open the Paragraph box by using the dialogue box launcher in the paragraph 

group on the Home or Page Layout tabs. Use the Line spacing field and corresponding At field to make 

adjustments. 

 

C 
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aragraph Spacing  

Paragraph 

spacing 

determines the 

amount of space above or below a paragraph.  

1. Click anywhere in the paragraph for which you want to adjust paragraph 

spacing. If you want to apply new paragraph spacing to multiple paragraphs, 

select them.  

2. There is more than one way to adjust paragraph spacing, and the quickest way 

is to go to the Page Layout tab. In the Paragraph group, use the Before and After 

fields under Spacing.  

3. Adjust the Before and After Spacing as desired. To make your document 

appear like the previous version of Word, change the After to 0 pt.  

4. You can also open the Paragraph box by using the dialogue box launcher in 

the Paragraph group.  

Use the Before and After fields to make adjustments.  

 

reate a New Default for Line & Paragraph Spacing 

1. Open the Paragraph box by using the dialogue box launcher in the 

Paragraph group on the Home or Page Layout tabs.  

2. Make your adjustments to Spacing in the Before, After, and Line 

spacing fields. 

3. Click on the Default button. 

4. Click on the Yes button. Your line and paragraph spacing will now be as you 

specified for this and all future documents.  

5. When you close Word 2007, you will get another message because you are 

changing the Normal.dotx. Click on the Yes button to save the changes you made to the defaults.

P 

C 
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Working with Paragraphs  

Open Microsoft Word. In the section that follows, you will learn various ways to format a paragraph. When you 

are formatting a paragraph, you do not need to highlight the entire paragraph. Placing the cursor anywhere in 

the paragraph enables you to format it. After you set a paragraph format, subsequent paragraphs will have the 

same format unless you change their format.  

 

You will need text to work with to perform the exercises for this section, so type the following exactly as shown. 

End paragraphs where you see the end-of-paragraph marker (¶). Press Enter once to end the paragraph, but do 

not leave spaces between paragraphs. You will set the space between paragraphs during the exercise. Do not 

press Enter to move to a new line -- Microsoft Word automatically wraps at the end of a line.  

 

Sample Paragraphs ¶  

We will use this paragraph to illustrate several Microsoft Word features. It will be used to illustrate Space 

Before, Space After, and Line Spacing. Space Before tells Microsoft Word how much space to leave before the 

paragraph. Space After tells Microsoft Word how much space to leave after the paragraph. Line Spacing sets the 

space between lines within a paragraph. ¶  

 

We will use this paragraph to illustrate some additional Microsoft Word features. It will be used to illustrate 

first-line indent. With first-line indent, you can indent the first line of your paragraph. We will also look at 

indentation. Indentation enables you to indent from the left or right margin of your document. ¶  

 

Space Before and Space After  

Space Before sets the amount of space before the paragraph. Space After sets the amount of space after the 

paragraph. Following are the sample paragraphs with Space After set to 12 pt. The exercises that follow give you 

a chance to see how Space Before and Space After work.  

 

Example -- Space After  

Sample Paragraphs ¶   

We will use this paragraph to illustrate several Microsoft Word features. It will be used to illustrate Space 

Before, Space After, and line spacing. Space Before tells Microsoft Word how much space to leave before the 

paragraph. Space After tells Microsoft Word how much space to leave after the paragraph. Line Spacing sets the 

space between lines within a paragraph.¶   
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We will use this paragraph to illustrate some additional Word features. It will be used to illustrate first-line 

indent. With first-line indent, you can indent the first line of your paragraph. We will also look at Indentation. 

Indentation enables you to indent from the left and/or right margins of your document. ¶   

 

Exercise 1  

Space Before  

Highlight the title of the sample text: "Sample Paragraphs."  

1. Choose	Format	>	Paragraph	from	the	menu.	

2. Choose	the	Indents	and	Spacing	tab.		

3. Enter	18	pt	in	the	Before	field.		

4. Click	OK.	You	now	have	18	points	before	"Sample	Paragraph."		

 

Space After  

1. Highlight	all	of	the	text	you	typed	(the	title	and	both	paragraphs):		

2. Choose	Format	>	Paragraph	from	the	menu.	

3. Choose	the	Indents	and	Spacing	tab.		

4. Enter	12	pt	in	the	After	field.		

5. Click	OK.	You	now	have	12	points	after	each	paragraph.		

 

Line Spacing  

Line Spacing sets the amount of space between lines within a paragraph. Single spacing is the default. The 

spacing for each line is set to accommodate the largest font on that line. If there are smaller fonts on the line, 

there will appear to be extra space between lines where the smaller fonts are located. At 1.5 lines, the Line 

Spacing is set to one-and-a-half times the single-space amount. For double-spaced lines, the line spacing is set to 

two times the single-space amount. 

 

Exercise 2  

1. Highlight	the	first	paragraph	you	typed,	starting	with	"We	will	use"	and	ending	with	"within	a	

paragraph."		

2. Choose	Format	>	Paragraph	from	the	menu.	

3. Choose	the	Indents	and	Spacing	tab.		

4. Click	to	open	the	drop-down	menu	on	the	Line	Spacing	field.		

5. Click	1.5	Lines.		 	

6. Click	OK.	Your	line	spacing	for	the	paragraph	is	now	1.5.		
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First-Line Indent  

This exercise demonstrates how you can indent the left side of the first line of your paragraph, as in the 

following example.  

 

Example -- First-line Indent  

      The first-line indent feature indents the first line of the paragraph. The amount of the indent is specified in 

the By field. The remainder of the paragraph is indented by the amount specified in the Indentation field. 

 

Exercise 3  

1. Highlight	the	second	paragraph	you	typed,	beginning	with	"We	will	use"	and	ending	with	"of	your	

document."		

2. Choose	Format	>	Paragraph	from	the	menu.	

3. Choose	the	Indents	and	Spacing	tab.		

4. Click	to	open	the	drop-down	menu	on	the	Special	field.		

5. Click	First	Line.		

6. Enter	0.25"	in	the	By	field.		

7. Click	OK.		

8. The	first	line	of	your	paragraph	is	now	indented	.25	cm.		

 

Special Note: To remove the first line indent:  

1. Place	the	cursor	anywhere	in	the	paragraph.		

2. Choose	Format	>	Paragraph	from	the	menu.	

3. Choose	the	Indents	and	Spacing	tab.		

4. Click	in	the	Special	pull-down	menu;	then	Click	None.		

5. Click	OK.		

 

Indentation  

Indentation allows you to indent your paragraph from the left or right margin. The following examples show 

different types of indentation.  

 

Example -- Indentation  

We will use this paragraph to illustrate several Word features. We will illustrate Space Before, Space After, and 

Line Spacing. Space Before tells Word how much space to leave before the paragraph. Space After tells Word 

how much space to leave after the paragraph. Line Spacing sets the space between lines within a paragraph. 
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We will use this paragraph to illustrate some additional Word features. We will illustrate first-line indent. With 

first-line indent, you can indent the first line of your paragraph. We will also look at Indentation. Indentation 

enables you to indent from the left or right margins of your document.  

 

Exercise 4  

Highlight the second paragraph, beginning with "We will use" and ending with " of your document "  

Choose Format > Paragraph from the menu. 

Type 1" in the Left field.  

Type 1" in the Right field.  

Click OK. Your paragraph is now indented one inch from both the left and right margins, as in the example.  

 

Alignment  

Microsoft Word gives you a choice of several types of alignment. Left-justified text is aligned on the left side. It is 

the default setting.   

 

Example -- Left-Justified  

Sample Paragraph  

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-

justified text is aligned on the right. Centred text is centred between the left and right margins. You can use 

Centre to centre your titles. Justified text is flush on both sides. Right-justified text is aligned on the right side.  

 

Example -- Right-Justified  

Sample Paragraph  

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-

justified text is aligned with on the right. Centred text is centred between the left and right margins. You can use 

Centre to centre your titles. Justified text is flush on both sides. Centred text is centred between the left and 

right margins.  

 

Example -- Centred  

Sample Paragraph  

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-

justified text is aligned with on the right. Centred text is centred between the left and right margins. You can use 

Centre to centre your titles. Justified text is flush on both sides. Justified text is flush on both sides.  
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Example -- Justified  

Sample Paragraph  

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-

justified text is aligned with on the right. Centred text is centred between the left and right margins. You can use 

Centre to centre your titles. Justified text is flush on both sides.  

The following exercises demonstrate how to justify text.  

 

Exercise 5  

Right-Justify  

1. Return	to	the	first	paragraph	you	typed,	beginning	with	"We	will	use"	and	ending	with	"within	a	

paragraph."	Highlight	the	paragraph.		

2. Choose	Format	>	Paragraph	from	the	menu.	

3. Choose	the	Indents	and	Spacing	tab.		

4. Click	to	open	the	Alignment	pull-down	menu.		

5. Click	Right.		

6. Click	OK.	The	paragraph	is	now	right-aligned.		

 

Left-Justify  

1. Highlight	the	first	paragraph	you	typed,	beginning	with	"We	will	use"	and	ending	with	"within	a	

paragraph."		

2. Choose	Format	>	Paragraph	from	the	menu.		

3. Choose	the	Indents	and	Spacing	tab.		

4. Click	to	open	the	Alignment	pull-down	menu.		

5. Click	Left.		

6. Click	OK.	The	paragraph	is	now	left-aligned.		

 

Alternate Method -- Right-Justify by Using Keys  

1. Highlight	the	text.		

2. Press	Ctrl-r.	The	paragraph	is	now	right-aligned.		

 

Alternate Method -- Left-Justify by Using Keys  

1. Highlight	the	text.		

2. Press	Ctrl-l.	The	paragraph	is	now	left-aligned.		
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Alternate Method -- Right-Justify by Using the Icon  

1. Highlight	the	text.		

2. Click	the	Align	Right	icon.	The	paragraph	is	now	right-aligned.		

 

Alternate Method -- Left-Justify by Using the Icon  

1. Highlight	the	text.		

2. Click	the	Align	Left	icon.	The	paragraph	is	now	left-aligned.		

 

Centre - Using the Menu  

1. Highlight	the	first	paragraph	you	typed,	beginning	with	"We	will	use"	and	ending	with	"within	a	

paragraph."		

2. Choose	Format	>	Paragraph	from	the	menu.	

3. Choose	the	Indents	and	Spacing	tab.		

4. Click	to	open	the	Alignment	pull-down	menu.		

5. Click	Centred.		

6. Click	OK.	The	paragraph	is	now	centred.	

 

Justify - Using the Menu  

1. Highlight	the	first	paragraph	you	typed,	beginning	with	"We	will	use"	and	ending	with	"within	a	

paragraph."		

2. Choose	Format	>	Paragraph	from	the	menu.	

3. Choose	the	Indents	and	Spacing	tab.	

4. Click	to	open	the	Alignment	pull-down	menu.		

5. Click	Justified.	

6. Click	OK.	The	paragraph	is	now	justified.	

 

Alternate Method -- Justify and Centre by Using Keys  

1. Highlight	the	text.		

2. Press	Ctrl-e.	The	text	is	now	centred.		

3. Press	Ctrl-j.	The	text	is	now	justified.		

 

Alternate Method -- Justify and Centre by Using the Icon  

1. Highlight	the	text.		

2. Click	the	Centre	icon.	The	text	is	now	centred.	Click	the	Justify	icon.	The	text	is	now	justified.		
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Hanging Indent  

The hanging indent feature indents each line except the first line by the amount specified in the By field, as 

shown in the example.  

 

Example: Hanging Indent  

Hanging Indent:  The hanging indent feature indents the first line of the paragraph from the margin by the 

amount specified in the Left field. The amount in the Left field plus the amount specified in the By field indent all 

subsequent lines.  

 

Exercise 6  

When you begin typing the following paragraph, you might find that your paragraph is indented one inch on 

both sides. When you start a new paragraph in Microsoft Word, the setting from the previous paragraph carries 

over. If you wish, you can reset the indentation. If you choose not to reset the indentation, it will not affect your 

ability to perform the exercise.  

1. Type	the	following:		

Hanging	Indent:	The	hanging	indent	feature	indents	the	first	line	by	the	amount	specified	in	the	Left	

field.	Subsequent	lines	are	indented	by	the	amount	specified	in	the	Left	field	plus	the	amount	

specified	in	the	By	field.		

Highlight	the	paragraph	you	just	typed.		

2. Choose	Format	>	Paragraph	from	the	menu.		

3. Choose	the	Indents	and	Spacing	tab.		

4. In	the	Special	field,	click	to	open	the	pull-down	menu.	

5. Click	Hanging.		

6. In	the	By	box,	type	2.0.		

7. Click	OK.		

8. Place	the	cursor	after	the	colon	following	"Hanging	Indent."	

9. Press	the	Tab	key.		

10. Notice	how	the	indentation	changes.		

11. Save	File	and	Exit	Microsoft	Word		

 

Bullets and Numbering 
In Microsoft Word, you can easily create bulleted or numbered lists of items. Several bulleting and numbering 

styles are available, as shown in the examples. You select the one you wish to use. Try the exercises to see how 

it works.  
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Examples: Numbering  

 

 

 

 

 

 

 

 

 

 

Examples: Bulleting  

 
 

 

 

 

Exercise 1  

1. Type	the	following	as	shown.		

Apple		

Orange		

Grape		

Mango		

Cherry		

2. Highlight	the	words	you	just	typed.		
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3. Choose	Format	>	Bullets	and	Numbering	from	the	menu.	

4. Choose	the	Numbered	tab.		

5. Several	styles	are	available	to	you.	Click	the	style	you	want	to	use.		

6. Click	OK.	Your	list	is	now	numbered.		

 

To remove the numbering:  

1. Highlight	the	list	again.		

2. Choose	Format	>	Bullets	and	Numbering	from	the	menu.	

3. Click	None.		

4. Click	OK.	Your	list	is	no	longer	numbered.	

 

Alternate Method -- Numbering by Using the Icon 

1. Highlight	the	list	you	typed.		

2. Click	the	Numbering	icon	on	the	Formatting	toolbar.	Your	list	is	now	numbered.		

 

To remove the numbering:  

1. Highlight	the	list	again.		

2. Click	again	on	the	Numbering	icon	.	Your	list	is	no	longer	numbered.	

 

Bulleting  

1. Highlight	the	list	you	typed.		

2. Choose	Format	>	Bullets	and	Numbering	from	the	menu.		

3. Choose	the	Bulleted	tab.		

4. Several	styles	are	available	to	you.	Click	the	style	you	want	to	use.		

5. Click	OK.	Your	list	is	now	bulleted.		

 

To remove bulleting:  

1. Highlight	the	list	again.		

2. Choose	Format	>	Bullets	and	Numbering	from	the	menu.		

3. Click	None.		

4. Click	OK.	Your	list	is	no	longer	bulleted.	

 

Alternate Method -- Bulleting by Using the Icon  

1. Highlight	the	list	you	typed.		

2. Click	the	Bullets	icon	on	the	Formatting	toolbar.	Your	list	is	now	bulleted.		
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To remove the bulleting:  

1. Highlight	the	list	again.		

2. Click	the	Bullets	icon			again.	Your	list	is	no	longer	bulleted.	

 

Undo & Redo  
You can quickly reverse most commands you execute by using Undo. If you then change your mind, you can use 

Redo.  

 

Exercise 2  

1. Type	Undo	example.		

2. Choose	Edit	>	Undo	Typing	from	the	menu.	The	typing	disappears.		

3. Choose	Edit	>	Redo	Typing	from	the	menu.	The	typing	reappears.		

4. Highlight	"Undo	example."	

5. Press	Ctrl-b	to	bold.		

6. Choose	Edit	>	Undo	Bold	from	the	menu.	The	bolding	is	removed.		

7. Choose	Edit	>	Redo	Bold	from	the	menu.	Your	text	is	bolded. 

 

Alternate Method -- Undo & Redo by Using Keys  

1. Type:	Undo	example.		

2. Press	Ctrl-z.	The	typing	disappears.		

3. Press	Ctrl-y.	The	typing	reappears.		

4. Highlight	";Undo	example."		

5. Press	Ctrl-u	to	underline.		

6. Press	Ctrl-z.	The	underline	is	removed.		

7. Press	Ctrl-y.	The	underline	reappears.	
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Format Pages within an Existing Word Processing Documents 

hich Page Layout should I use?    

When you are writing your document there are several layouts which you can work in. You 

can change between layouts using the (View) menu. You can alternatively use the shortcut 

icons in the bottom right corner of the window.    

 

Normal View 

“Normal View” uses far less of your computer resources than “Page View” although it doesn’t display the 

document as it will be printed. In Microsoft Word, switches to normal view, this is the default document view 

for most word-processing tasks, such as typing, editing, and formatting.    

W 
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Web Layout    

If you are working in Web Layout view and you find that a table is 

automatically snapped to the left or right, remove the text wrapping 

option. (Table > Table Properties) (Table Text, Text Wrapping). This 

switches the active document to Web layout view, which is an editing 

view that displays your document, as it will appear in a Web browser.    

 

 

 

 

Print Layout    

Switches the active document to page layout view, which is an editing 

view that displays your document as it will print. Page layout view 

uses more system memory, so scrolling may be slower, especially if 

your document contains many pictures or complex formatting.    

 

 

 

 

Outline    

"Outline view" displays the logical structure letting you drag headings and reorganise quickly. The view is very 

useful for large documents (20+ pages). Switching to outline view, in which you can examine and work with the 

structure of your file in classic outline form. Work in outline view when you need to organize and develop the 

content of your file.    

 

To adjust the starting page number (Insert > Page Numbers)(Format button) You can either set the starting 

number or continue from the previous section. You can also change the number format and / or include chapter 

numbers.    

 

If you alter the position of the margins when no text is selected then your alterations will only affect the 

paragraph that the insertion point is currently in. You can double click the little rectangle just above the top 

vertical scroll bar and this will split your screen horizontally (Window > Split), double clicking the boundary bar 

will remove the split (Window > Remove Split).    
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It is possible to have a border around a whole page (Format > Borders and Shading) (Page Border tab) If you 

switch to Page Layout view (View > Page Layout) it should be displayed. If you always work with the View 

percentage on 100% (or even 110%) you can probably see both edges of the page (in page-layout view). In this 

case you may want to remove the horizontal scroll bar to display another line of text (Tools > Options)(View tab, 

"Horizontal scrollbar").    

 

You won’t need to see the Rulers most of the time, so remove them (View)(uncheck Rulers). When you do need 

a ruler hover your cursor just below the grey area at the top and the ruler will slide out. Do you gain an extra 

line?  Always have the status bar displayed at the bottom as it shows you key information such as the total 

number of pages, section number etc.  

 

You can change the units displayed on your ruler from (Tools > Options) (General tab measurement units). To 

get detailed measurements on your ruler click on a tab or margin marker on the ruler and press both mouse 

buttons. The normal ruler is replaced with a distance ruler.  

 

To preserve the layout of your document some mark-up elements (insertions, deletions, formatting changes, 

comments) appear in the text of the document. It displays others in balloons that appear in the margin.    

 

Footnotes and Endnotes    

These are notes of reference, explanation or comment. A word in the main text can be marked with a footnote 

or endnote reference mark. Footnotes appear on the same page as the text they explain. Endnotes reside at the 

end of each chapter (Insert > Footnote, Next).  

 

Number – 2 options / AutoNumber / Custom Mark    

If you want to change the location of your footnotes / endnotes, number format, starting number, or 

numbering system (continuous, restart each section, restart each page) click on Options.  
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age breaks 

Understanding and differentiating between 

different types of breaks is important. Look at 

the table on the right and see if you 

understand the various types of breaks which can be used 

in Word 2007.  

 

To insert breaks: 

1. Place the insertion point where you want the page 

break to appear. 

2. Go to the Page Layout tab, Page Setup group, and select the button for Breaks. From the drop down menu, 

select the option for Page. 

 

Insert a manual page break  

Click where you want to start a new page; on the Insert tab, in the Pages group, click Page 

Break.  

 

Prevent page breaks in the middle of a paragraph 

Select the paragraph that you want to prevent from breaking onto two pages. On the Page Layout tab, click the 

Paragraph Dialog Box Launcher, and then click the Line and Page Breaks tab. Select the Keep lines together 

check box.  

 

Prevent page breaks between paragraphs 

Select the paragraphs that you want to keep together on a single page. On the Page Layout tab, click the 

Paragraph Dialog Box Launcher, and then click the Line and Page Breaks tab. Select the Keep with next check 

box.  

 

Specify a page break before a paragraph 

Click the paragraph that you want to follow the page break. On the Page Layout tab, click the Paragraph Dialog 

Box Launcher, and then click the Line and Page Breaks tab. Select the Page break before check box.  

 

P 
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Place at least two lines of a paragraph at the top or bottom of a page 

A professional-looking document never ends a page with just one line of a new paragraph or begins a page with 

only the last line of a paragraph from the previous page. The last line of a paragraph by itself at the top of a page 

is known as a widow. The first line of a paragraph by itself at the bottom of a page is known as an orphan. 

 

Select the paragraphs in which you want to prevent widows and orphans.  

On the Page Layout tab, click the Paragraph Dialog Box Launcher, and then click the Line and Page Breaks tab.  

Select the Widow/Orphan control check box.  This option is turned on by default. 

 

 Prevent page breaks in a table row 

Click the row in the table that you don't want to break. Select the entire table if you don't want the table to 

break across pages. A table that is larger than the page must break. On the Table Tools tab, click Layout; in the 

Table group, click Properties; Click the Row tab, and the clear the “Allow row to break 

across pages”-check box.  

 

You can use section breaks to change the layout or formatting of a page or pages in 

your document. For example, you can lay out part of a single-column page as two columns. You can separate the 

chapters in your document so that the page numbering for each chapter begins at 1. You can also create a 

different header or footer for a section of your document. In Microsoft Office Word 2007, you can choose many 

page layouts from the gallery of new page designs. For example, you can add a single-column page that has a 

two-column section by clicking that page layout option in the gallery of New Page designs. 

 

Insert a section break 

On the Page Layout tab, in the Page Setup group, click Breaks. Click the type of section break that you want to 

use.  

 

Types of section break that you can insert 

Section breaks are used to create layout or formatting changes in a portion of a document. You can change the 

following formats for individual sections: 

• Margins	

• Paper	size	or	orientation	

• Paper	source	for	a	printer	

• Page	borders	

• Vertical	alignment	of	text	on	a	page		

• Headers	and	footers		

• Columns	

• Page	numbering	

• Line	numbering	

• Footnotes	and	endnotes	
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A section break controls the section formatting of the text that precedes it. When you delete a section break, 

you also delete the section formatting for the text before the break. That text becomes part of the following 

section, and it assumes the formatting of that section. For example, if you separate the chapters of a document 

by using section breaks and then you delete the section break at the beginning of Chapter 2, Chapter 1 and 

Chapter 2 are in the same section and assume the formatting that previously was used only by Chapter 2.  

 

The section break that controls the formatting of the last part of your document is not shown as part of the 

document. To change the document formatting, click in the last paragraph of the document.  

 

Section break examples 

The following examples show the types of section breaks that you can insert. (In each illustration, the double 

dotted line represents a section break.) The Next Page command inserts a section break and starts the new 

section on the next page. This type of section break is especially useful for starting new chapters in a document.  

 

The Continuous command inserts a section break and starts the new section on the same page. A continuous 

section break is useful for creating a formatting change, such as a different number of columns, on a page. The 

Even Page or Odd Page command inserts a section break and starts the new section on the next even-numbered 

or odd-numbered page. If you want document chapters always to begin on an odd page or on an even page, use 

the Odd page or Even page section break option. 

 

Change the document layout or formatting by using section breaks 

Click where you want to make a formatting change. You might want to select a portion of the document around 

which to insert a pair of section breaks. On the Page Layout tab, in the Page Setup group, click Breaks. In the 

Section Breaks group, click the section break type that fits the type of formatting change that you want to make. 

 

For example, if you're separating a document into chapters, you might want each chapter to start on an odd 

page. Click Odd Page in the Section Breaks group. 

  

emove changes of the document layout 

A section break defines where a formatting change occurs in the document. When you delete a section 

break, you also delete the section formatting for the text before the break. That text becomes part of 

the following section, and it assumes the formatting of that section. Make sure that you're in Draft view so that 

you can see the double dotted line section break. Select the section break that you want to delete. Press 

DELETE.

R 
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Format an Exiting word Processing Document 

 

tyles 
A style is a group of formats that are applied all at one time and can be used over and over again. 

Using styles allows you to create a well-organized and flowing document. Furthermore, you can use 

Quick Styles. Quick Styles are sets of styles that are designed to work together.  

 

The style colours and formats in a single style are created to allow you to quickly generate professional and well-

designed documents. Quick Styles typically include styles for several heading levels, body text, and objects such 

as SmartArt and Shapes.  

 

Using a Quick Style Set on a New Document 

1. Create a new blank document. 

2. Go to the Home tab and in the Styles group, click on the 

Change Styles button. From the list, choose the option for Style 

Set. The default is Black and White and if you want to use this 

Style Set, go to Step 4.  

3. From the list, choose the style set that you want to use 

throughout the document. 

4. In the Styles group, on the Home tab, you will now have the 

styles from your selection available in a gallery format to use as 

needed. 

5. To use a style, click in the text that you want to adjust and from the Styles group gallery, rest the cursor over 

the style to preview the specific style in the 

document. When you locate the style that you 

want to use, click on it once to apply. 

 

 

sing a Quick Style Set on an Existing 

Document 

1. Open the document that you want to apply a quick style 

set to. 

S 

U 
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2. Go to the Home tab and in the Styles group, click on the Change Styles button if you want to change the Style 

Set from the default of Black and White. From the list, choose the option for Style Set. 

3. From the list, choose the style you want applied to the document. 

4. The document will now reflect the styles from the set. Using Quick Styles does not fix formatting errors. If you 

did not use styles originally, such as Headings, they will not be created just by selecting a style set. 

5. Continue working with the document. In 

the Styles group, on the Home tab, you will 

now have the styles from your selection 

available in a gallery format to use as 

needed. 

6. To use a style, click in the text that you want to adjust and from the Styles group gallery, rest the cursor over 

the style to preview the specific style in the document. When you locate the style you want to use, click on it 

once to apply. 

 

reate a Quick Style 

1. You can create a custom style for use when 

you are working within a specific document. 

First, select the text and format it how you 

want the style to be saved. Do not forget to use the mini 

toolbar for convenience and speed. 

2. Right-click on the selection and choose the options for 

Styles, Save Selection as a New Quick Style. 

3. In the Create New Style from Formatting box, enter a name for the style in the Name field. 

4. To keep a style for future documents, click on 

the Modify button. Select the radio button for 

New documents based on this template.  

5. Click on the OK button.  

6. The style will now be in the Styles gallery and can be used by simply clicking on the 

button in the Styles group. 

7. If the style is removed from the gallery, you can add it back for your use very 

quickly. Click on the Styles dialogue box launcher. 

8. Locate the style and when the cursor is over the style, a down arrow appears on 

the right side. Click the down arrow. 

C 
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9. Select the option for Add to Quick Style Gallery. 

10. Close the Styles box by clicking on the Close button in the top right corner. 

 

 

 

 

 

 

 

 

 

sing templates 

A template is a pre-formatted document that is included with your installation of Microsoft Word 

2007. Templates allow you to pick a look and feel that is appropriate for whatever Word task you 

need to accomplish and then simply and easily fill in your own information to make the project 

unique.  

 

hoosing a Word Template 

1. From the OFFICE BUTTON, select New... The New Document dialog box appears. 

2. Under Templates, click INSTALLED TEMPLATES 

3. From the Installed 

Templates section, 

select the desired 

template  

4. Click CREATE 

The template is 

applied to your new 

document. 

 

U 
C 
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Customizing an Existing Template 

If you like the overall style of an existing template but would like to make a few changes, you can customize the 

template to meet your needs. To do this, you can either modify the original template file or create a new file 

closely based on the old template. WARNING: If you modify the template file, the original template will be 

permanently changed. 

 

Modifying the Original Template File 

1. From the OFFICE BUTTON, select Open... The Open dialog box appears.  

2. From the Files of type pull-down list, select All Word Templates (*.dotx; *.dotm; *.dot)  

3. Using the Look in pull-down list, locate and select the template file you want to modify 

NOTE: The location will vary depending on your computer setup. Generally, templates are located in 

C:\\Program Files\Microsoft Office\Templates\1033. 

4. Click OPEN 

5. Modify the template by adding the desired text, graphics, and formatting you want  in the modified template 

6. From the OFFICE BUTTON, select Save 

 

Creating a New Template File Based on an Existing Template 

1. Open a Word template 

2. Modify the template by adding the desired text, graphics, and formatting to be included in the new template  

3. From the OFFICE BUTTON, select Save As... The Save As dialog box appears.  

4. From the Save a copy of the document pull-down list, select Word Template 

5. In the File name text box, type the desired filename.  

6. Using the Save in pull-down list, select the desired save location.  

7. Click SAVE 

 

Creating a Template 

If you have formatting that you use frequently in your work but is not offered in Word's collection of pre-set 

templates, you can easily create a new template using your own formatting and settings. 

1. Create or open the file containing the formatting and settings to be included in the custom template 

2. From the OFFICE BUTTON, select Save As... The Save As dialog box appears.  

3. From the Save a copy of the document pull-down list, select Word Template 

4. In the File name text box, type the desired filename 
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5. Using the Save in pull-down list, select the desired save location.  

6. Click SAVE  

 

eaders and Footers 

Headers and Footers are areas at the top and bottom of each page in a document. Headers and 

Footers now utilize the side margins of the page as well. Headers and Footers are used to insert 

information such as page numbers, titles, dates, file names, and graphics or logos. 

Inserting Headers and Footers 

1. To insert a basic Header and/or Footer you can simply 

double click in the top or bottom margin area to open 

the Header and Footer area. By using this method, you 

can directly add your text to either area. 

2. Another method is to click on the Header or Footer 

button on the Insert tab. 

3. If you click on the Header button the following gallery 

will display: 

• If you want a blank Header, click on the first 

option in the gallery. This will allow you to enter 

text in your own design. You can also use the 

vertical scroll bar to find a Header that will work 

for your document. When you find one that you 

like, click once to insert it into the document. 

• Click on the text placeholders to add you text, 

if necessary. 

4. If you click on the Footer button, the following gallery 

will display:  

• If you want a blank Footer, click on the first option in 

the gallery. You can also use the vertical scroll bar to 

find a Footer that will work for your document. When 

you find one that you like, click once to insert it into the 

document. 

• Note that if you selected a particular design for the 

Header, you may want to use the same design for the Footer. 

H 
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5. Once you choose the layout for your 

Header or Footer, this area will open and 

look similar to the following: 

 

 

 

 

 

 

6. The Header or Footer will open and have fields for you to click on in order to enter text. The Header & Footer 

contextual tab also opens. The Header & Footer contextual tab will only display when the Header or Footer area 

is opened.  

7. To exit the Header and Footer areas, double-click in the body of the document. 

8. To 

remove 

a 

Header 

or 

Footer, 

click on the respective button on the Insert tab and select the option for Remove Header or Remove Footer. 

9. To edit a Header or Footer, click on the respective button on the Insert tab and select the option for Edit 

Header or Edit Footer. Then you can either change what is in the existing Header or Footer or you can select a 

new design from the Galleries. 

 

Create different Header or Footers for different Sections  

Note: You must have sections breaks inserted into the document to accomplish this task. 

1. Put the cursor in the section for which you want a different Header or Footer. 

2. On the Insert tab, click on the Header or Footer button in the Header & Footer group. From the menu, choose 

the Edit Header or Edit Footer option. 

3. On the Headers & Footers contextual tab, click on the Link to Previous button in the Navigation group. 

4. You have now broken the link between the sections and you can now change the Header or Footer for this 

section. 
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dditional Changes for Headers & Footers 

There are many other changes that can be made to Headers and Footers. These commands can be 

found on the Header & Footer Tools contextual tab. If you review the buttons on the Header & 

Footer Tools tab you will see there are buttons for adding Date & Time, Quick Parts, Pictures, Clip 

Art, adjusting the margin space above and below the Header and Footer, and options for Different First Pages 

and Different Odd & Even Pages. 

 

age numbers 

1. You can insert page numbers by using the Page Number button in 

the Header & Footer group on the Header & Footer Tools contextual 

tab.  

2. As you can see from the menu, you have several choices available for inserting 

page numbers, such as the Top of Page, Bottom of Page, Page Margins (left and 

right margins), or Current Position. 

 • The page number will automatically be inserted into the Header, 

Footer, or Side Margins. 

 • Using the Current Position option will allow you to put your cursor in the exact location (in the 

header/footer areas or anywhere) for where you want the page number to display. 

 

Formatting Page Numbers 

1. Open the Header/Footer area. 

2. To format the page number (change page number format, continue 

from previous section, or to start the page number at a certain 

number) click on the Page Number button in the Header & Footer 

group on the Header & Footer Tools contextual tab. 

3. From the list, choose the option for Format Page Number. Make the 

changes to the page number format as desired. 

4. Click on the OK button. 

A 

P 
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ootnotes and Endnotes 

Per Microsoft Help Footnotes and Endnotes are used in printed documents to explain, comment on 

or to provide references for text in a document. 

 

Footnotes are defined as follows: 

A footnote is used in printed documents to explain, comment on, or provide reference for text in a document. 

Footnotes corresponding notes are found at the bottom of a page with the referenced text. 

 

Endnotes are defined as follows: 

An endnote is used in printed documents to explain, comment on, or provide references for text in a document. 

Endnotes corresponding notes are found at the end of the document. 

 

Note Reference Mark is defined as follows: 

A note reference mark is the notation in the documentation that is used to refer a reader to the footnote or 

endnote. 

 

reate a Footnote 
1. In Print Layout view, click where you want the note reference mark to be. 

2. Click on the Insert Footnote button on the References tab.  

3. Word automatically inserts the note reference 

mark and puts the cursor at the bottom of the 

page.  

4. Enter the footnote text. 

5. To edit footnotes, simply go to the note and 

edit the text. 

6. You can see what the footnote is by resting the cursor over the reference mark. 

 

F 

C 



 
 

SDA | MODULE 2 | STUDENT GUIDE 162 

 

7. To adjust the formatting of the footnote, such as changing 

from numbers (1, 2, 3, 4) to letters (A, B, C) click on the 

Footnotes dialogue box launcher. 

8. The Footnote and Endnote box: 

9. Use the Format section to make adjustments.  

10. If you are making the changes after you have created all 

the footnotes, use the Apply changes to field to apply the 

changes to the whole document. 

11. Click on the Apply button. 

 

 

 

 

 

reate an Endnote 
1. In Print Layout view, click where you want the 

note reference mark to be. 

2. Click on the Insert Endnote button on the 

References tab. 

3. Word automatically inserts the note reference mark and 

puts the cursor at the end of the document. Type the 

endnote.  

4. To adjust the formatting of the endnote, such as 

changing from numbers (i, ii, iii, etc.) to letters (A, B, C, 

etc.) click on the Footnotes dialogue box launcher. 

5. The Footnote and Endnote box:  

6. Use the Format section to make adjustments. 

7. If you are making the changes after you have created all 

the endnotes, use the Apply changes to field to apply the 

changes to the whole document. 

8. Click on the Apply button. 

C 
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ection Breaks 

1. Place the insertion point where you want the section break 

to appear. 

2. Go to the Page Layout tab, Page Setup group, and select 

the button for Breaks 

. From the drop down menu, select the option under Section Breaks 

that is appropriate for the current task. 

3. If you have the Show/Hide tool on you will see section breaks 

indicated similar to the following: 

 

.  

S 
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You are now ready to go through a check list. Be honest with yourself. 

Tick the box with either a √ or an X to indicate your response. 

	
□ I	am	able	to	work	with	multiple	documents.		
□ I	am	able	to	format	text.		
□ I	am	able	to	format	paragraphs.		
□ I	am	able	to	format	pages.		
□ I	am	able	to	format	a	document.		
□ I	am	able	to	use	and	create	templates		

	

 

 

 
 
 
 
 
 

	
	
	
	
	
	

You	must	think	about	any	point	you	could	not	tick.	Write	this	down	as	a	goal.	
Decide	on	a	plan	of	action	to	achieve	these	goals.	Regularly	review	these	goals.	

 

 

 

 

 

 

 

My	Goals	and	Planning:	
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________

________________________________________________________________________________________
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People	credited	with	this	unit	standard	are	able	to:	

• Show	knowledge	of	the	characteristics	of	the	World	Wide	Web	and	identify	the	features	of	a	web	

browser	

• Demonstrate	the	ability	to	log	on	to	the	internet	and	use	a	browser	to	access	the	world	wide	web	

• Accomplish	web	search	functions	using	a	web	browser	and	available	search	engine	tools	

• Save	search	results	by	using	bookmark	tools	

• Print	web	pages	and	search	reports	

Unit Standard 7573  
 

SPECIFIC	OUTCOMES	AND	RELATED	ASSESSMENT	CRITERIA	
SO	1	 UNDERSTAND	THE	CONCEPTS	AND	TERMS	OF	THE	INTERNET	

AC	1	

The	concepts	are	explained	in	terms	of	their	meaning	and	relation	to	the	use	of	the	Internet	as	a	
whole.	(At	least	three	of	the	following:	WWW	(World	Wide	Web),	Uniform	Resource	Locator	
(URL),	Hypertext	Transfer	Protocol	(HTTP),	Internet	Service	Providers	(ISP),	File	Transfer	
Protocol	(FTP),	Hyperlink,	Hypertext	Markup	Language	(HTML),	limitations,	control,	navigation,	
frames.)	

AC	2	 The	structure	of	a	web	address	(URL-Universal	Resource	Locator)	is	explained	using	an	example.		
AC	3	 Web	Browsers	are	explained	in	terms	of	their	purpose	and	use.		

AC	4	 Examples	of	Web	Browsers	are	given.	(Minimum	of	two	Web	Browsers,	including,	but	not	limited	
to:	Internet	Explorer,	Netscape	Navigator,	Firefox.)	

AC	5	 Search	Engines	are	explained	in	terms	of	their	purpose	and	use.	
AC	6	 Cookies	are	explained	in	terms	of	their	purpose	and	use.		
AC	7	 Internet	Cache	is	explained	in	terms	of	its	purpose	and	use	

AC	8	

The	benefits	of	using	the	Internet	are	explained.	At	least	three	of	the	following	which	may	include	
but	not	limited	to:	(Information	access,	24-hour	access,	own	website	for	others	to	access,	efficient	
provision	of	customer	service	information,	use	of	multi-media,	computer	supported	collaborative	
work.)	

AC	9 

The	limitations	of	using	the	Internet	are	explained.	(At	least	three	of	the	following	which	may	
include	but	not	limited	to:	�Identifying	authoritative	sources,	currency	of	information,	accuracy	of	
information,	security,	staff	time	involved	in	using	the	Internet,	download	speed,	spreading	
viruses.)	

SO	2	 EXPLAIN	LEGAL	AND	ETHICAL	ISSUES	IN	RELATION	TO	INTERNET	USE.		

AC	1	

The	explanation	includes	the	implications	of	various	acts,	in	terms	of	using	information	from	the	
Internet.		(The	implications	of	current	legislation	on	the	use	of	information	from	the	internet	need	
to	be	included	in	explanations	with	reference	to	national	and	international	practice.	At	least	two	
laws	need	to	be	included.)	

AC	2	 The	explanation	includes	implications	of	providing	Internet	access	to	individuals	in	terms	of	
security	of	information,	and	virus	protection.		

AC	3	 The	explanation	includes	security	considerations	of	using	the	Internet.	(At	least	two	of:		
�	Protected	Website,	Digital	Certificate,	Encryption,	Viruses,	Credit	Card	fraud,	Firewall.)	

SO	3	 USE	A	GRAPHICAL	USER	INTERFACE	(GUI)-BASED	BROWSER	TO	DISPLAY	A	
GIVEN	WEB	PAGE.		

AC	1	 A	connection	is	made	with	the	World	Wide	Web.	(At	least	one	of	the	following	connection	types	
are	used:	Via	an	Internet	Service	Provider,	LAN	or	WAN.)	

AC	2	 A	browser	application	is	opened	and	closed.		
AC	3	 The	given	Web	Page	is	displayed.		
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AC	4	 A	Web	Page	is	saved	as	a	file.		
AC	5	 A	Web	Page	is	stopped	from	loading.		
AC	6	 A	Web	Page	is	refreshed.		
AC	7	 The	browser	Home	Page	is	changed.		

SO	4	 ADJUST	SETTINGS	TO	CUSTOMIZE	THE	VIEW	AND	PREFERENCES	OF	THE	
BROWSER	APPLICATION.		

AC	1	 Toolbars	are	displayed	and	hidden.		
AC	2	 Images	on	a	Web	page	are	displayed	and	hidden.		
AC	3	 Previously	visited	URLs	are	listed.	
AC	4	 The	list	of	previously	visited	URLs	is	deleted.	

 

SO	5	 NAVIGATE	ON	THE	INTERNET.	
AC	1	 Links	are	activated	and	control	is	passed	back	to	the	original	page.	(Hyperlink,	Image	Link.)	
AC	2	 Control	is	past	backwards	and	forwards	through	pages	of	a	website.	
AC	3 Text	is	extracted	from	a	web	page	and	copied	into	a	file.	
AC	4 An	image	on	a	web	page	is	saved	to	a	file.	
AC	5 Web	pages	are	bookmarked.	
AC	6 Bookmarks	are	deleted.	
SO	6 USE	A	SEARCH	ENGINE	TO	LOCATE	GIVEN	INFORMATION	SPECIFICATIONS.	
AC	1 Use	a	Search	Engine	to	locate	given	information	specifications.	(Minimum	of	two	Search	Engines.)	
AC	2 A	search	locates	information	that	matches	the	given	information	specifications.	

AC	3 

A	complex	search	locates	information	that	matches	the	given	information	specifications.(A	simple	
and	complex	search	needs	to	be	completed.	Complex	means	the	use	of	common	logical	operators	
such	as	AND,	OR,	AND	NOT,	as	well	as	the	use	of	a	wild	card	like	"*".	At	least	one	operator	should	
be	included	in	a	complex	search.)	

SO	7 OBTAIN	INFORMATION	FROM	A	WEB	SITE.	
AC	1 Web	site	information	is	saved	to	a	local	storage	device.	(Text	format,	HTML	format.)	

AC	2 A	web	site	object	is	downloaded	to	a	local	storage	device.	(At	least	one	of	the	following:	Graphics,	
sound,	software.)	

 

										CRITICAL	CROSS	FIELD	OUTCOMES	
UNIT STANDARD CCFO IDENTIFYING   
Identify and solve problems in which responses display that decisions using critical and creative thinking have 
been made by locating information on the internet.   
 
UNIT STANDARD CCFO ORGANISING   
Organise and manage oneself and one`s activities responsibly and effectively by organizing information in a 
web browser.   
 
UNIT STANDARD CCFO COLLECTING   
Collect, analyse, organise, and critically evaluate information by locating and analyzing information using a web 
browser.   
 
UNIT STANDARD CCFO SCIENCE   
Use science and technology effectively and critically, showing responsibility towards the environment and 
health of others, by locating information uses a web browser.   

 



 
 

SDA | MODULE 2 | STUDENT GUIDE 168 

 

 

 

All qualifications and part qualifications registered on the National Qualifications Framework are public 
property. Thus the only payment that can be made for them is for service and reproduction. It is illegal 
to sell this material for profit. If the material is reproduced or quoted, the South African Qualifications 
Authority (SAQA) should be acknowledged as the source.  

SOUTH AFRICAN QUALIFICATIONS AUTHORITY  

REGISTERED UNIT STANDARD THAT HAS PASSED THE END DATE:  

 

Demonstrate ability to use the World Wide Web  

SAQA US 
ID 

UNIT STANDARD TITLE 

7573  Demonstrate ability to use the World Wide Web  

ORIGINATOR ORIGINATING PROVIDER 

SGB Information Systems and 
Technology  

  

QUALITY ASSURING BODY 

-   

FIELD SUBFIELD 

Field 10 - Physical, Mathematical, Computer and Life Sciences Information Technology and Computer 
Sciences  

ABET 
BAND 

UNIT STANDARD 
TYPE 

OLD NQF LEVEL NEW NQF LEVEL CREDITS 

Undefined  Regular-
Fundamental  

Level 2  NQF Level 02  3  

REGISTRATION STATUS REGISTRATION START 
DATE 

REGISTRATION END 
DATE 

SAQA DECISION 
NUMBER 

Passed the End Date -  
Status was "Reregistered"  

2003-12-03  2004-12-02  SAQA 1351/03  

LAST DATE FOR ENROLMENT LAST DATE FOR ACHIEVEMENT 

2005-12-02    2008-12-02    

 

In all of the tables in this document, both the old and the new NQF Levels are shown. In the text (purpose statements, 

qualification rules, etc), any reference to NQF Levels are to the old levels unless specifically stated otherwise.  
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This unit standard is replaced by:  

US ID Unit Standard Title 
Old NQF 
Level 

New NQF 
Level 

Credits 
Replacement 
Status 

116931  
Use a Graphical User Interface (GUI)-based web-
browser to search the Internet  

Level 2  
NQF Level 
02  

4  Complete  

 

PURPOSE OF THE UNIT STANDARD  

People credited with this unit standard are able to :  
 
•  show knowledge of the characteristics of the World Wide Web and identify the features of a web browser  
 
•  demonstrate the ability to log on to the internet and use a browser to access the world wide web  
 
•  accomplish web search functions using a web browser and available search engine tools  
 
? save search results by using bookmark tools  
 
•  print web pages and search reports  

 

LEARNING ASSUMED TO BE IN PLACE AND RECOGNITION OF PRIOR LEARNING  

Open.  
 
The credit value of this unit is based on a person having the prior knowledge and skills to operate a personal 
computer and a modem.  

 

UNIT STANDARD OUTCOME HEADER  

Demonstrate basic knowledge about the World Wide W  

 

Specific Outcomes and Assessment Criteria:  

 

SPECIFIC OUTCOME 1  

Demonstrate basic knowledge about the World Wide Web and the features of a web browsing programme.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  
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1. The nature and characteristics of the Wide World Web are explained.  

ASSESSMENT CRITERION RANGE  

Limitations, filtering, control, navigation, frames. 
  

 

ASSESSMENT CRITERION 2  

2. The term "Hyper Text Markup Language (HTML)" is defined and explained.  

 

ASSESSMENT CRITERION 3  

3. The make up and structure of a web address (Universal Resource Locator - URL) are understood.  

 

ASSESSMENT CRITERION 4  

4. The uses of a Web Browser are described.  

 

ASSESSMENT CRITERION 5  

5. The distinctive features of a Web Browser are identified.  

 

SPECIFIC OUTCOME 2  

Demonstrate ability to log on to internet, start browser and access web page.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. A connection is established with an Internet Service Provider.  

 

ASSESSMENT CRITERION 2  

2. The web browsing application is opened.  

 

ASSESSMENT CRITERION 3  

3. A given web page is displayed.  

 

ASSESSMENT CRITERION 4  

4. The web browser home page/start page is changed.  

 

ASSESSMENT CRITERION 5  
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5. Application Help Functions are used.  

 

ASSESSMENT CRITERION 6  

6. The web browser application is closed.  

 

SPECIFIC OUTCOME 3  

Adjust Basic Settings.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Viewing modes are changed.  

 

ASSESSMENT CRITERION 2  

2. Toolbar display is modified.  

 

ASSESSMENT CRITERION 3  

3. Image files are displayed in web page.  

 

ASSESSMENT CRITERION 4  

4. Image files are not displayed in web page.  

 

SPECIFIC OUTCOME 4  

Access a web address.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. A URL (Uniform Resource Locator) is opened and data is collected.  

 

ASSESSMENT CRITERION 2  

2. A hyperlink or image link is opened.  

 

ASSESSMENT CRITERION 3  

3. The original page is returned to.  
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ASSESSMENT CRITERION 4  

4. A specified site is browsed and data is collected.  

 

SPECIFIC OUTCOME 5  

Use a search engine.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. Search requirements are defined.  

 

ASSESSMENT CRITERION 2  

2. A key word is used in a search.  

 

ASSESSMENT CRITERION 3  

3. Common logical operators are used in a search.  

 

SPECIFIC OUTCOME 6  

Print a web page or search report.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. A page is previewed.  

 

ASSESSMENT CRITERION 2  

2. Page setup options are modified.  

 

ASSESSMENT CRITERION 3  

3. A web page is printed using basic print options.  

 

ASSESSMENT CRITERION 4  

4. A search report is printed as a document.  
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SPECIFIC OUTCOME 7  

Use and create a bookmark.  

 
ASSESSMENT CRITERIA  

 

ASSESSMENT CRITERION 1  

1. A bookmarked page is opened.  

 

ASSESSMENT CRITERION 2  

2. A web page is bookmarked.  

 

ASSESSMENT CRITERION 3  

3. Web pages are added to a bookmark folder.  

 
 

Critical Cross-field Outcomes (CCFO):  

 

UNIT STANDARD CCFO IDENTIFYING  

Identify and solve problems.  

 

UNIT STANDARD CCFO WORKING  

Work effectively with others as a member of a team, group, organisation and community.  

 

UNIT STANDARD CCFO ORGANISING  

Organise and manage oneself and one`s activities responsibly and effectively.  

 

UNIT STANDARD CCFO COLLECTING  

Collect, organise and critically evaluate information.  

 

UNIT STANDARD CCFO COMMUNICATING  

Communicate effectively using visual, mathematical, and language skills in modes of oral and written 
presentations.  

 

UNIT STANDARD CCFO SCIENCE  
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Use science and technology effectively and critically (showing responsibility towards the environment and health 
of others).  

 

UNIT STANDARD CCFO DEMONSTRATING  

Demonstrate an understanding of the world as a set of related systems.  

 

UNIT STANDARD CCFO CONTRIBUTING  

Contribute to the full personal development of each learner and the social and economic development of society 
at large, by making it the underlying intention of any programme of learning to make an individual aware of the 
importance of:  
•  reflecting on exploring a variety of strategies to learn more effectively  
•  participating as responsible citizens in the life of local, national and global communities  
•  being culturally and aesthetically sensitive across a range of social contexts  
•  exploring education and career opportunities and  
•  developing entrepreneurial opportunities.  
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UNDERSTAND THE CONCEPTS AND TERMS OF THE INTERNET 
 
The Internet and its various concepts 
The Internet is named after the Internet Protocol, the standard communications protocol used by every 

computer on the Internet. The Internet can powerfully leverage your ability to find, manage, and share 

information. Never before in human history has such a valuable resource been available to so many people at 

such little cost. You are incredibly lucky. The Internet was designed in part to provide a communications 

network that would work even if some of the sites were destroyed by nuclear attack. If the most direct route 

was not available, routers would direct traffic around the network via alternate routes. 

 

The early Internet was used by computer experts, engineers, scientists, and librarians. There was nothing 

friendly about it. There were no home or office personal computers in those days, and anyone who used it, 

whether a computer professional or an engineer or scientist or librarian, had to learn to use a very complex 

system. 

 

The World Wide Web, abbreviated as WWW and W3 and commonly known as The Web, is a system of 

interlinked hypertext documents contained on the Internet. With a web browser, one can view web pages that 

may contain text, images, videos, and other multimedia and navigate between them using hyperlinks. 

 

An HTTP session is a sequence of network request-response transactions. An HTTP client initiates a request. It 

establishes a Transmission Control Protocol (TCP) connection to a particular port on a host. An HTTP server 

listening on that port waits for a client's request message. Upon receiving the request, the server sends back a 

status line, such as "HTTP/1.1 200 OK", and a message of its own, the body of which is perhaps the requested 

resource, an error message, or some other information. 

 

An Internet Service Provider (ISP), also sometimes referred to as an Internet access provider (IAP), is a 

company that offers its customer’s access to the Internet. The ISP connects to its customers using a data 

transmission technology appropriate for delivering Internet Protocol datagram, such as dial-up, DSL, cable 

modem, wireless or dedicated high-speed interconnects. 

 

ISP’s may provide Internet e-mail accounts to users which allow them to communicate with one another by 

sending and receiving electronic messages through their ISP's servers. (As part of their e-mail service, ISPs 
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usually offer the user an e-mail client software package, developed either internally or through an outside 

contract arrangement. ISP’s may provide other services such as remotely storing data files on behalf of their 

customers, as well as other services unique to each particular ISP. 

 

File Transfer Protocol (FTP) is a standard network protocol used to exchange and manipulate files over a 

TCP/IP based network, such as the Internet. FTP is built on a client-server architecture and utilizes separate 

control and data connections between the client and server applications. Applications were originally interactive 

command-line tools with a standardised command syntax, but graphical user interfaces have been developed 

for all desktop operating systems in use today. FTP is also often used as an application component to 

automatically transfer files for program internal functions. FTP can be used with user-based password 

authentication or with anonymous user access 

 

How big is the internet? 

Assessing the size of the Internet is a somewhat difficult proposition, since it is a distributed body, and no 

complete index of it exists. What we mean by asking how large the Internet is also plays into how we answer the 

question. Do we mean how many people use the Internet? How many websites are on the Internet? How many 

bytes of data are contained on the Internet? How many distinct servers operate on the Internet? How much 

traffic runs through the Internet per second? All of these different metrics could conceivably be used to address 

the sheer size of the Internet, but all are very different. 

 

Perhaps the simplest metric is simply how many people use the Internet. This can be viewed as the population 

of the Internet, and so would seem to be a decent gauge of its size. The general answer seems to be that just 

over a billion people used the Internet in 2008. Of these, about 500 million use the Internet at least once a 

week, making them more-or-less permanent citizens of the Internet population. 

 

It may be that what most people mean when they ask the size of the Internet is how many bytes it takes up. 

Estimating that is a fairly difficult task, but one person made an estimate not so long ago who can probably be 

trusted to have a good idea. Eric Schmidt, the CEO of Google, the world’s largest index of the Internet, 

estimated the size at roughly 5 million terabytes of data. That’s over 5 billion gigabytes of data, or 5 trillion 

megabytes. Schmidt further noted that in its seven years of operations, Google has indexed roughly 200 

terabytes of that, or .004% of the total size. There are thought to be some 155 million websites on the Internet, 

but this number fluctuates wildly from month to month, and one runs into a problem of what exactly 
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constitutes a website. Is a person’s individual Facebook page its own website? How about their LiveJournal or 

blog? What if the blog is hosted by a blog service?  

 

Other metrics for the Internet's size run into problems with finding any reasonable numbers on them. People 

estimate there are roughly 75 million servers worldwide, but this number may be off by up to a factor of five. 

The traffic that runs through the Internet in a single day might seem like it would be easily measured, but in fact 

it is very hard to find a reliable collection of this data, because of the sheer amount of computers, servers, and 

nations involved. 

 

The	Structure	of	a	Web	Address		
Here’s a typical web address: http://www.google.co.za  

There are four parts to a web address:  

1. A web address always begins with “http://” which stands for hypertext transfer protocol and refers to the 

manner (also known as the “scheme”) in which web pages are sent over the Internet. In current versions of 

Internet Explorer, the http:// is automatically inserted for you, so you don’t need to struggle with typing it in.  

2. A web address typically includes “www” which is short for World Wide Web. However, some web addresses 

(including those that allow you to access your e-mail over the web) do not have the www as part of their 

address. If you’re not sure whether the web site you’d like to visit has a www as part of its address, try it both 

ways. One of the two is bound to work.  

3. A web address includes a site name. In the example above, the site name is “Google”  

4. A web address includes a domain name. In the example above the category is “.co.za”. There is occasionally a 

slash (“/”) and some text following the domain name. This typically represents a specific web page within the 

web site.  

	

Some of the largest, most common domains are .com (commercial site), .edu (educational institution), .gov 

(government site), .mil (military site), .net (network site), and .org (non-profit or private organization). So, when 

you next see a web address that ends in .edu, you’ll know that web site belongs to an educational institution.  

There are never any empty spaces in a web address but underscored spaces, i.e. “_” are OK. Also, don’t worry 

too much about using capital letters. Very rarely is any distinction made between upper and lower case letters. 

Also, be careful not to confuse a web address with an e-mail address. An e-mail address always has an “@” 

symbol in it and is very unlikely to ever have a "www.” sequence. 
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What is a Web Browser? 

A Web browser is a software program that interprets the coding language of the World Wide Web in graphic 

form, displaying the translation rather than the coding. This allows anyone to “browse the Web” by simple point 

and click navigation, bypassing the need to know commands used in software languages. The World Wide Web 

is written in Hypertext Markup Language (HTML). Viewed with software other than a Web browser, HTML looks 

nothing like its graphic translation.  

 

Try this! 

To take a peek at what a webpage looks like without the graphics, as it was designed, right-click on any empty 

space in a webpage. A small pop-up menu will appear. Choose View Source in Microsoft’s Internet Explorer (IE). 

When finished viewing the HTML coding, click the window closed to return to the Web browser window. 

 

Let’s take a look at some web browsers 

Firefox 

FireFox is a web browser created by Mozilla, the original creators 

of the Netscape series of browsers. Version one was released in 

November 2004. It quickly gained new fans because of its open 

source license and multitude of features. Multiple new versions 

have been released since 2004, with each update adding more 

features and improved security. 

 

Open source means that the source code for the program is 

available to anyone who cares to download it. Any programmer 

can use the initial code to develop FireFox, whether they are creating customized options for themselves or 

working to improve the browser for all users. Being open source makes FireFox infinitely adaptable. Some of 

FireFox's specialized features include pop-up blockers and advanced privacy settings. FireFox also offers tabbed 

browsing. You can open more than one website in your browser window, and tabs on the screen allow you to 

easily switch between them.  

 

The browser also has several advanced search options. There is a Google search built into the toolbar, but that's 

not necessarily unique. What makes FireFox stand out is the ability to create Smart Keywords that will work with 

your favourite sites the same way a Google toolbar search does. You can go straight to the information you want 
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without having to visit unnecessary websites and menus. In addition, a specialized Find bar allows you to search 

for text within a site without having to bring up any additional editing prompts.  

 

FireFox can be a highly personalized browser, and not just for programmers who can download the source code 

and tweak the browser to fit their needs. The average user can modify his or her toolbar look and settings, and 

download extensions and themes. Themes simply change the look of the browser while extensions provide 

additional capabilities like mouse gestures or games. Hoping to win computer users over from other browsers, 

FireFox features quick downloading and easy importability of settings like bookmarks and passwords from other 

products. 

Internet Explorer 

Windows Internet Explorer (formerly Microsoft Internet Explorer; abbreviated 

to MSIE or, more commonly, IE), is a series of graphical web browsers 

developed by Microsoft and included as part of the Microsoft Windows line of 

operating systems starting in 1995.  

 

It has been the most widely used web browser since 1999, attaining a peak of about 95% usage share during 

2002 and 2003 with IE5 and IE6. 

 

Internet Explorer was first released as part of the add-on package Plus! for Windows 95 in 1995. Later versions 

were available as free downloads, or in service packs, and included in the OEM service releases of Windows 95 

and later versions of Windows.  

 

Other versions available since the late 1990’s include an embedded OEM version called Internet Explorer for 

Windows CE (IE CE) available for WinCE based platforms and is currently based on IE6. Internet Explorer for 

Pocket PC, later rebranded Internet Explorer Mobile for Windows Mobile was also developed, and remains in 

development alongside the more advanced desktop versions. 

 

Internet Explorer makes use of the accessibility framework provided in Windows. Internet Explorer is also a user 

interface for FTP, with operations similar to that of Windows Explorer (although this feature requires a shell 

window to be opened in recent versions of the browser, rather than natively within the browser). 
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Search Engines  
Exactly what is a search engine? Basically, a search engine is a software program 

that searches for sites based on the words that you designate as search terms. 

Search engines look through their own databases of information in order to find 

what it is that you are looking for.  

 

Are Search Engines and Directories The Same Thing?  

Search engines and directories are not the same thing; although the term "search engine" often is used 

interchangeably. Search engines automatically create web site listings by using spiders that "crawl" web pages, 

index their information, and optimally follows that site's links to other pages. Spiders return to already-crawled 

sites on a pretty regular basis in order to check for updates or changes, and everything that these spiders find 

goes into the search engine database. 

 

How Do Search Engines Work? 

Please note: search engines are not simple. They include incredibly detailed processes and methodologies, and 

are updated all the time. This is a bare bones look at how search engines work to retrieve your search results. All 

search engines go by this basic process when conducting search processes, but because there are differences in 

search engines, there are bound to be different results depending on which engine you use.  

1. The	searcher	types	a	query	into	a	search	engine.		

2. Search	engine	software	quickly	sorts	through	literally	millions	of	pages	in	its	database	to	find	

matches	to	this	query.		

3. The	search	engine's	results	are	ranked	in	order	of	relevancy.	

 

Cookies 

Cookies are small files that Web sites put on your computer hard disk drive when you first visit. Think of a cookie 

as an identification card that's uniquely yours. Its job is to notify the site when you've returned. Cookies should 

not be confused with viruses. While it is possible to misuse a cookie in cases where there is personal data in it, 

cookies by themselves are not malicious. Many Web sites, including Microsoft's, use cookies. Cookies tell the 

website administrators how often you visit pages, which helps them find out what information interests you. In 

this way, they can give you more of the content you like and less of the content you don't.  
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Cookies can help you be more efficient. Have you ever put something in a virtual shopping cart in an online 

store and then returned a few days later to find that the item is still there? That's an example of cookies at 

work. Cookies let you store preferences and user names, register products and services, and personalise pages. 

But if you never register or leave personal information at a site, then the server only knows that someone with 

your cookie has returned to the Web site. It doesn't know anything else. 

 

Internet Cache 

Internet browser cache also known as "Temporary Internet Files" in Internet Explorer. Internet cache is used to 

help improve how fast data is opened while browsing the Internet. In most cases, each time a web page is 

opened, it is sent to your browser's temporary cache on your hard disk drive.  

If that page is accessed again and has not been modified, the browser will open the page from your cache 

instead of downloading the page again. This saves users a lot of time, especially if that user is using a modem, 

and can also help save the web page owner on bandwidth. 

 

Benefits of the Internet 

Information access – the internet houses a world of information, were users can relates their experiences 

and findings on a single engine for billions of other users to read, use and discuss. The information is available to 

anyone with either access thereto or the knowledge of how to find it.  

 

24-hour access – unlike libraries, subject matter experts or any other information sources, the internet is a 

24 hour, 7 days a week, 365 days a year information resource which never shuts down. So you are able to access 

and use it whenever you require.  

 

Own website for others to access – as other users do, you are able to construct a website and share 

your information with other people, for them to use. You are able to sell and market or even just share 

experiences or information with them on any conceivable topic.  

 

Efficient provision of customer service information – when you have your own website running, 

you are able to allow other users to register on the website and share their information with you, on a business 

or personal scale. As a business, you are able to assist your clients more efficiently if you have their relevant 

details and requirements; so too on a personal scale, if your intentions are geared in that direction.  
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Use of multi-media, computer supported collaborative work – large, multi-national 

organisations that require their employees, working globally, to be able to access and use information is now 

able to make this information available to their employees, via the internet. The employees simply connect to 

the internet, then log into the company’s website and will be able to retrieve any information they require from 

the website or storage systems. 

 

Limitations the Internet 

Identifying authoritative sources – many people, because it is free and easy to do so, publish 

information on the internet which is not always theirs’ to use and publish. Very often you will find pirated 

versions of software available freely on the internet, which is illegal to download. So there is definitely a 

problem with the users of the internet, as they are not always honourable.  

 

Currency and accuracy of information – because the internet has such a wealth of information and 

the fact that it has been running for more than a decade, the information available is not always current and 

reliable to the users. Very often it is said that when using information from the internet, you should firstly 

research the viability and accuracy thereof to ensure that your findings are accurate.  

 

Security – one of the largest concerns with the use of the internet is the security. More than 70% of internet 

users have been at risk with regards to their security. Again, this falls in the hand so individuals using the 

internet but who do not have honourable intentions. All types of information is shared on the internet and 

without due concerns to security issues, some individuals unknowingly, give out information to the wrong 

sources, who will use it against them.   

 

Staff time involved in using the Internet – when using the internet, because of the vastness of 

information available, users are very often flooded with the amount of information and find it difficult to make 

sense of the information overflow. This process can slow the progress of an individual if they are not able to 

timeously sift through the information and gather only what is required for the task at hand.  

 

Download speed – every internet service provider promises faster internet, which is one of the deciding 

factors that every user of the internet considers before deciding on the ISP they will be utilising. It has been said 

that people who use the internet for three or more hours a day for 7 years, will spend 45 days waiting on the 
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downloading of information from the internet. So the speed of your internet connection definitely does make a 

difference on the production time of employees 

 

Legal and Ethical Issues in Relation to Internet Use 
 

Many users of the internet have been forced to employ a variety of security measures to ensure that their 

information, websites and users are safe from the prying hands and minds of internet fraudsters. In recent 

times, the largest fraudulent activities on the internet, has been focussed on that of the banking and financial 

institutions. Because millions of South Africans use their internet banking facilities on a daily basis, personal or 

business related, these activities are the hardest hit by the “cyber-criminals”.  

 

Related institutions have instituted a variety of measures to assist with the clamping down of such activities, but 

their success rates have varied. Let’s have a closer look at how these measures have been identified and the 

attempts which have been made to eradicate them: 

 

Internet Banking Security 
CONTRIBUTED BY JOHN O'LEARY 

FRIDAY, 05 JANUARY 2007 

For anyone who is nervous of computers it is the perennial nightmare: you log in to your internet banking 

facility one day happy in the knowledge that your finances are safe in the bosom of modern technology, only to 

find that your current account balance has been unexpectedly and painfully diminished, apparently by a transfer 

to a credit card issued by a bank in Bermuda. It subsequently transpires that someone has obtained the 

username and password for you internet banking service, and by passing himself off as you online, has siphoned 

off funds from your account. 

 

Identity Theft 

This scenario is just one example of a disturbing and ever more common practice known as "identity theft". 

While its scope is considerable, and includes using someone else's identity to obtain a passport or a driver's 

licence, or to draw someone else's pension, we will be dealing with identity theft only as it relates to internet 

banking. Broadly there are three ways in which someone can obtain the personal details which will allow him 

access to your bank account.  
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Firstly, he can access the bank's databases and obtain the details directly from that source. Given that these 

databases are protected by very robust security features, it is unlikely that such information will be accessible by 

this route, unless it is accessed by someone with inside knowledge of the bank's system. 

 

The second way of obtaining this sensitive information is by intercepting electronic communications between 

the bank and its customer. Fortunately, communications between the bank's web-servers (the computers that 

provide internet banking services) and the client's web-browser (for example Internet Explorer or Netscape 

Navigator) are encrypted, making it virtually impossible to "tap into" these communications.  

 

"Hacking" 

This brings us to the "weak link" in the system - the client's computer itself. This often has little or nothing in the 

way of security measures in place, so this is where identity thieves concentrate. A recent incident that caught 

the country's attention involved a "hacker" obtaining log-in information from several customers of ABSA Bank, 

and then using this information to transfer money from their accounts. What appears to have happened is that 

the hacker bought a computer program called eBlaster.  

 

This is "spyware" software, used to keep track of others' use of personal computers. Such software is normally 

used by employers to keep track of their employees' computer use, or by parents to keep tabs on their children. 

The hacker used this software to email a computer program to his victims.  

 

When the victims opened these emails, the computer programs installed themselves in the victims' computers. 

These programs then monitored the victims' computer use, recording all their keystrokes and sending them 

back to the hacker's computer. This allowed the hacker to obtain the information that gave him access to his 

victims' bank accounts. 

 

This method is just one of several possibilities. One of the dangers of computer viruses is that they often implant 

what is called a "Trojan Horse" in the client's computer system. Rather than release Greeks to open the city 

gates however, this Trojan Horse is a computer program that may send personal information back to the virus' 

creator, or even be used to take control of your computer.  

 

Other, more traditional methods include sitting down behind an unattended computer and obtaining 

confidential information that way, or by simply reading notes left in unattended wallets and handbags. 
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How Do I Protect Myself? 

We recommend that you do the following:  

□ Do	not	allow	unauthorised	persons	access	to	your	PC.	If	necessary,	set	a	password	so	that	if	the	

computer	is	left	un-attended,	it	cannot	be	accessed.	If	you	make	a	paper	note	of	your	username	and	

password,	write	it	down	in	a	safe	place.	

	

□ When	you	dispose	of	old	computers,	make	sure	that	the	information	on	your	hard	drive	is	made	

completely	inaccessible,	either	by	means	of	a	low-level	format	(ask	your	computer	maintenance	company	

about	this),	or	by	physically	destroying	the	hard	drive.	

	

□ Only	open	emails	that	do	not	look	in	the	least	suspicious.	This	means	that	you	should	know	the	

person	who	has	sent	you	the	email,	and	/	or	see	from	the	subject	that	the	email	is	relevant.	Be	particularly	

wary	of	subjects	that	seem	to	be	designed	to	grab	your	attention,	like	"returning	your	call",	"I	was	just	

thinking"	etc.	

	

□ Install	anti-virus	software	and	ensure	that	its	virus	definitions	(what	the	software	uses	to	recognise	

the	latest	viruses)	are	kept	up	to	date.	The	well-regarded	antivirus	packages	continually	check	for	updates.	

	

□ You	MUST	have	a	firewall	between	your	computer	and	the	internet.	A	firewall	is	special	software	

that	only	allows	computer	programs	that	you	approve	of	to	access	the	internet.	This	will	stop	spyware	and	

viruses	from	communicating	with	their	distributors.	You	can	download	free	firewall	programs	off	the	

internet,	or	buy	them	from	most	software	vendors.		

 

Who is Liable? 

What concerns most people when faced with this scenario is the question of who bears the loss should funds be 

transferred out of their bank account - their bank or themselves? In the very unlikely event that a security 

breach occurs at the bank or in secure communications between the bank and the client, the bank would be 

obliged to reimburse its client for any such loss, as the fault would clearly be that of the bank.  

 

Where the breach has occurred on the client's computer however, the position is less certain, and would 

depend on the facts. Certainly where the client has not made any effort to safeguard login data and suffers a 
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loss as a result of this negligence, the bank cannot be held liable. Where the client has secured his computer, he 

will still have to show that the bank was negligent in some way for the bank to be held liable.  

 

The legal position aside, the bank may opt to compensate the client for the loss in any event so as to maintain 

public confidence in its system - but do not count on this! 

 

Conclusion 

All transactions carry risk, and internet banking is no exception. If you take care to maintain your security by 

following the steps outlined in this article, the risk of suffering loss is very small indeed.  

 

Let’s hear what the experts have to say with regards to your security and how to maintain it: 

 

nternet banking - know the risks 
November 10, 2009 in Security  

 

Internet banking is widely used, especially by individuals and small and medium businesses, because it is 

easy and convenient, available 24 hours a day, seven days a week and typically incurs far less bank fees than 

going in to a branch to do banking.  

However, online identity theft is unfortunately a reality, and ploys such as phishing and pharming, virus attacks, 

hacking, unauthorised access and fraudulent transactions put consumers at risk. The best way to avoid falling 

victim to these kinds of attacks is to be aware of them and safeguard personal information. Online fraud is rife 

and consumers need to be aware of its existence and understand the risks they pose to avoid falling victim to 

fraudsters. 

Phishing is one of the most common, and publicised, forms of theft when it comes to Internet banking. Phishing 

typically takes the form of an email, ostensibly from a customer’s bank, requesting confidential details and 

internet banking information, or containing a link to a Website that looks almost identical to the authentic one, 

where users will enter their details. These are then captured by the fraudsters and used to make unauthorised 

transactions on an account.  

Internet banking users need to be vigilant in recognising these ploys so that they do not respond to them. They 

also need to be aware that protecting confidential details is their responsibility and that they should never 

divulge information like passwords, profile numbers and Personal Identity Numbers (PINs). Banks will never use 

email to request personal details or contact a user telephonically to request electronic banking information. 

 

I 
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Keystroke logging is another common method of perpetrating online banking theft. This literally involves the 

user’s keystrokes being recorded, in a number of ways, and then using this information to access accounts 

without authorisation and make fraudulent transactions. To do this, the fraudsters may use software, hardware, 

keyboard sniffers, keyboard overlays or even optical surveillance like video cameras.  

 

The best way to avoid falling victim to keystroke logging is not to access an Internet banking facility from any 

publicly accessible venue, such as Internet cafés or even at the office. Users also need to avoid clicking on 

suspicious links in emails, which may contain Trojans or a virus that may install a keystroke logging programme 

on the user’s machine. Anti-spyware software as well as having an adequate firewall is also important to 

prevent these types of programmes from being installed. 

 

Another less well known form of online identity theft is pharming, which is a compromise of a website at the 

Internet Service Provider (ISP) level. When users enter the URL of their Internet banking site, pharming hijacks 

the DNS tables, redirecting the user to a fraudulent site that looks just like the real site, which is then used to 

capture their details for fraudulent activities.  

 

This method is particularly dangerous, as even if users have all of their security in place on their machine they 

are still vulnerable as this type of fraud happens on the bank’s side. The only way to identify a fraudulent 

banking site is to look for the padlock at the bottom of the screen, as this indicates that the website is encrypted 

and secure. If this padlock does not appear the user should leave the site immediately and not enter any of their 

details.  

 

While these threats are real and pose a serious risk to users of internet banking, it cannot be denied that online 

banking has benefits that outweigh the issues. As long as users are aware of potential problems that may 

compromise their accounts, and take security seriously, these threats can be avoided and users can enjoy the 

convenience of online banking without falling victim to fraud. 

 

To clearly understand the legal implications of internet use, we need to relate this to an area where laws 

governing the internet have been practised and enforced for many years. Unfortunately South Africa is in the 

infancy stage of such law prosecution, so we have made use of an American article to better explain the 

concept. Let’s start by reading the following article: 
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Legal Issues on the Internet - Hyperlinking and Framing  
MAUREEN A. O'ROURKE 

Introduction 

As the Internet has continued its emergence from a research network to a largely for-profit enterprise, 

commercial owners of World Wide Web (web) sites have concentrated much of their efforts on searching for 

revenue models that allow them to profit from Internet dealings. This commercialization of the Internet has 

raised challenges for the law in at least two ways. First, the search for a profit-generating revenue model has 

challenged the customs or "netiquette" that effectively ruled the Internet when it was dedicated to research. 

The question for the law is whether those customs should constitute the legal rule in a commercial 

environment.  

 

For example, the web was built for the purpose of enabling hypertext capabilities, allowing one site to hyperlink 

(link) to and access another. In this way, users could make sense of the great mass of data contained on the 

Internet. Linking was both accepted and encouraged when the Internet was a research network. However, on 

the commercial Internet, some site owners have contended that before employing a link, the linking site must 

seek permission from the web site to which it wishes to link. The legal response to this question can be helpfully 

informed by reference to the netiquette of linking interpreted in light of legal principles which predate the 

Internet's inception. 

 

The second challenge to the law lacks a similar frame of reference to netiquette. As new technologies have 

emerged allowing even more manipulation of data than that anticipated when the Internet was established, 

commercial site owners have attempted to limit the use of such technologies by others, particularly when such 

use impacts revenue. The issue for the law in this context is how to address this new conduct without any 

guidance from netiquette and under legal principles designed for a physical rather than cyber world.  

 

For example, technology that allows framing of other sites is a relatively recent innovation, lacking any 

established netiquette to provide some insight in conducting the legal analysis. A number of commercial site 

owners have objected to the framing of their sites, contending that such framing effectively misappropriates 

their content. The question for the law in this context is how to apply longstanding principles of copyright, 

trademark and common law unfair competition law to this new practice. 
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The legal answer is by no means clear and commentators hold widely diverging opinions. It is likely also that 

different courts will arrive at different results. It will probably be some time before the law is unified, offering 

consistent, predictable solutions.  

 

This article, then, presents one view of the law and argues that although the question is a close one, copyright 

law generally allows linking without permission. However, trademark law may limit the manner in which the link 

may be displayed. It also argues that copyright law allows framing but that if a particular use of a frame confuses 

consumers as to the source of the information, framing may implicate trademark concerns. Finally, it argues that 

a recent Second Circuit opinion, if adopted by other courts, will severely limit the utility of common law unfair 

competition claims involving Internet-based conduct 

 

Hyperlinking 

Historically, sites have welcomed links from others. To date, web site owners have made money primarily from 

the sale of advertising at their sites. The advertising rate is set by the number of people who travel to the site. 

From a revenue perspective then, web site owners are indifferent as to how a person accesses the site -- 

whether directly or by linking to it from another site. Both types of access record the desired "hits" to the site 

that can increase advertising revenue. The conventional view then has held that sites welcome linking from 

others because it increases traffic, advertising rates, and, by inference, revenue. 

 

Recently, however, certain sites have challenged the practice of linking without first seeking permission. In the 

widely publicized Ticketmaster Corp. v. Microsoft Corp. case, Ticketmaster sued Microsoft for linking to its site 

without permission. In particular, Ticketmaster objected to Microsoft's practice of linking deep within its site 

rather than to the home page, and claimed, among other things, that Microsoft effectively diverted advertising 

dollars that otherwise would have gone to Ticketmaster. Interestingly, the complaint was based primarily on 

trademark law rather than copyright, as the copyright infringement claim appeared almost as an afterthought. 

 

The impetus for the suit was probably primarily economic. By linking deep within the site, Microsoft bypassed 

Ticketmaster's home page which contains advertising. As a result, no "hit" to the home page was recorded, 

potentially decreasing Ticketmaster's revenue. Also, Ticketmaster had set up contractual arrangements with 

other firms in which those companies had agreed to pay to link to the Ticketmaster site. Free linking by 

Microsoft could devalue those relationships. Finally, Ticketmaster had agreed to give MasterCard prominence at 

the Ticketmaster site.  
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Microsoft's bypassing of the home page threatened the ability of Ticketmaster to comply with that agreement. 

The free link of Microsoft then seems facially to be invidious; allowing such a free link undercuts Ticketmaster's 

flexibility both in designing its site and in its marketing efforts with other sites. 

 

However, under the copyright law, the user's act of linking is unlikely to constitute infringement because it is 

probably protected either by an implied license or under the copyright doctrine of fair use. Because the user's 

act would not be infringing, the party -- here, Microsoft -- who enables the user to link, could not be guilty of 

contributory infringement.  

 

This result may seem incongruous in light of the objections detailed above. However, countervailing policy 

considerations including netiquette, the site owner's ability to combat unwanted linking technologically, and the 

First Amendment interest in maintaining the free flow of ideas and information on the Internet support this 

result. 

 

Trademark law, however, may place limits on linking. The gravamen of Ticketmaster's trademark complaint is 

that a link implies an association between the linking and linked sites. When such an association is lacking, the 

link could constitute trademark infringement, dilution and/or unfair competition under the Lanham Act.  

 

However, consumer expectations are generally relevant in trademark cases. Most users are unlikely to assume 

an affiliation between the two sites, particularly since the user leaves the linking site and travels to the linked 

site, understanding that it is at a new web location.  

 

Users' expectations may be influenced, in part, by the manner in which the trademark is used. If the linking site 

uses the linked site's fanciful logo as its pointer, consumers are more likely to believe that there is an association 

than if the linking site uses the address or name of the linked site as its pointer.  

 

Linking then, in the absence of other wrongful conduct, is unlikely to constitute either copyright or trademark 

infringement. However, if a site were to imply an association with the linked site expressly or implicitly through 

the manner in which it uses the trademark, it may be liable under the Lanham Act. 
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Framing 

Unlike linking, framing is a relatively recent phenomenon, introduced by Netscape in Version 2 of its Navigator 

product. A framing site, by virtue of certain commands in its HTML code, links to another site, displaying that 

site within a window or frame. The frame itself is comprised of content from the framing site. In contrast to 

generic hyperlinking, in the case of framing, the user remains at the framing site and views content from both 

sites.  

 

The address that the user's browser displays may continue to be that of the framing site. The user may be 

unaware that the content in the frame comes from another site. This difference between linking and framing 

may make trademark liability more likely for sites that frame rather than merely hyperlink. 

 

Sites are increasingly challenging those who frame them. Probably the most widely publicized challenge was 

that brought by a group of plaintiffs led by The Washington Post against Total News, Inc. The plaintiffs objected 

to the Total News site's framing of their content. Total News would surround the content of the plaintiffs' sites 

with ads that Total News itself had sold. Plaintiffs argued that Total News had infringed their copyrights and 

trademarks, diluted their trademarks and engaged in unfair competition both under the Lanham Act and at 

common law. 

 

Again, the impetus for the suit was probably economic. Total News was able to frame the sites in such a way 

that it looked as if Total News' advertisers were actually advertising on the framed sites themselves. Advertising 

revenue was thus diverted from the framed sites to Total News. Moreover, because the address of the Total 

News site continued to be displayed on the screen, it also looked as if Total News were the source of even the 

content displayed in the frame. 

 

However, copyright law is unlikely to be implicated in the act of framing, although again, it is a close question. 

Arguably, none of the exclusive copyright rights are implicated by the frame as it is simply a method of display. 

The frame though, might implicate the copyright owner's exclusive right to prepare derivative works. In refusing 

to dismiss a complaint that framing constituted copyright infringement, Judge Audrey Collins noted that existing 

precedent does not conclusively decide the issue of whether the use of a frame constitutes creation of a 

derivative work.  
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Even if the framing site were considered a derivative work of the framed site, the creator of the framing site 

may still not be liable for copyright infringement. The user actually does the framing and the user's conduct is 

likely to be protected under the copyright doctrine of fair use. As in the case of linking, if the user is not a direct 

infringer then the site that provides the ability to frame cannot be a contributory infringer. 

 

However, many cases that involve framing are likely to implicate trademark concerns. The continuing display of 

the address of the framing site may confuse users as to origin, a traditional concern of trademark law. 

Surrounding the framed site with content from the framing site may likewise confuse users as to origin.  

 

A line of cases in trademark law on the repackaging of trademarked goods also offers support for the contention 

that framing may violate trademark law. 

 

Framing thus is less likely to survive legal challenge than generic hyperlinking. While it may or may not give rise 

to copyright liability, it is quite likely to run afoul of the trademark laws. 

 

Unfair Competition 

The failure of existing law to address the practices in which parties engage by using previously unknown 

technology may lead many plaintiffs to place less reliance on statutory causes of action in copyright and 

trademark and more on the common law tort of unfair competition. Unfair competition is a more malleable 

cause of action than either copyright or trademark infringement, since, as its name suggests, it can address a 

wide range of conduct.  

 

However, a recent Second Circuit decision may have significantly limited its viability, at least with respect to 

claims of misappropriation, the essence of unfair competition claims based on hyperlinking and framing. 

 

In NBA v. Motorola, Inc., 105 F.3d 841 (2d Cir. 1997), the Second Circuit narrowly defined the contours of a 

common law unfair competition claim of misappropriation that would survive a copyright pre-emption analysis.  

 

The court seemed to indicate that a misappropriation claim is not pre-empted only if the particular information 

is time-sensitive, the defendant free-rides on the plaintiff's efforts and that free-riding, if it were to become 

widespread, would threaten the very existence of plaintiff's product.  
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In a world like the Internet that is characterized by relatively low costs, this latter element may be quite difficult 

to prove. If other courts adopt the Second Circuit's approach, plaintiffs may not be successful in challenging 

hyperlinking or framing as misappropriation.  

 

Even in a jurisdiction that does not adopt Motorola, plaintiffs may find their unfair competition claims pre-

empted under a conventional analysis under section 301 of the Copyright Act, as the conduct involved in 

hyperlinking and framing implicates copyright-type rights. 

Conclusion 

Hyperlinking and framing are just two of the Internet practices which plaintiffs are challenging. Neither is clearly 

illegal under existing legal doctrine, nor is it clear that either should be. The uncertainty of the current public law 

of copyright and trademark may lead parties to seek redress under the private law of tort.  

 

If misappropriation claims are unsuccessful under a Second Circuit view of the world, plaintiffs might try to use a 

cause of action like trespass to limit unauthorized access. Additionally, parties may attempt to order their 

relationships using the private law of contract to set the terms of access and use of a site. Thus, even if 

hyperlinking and framing were to survive challenges under the intellectual property statutes, they may be 

actionable under private law.  

 

However, as the Second Circuit's opinion reminds potential litigants, private causes of action may be pre-

empted by the public intellectual property law. Thus, the question of the relationship between the public and 

private law is likely to play an important role in deciding the shape of the Internet, regardless of whether the 

particular conduct involved is hyperlinking, framing, or some technology not yet developed.  



 
 

SDA | MODULE 2 | STUDENT GUIDE 194 

 

Use a Graphical User Interface (Gui)- Based Browser To Display a Given 

Web Page 
 

In all reality if you only knew how to use Internet Explorer you would be pretty much good to go. Every 

computer, even most Macs, have it installed and most pages are optimised for it. Internet Explorer is by far the 

most widely used web browser on the planet, and if you want to stay current and cool with technology, then 

you better do yourself a favour and learn Internet Explorer. Soon you will be cruising like a real pro, and don’t 

forget that it was Newbie that gave you the most needed instructions. 

 

These beginning sections will help you learn and understand the basic operations and functions of Internet 

Explorer.  

Opening a the Internet Explorer Browser 

1.      Click the Start  button. 

2.      Go to Programs, highlight and click Internet Explorer.  

3.      Alternatively click the Internet Explorer icon  on the Desktop or on the Taskbar  next to Start 

button. 

  

  

Beginning Basic Browsing 

 The important thing to remember when you first begin browsing the web is the Web address of a site you wish 

to visit. Go up to the "Address Bar" near the top of the page, and click on it. Now you can type in the Web 

address of the site you want, and then press enter.  

 

Internet Explorer will go to this site directly from whatever document you were currently viewing. This is much 

faster than going to a search engine and trying to locate the site you want in their directories, or searching for it 

with a query. (Address Bar shown below)  
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Your first time that you browse the web, you may have some difficulty. Efficiently browsing the Web is just like 

any other complex task in life, it takes practice to be good at it. Internet Explorer has some built-in features 

which will help to make it easier for you to browse the web.  

 

The fastest way to get to a place that you don’t know its address and you want to search for, is to click on the 

"Search" button on the Internet Explorer main toolbar. This button will take you to a document within 

Microsoft's home site. On this document you will find a choice of categories to look through and a list Search 

Engines to use.  

 

A Search Engine is an application that will attempt to find any documents that contain the subject or phrase that 

you enter into the search parameters. You can also browse through the categories of Web sites that the search 

engines have already organized for you. Alternatively you can go to specific search engines that you know their 

address. 

 

 The Main Explorer Toolbar  

 
 

The main toolbar is composed of eleven different buttons. Each of these buttons has a different function and 

purpose in Internet Explorer. The individual buttons will each be discussed in the following sections.  

 

The Back Button:  This button will take you back to whatever document you were previously viewing. 

Pressing it immediately takes you back one document; if you have browsed many pages, or are well into a multi-

page document, pressing it repeatedly will continue to back you up one page at a time. Once you reach your 

starting location, it will be greyed-out and unavailable.  

 

The Forward Button:  This button will take you forward to the next document if you have previously 

browsed multiple documents and had then backed-up to the page you are currently viewing. (If you have not 

backed up at all, the forward button will be greyed-out) Pressing it repeatedly will continue to move you 

forward one page at a time. You can move forward until you reach the last page that you had browsed, at which 

time the forward button will be greyed-out.  
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The Stop Button:  The stop button stops ANY current operations by Internet Explorer. It will stop any type 

of file from loading. It can also be used to stop animations from continuing once a page is loaded. If you press it 

before a page has finished loading, the page will display everything it had finished loading before the stop 

button was pressed. If a document is completely loaded and there are no animations, movies, or other files still 

running, the stop button will have no immediate function.  

 

The Refresh Button:  This button will reload the current document that you are viewing. It is useful if the 

page updates very frequently so that you can view these changes as soon as they are available. If you are 

loading a document and the transfer was interrupted, you can reload the full document again by clicking here.  

 

The Home Button:  This button will return you to the page you have selected as the default start-up page 

for Internet Explorer. It will not take you back to the beginning of your web browsing, it will just return you to 

your home location from where you are. If you press back after reaching your home page, you will go back to 

the page you left after you hit the Home button.  

 

The Search Button:  This button will take you to the page you have selected as the default Web search 

page for Internet Explorer. If you have not selected a page it will take you to Microsoft's default search page.  

 

The Favourites Button:  This button will open up the Favourites menu. You can choose a favourite that 

you wish to go to from the list, add a favourite to the list, or organize your favourites from this menu.  

 

The Print Button:  The print button will bring up a Print dialog box. In the box you can decide if you would 

like to print the contents of the page you are viewing, how many pages you will print, and also how many copies 

you will print. Keep in mind that if you try to print a page that is graphics intensive, you will need a printer that is 

capable of printing graphics. Also, the more graphics and pages a Web site has, the longer it will take to print.  

 

The Font Button:  Pressing this button causes Internet Explorer to cycle through the available font sizes. 

This button is useful if the text is too small to read, or too large to fit comfortably in the window.  

 

The Mail Button:  This button will open into a drop down menu from which you can select to read or send 

E-Mail. You can also open up your newsgroups from this menu.  
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The Edit Button:  This button will ONLY be on your toolbar if you have a Windows system Web editor (such 

as Microsoft FrontPage or Microsoft Word) installed on your computer. If you press this button, it will launch 

that editor and open the document you are currently viewing in it.  

  

 Viewing Documents While Not On the Web 

Internet Explorer is capable of displaying HTML documents and 

images even if you are not connected to the Internet. Go to the file 

menu from the main menu bar. From this menu select "Open", the 

open dialog box will appear. (You can also press CTRL-O from the 

main Explorer window to access this box)  

 

In this dialog box, you can type in a Web address to access a page on the Web. Since we 

are not on the Web, click the "Browse" button to look at files on the hard drive. Select the 

type of file you want to open from the drop-down menu at the bottom of the box.  

 

After you have selected the file type, go to the directory that contains this file. Select the 

file and then click "Open". The document, image, movie, or sound file you have selected 

should now be viewable in Internet Explorer.  

  

You may find information on the internet that you want to keep, this may include text or pictures.  Be careful 

when you do this to ensure that you are not breaking any copyrights. 

 

To save the current page on your computer 

1.     On the File menu, click Save As. 

2.     Select the folder you want to save the page in. 

3.     In the File Name box, type a name for the page, and then click Save. 

Note: Internet Explorer saves only the text on a page, not the graphics 

 

To save a picture 

1.     Right-click the picture 

2.     Click Save Target As. 

3.     Select the folder you want to save the page in. 

4.     In the File Name box, type a name for the item, and then click Save. 
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Printing Web Documents 

If your computer is connected to a printer, you can 

print out any Web document that you wish whether 

you are viewing it on the Web, or if you are just 

viewing it from your hard 

disk. Go to the file menu 

from the main menu bar. 

From this menu select 

"Print", the Print dialog 

box will appear. (An 

easier way to open this 

box is to simply click the 

"Print" button on the 

main toolbar or to press 

CTRL-P)   

 

In this dialog box you can decide how you would like to print the contents of the page you are viewing, how 

many pages you will print, and how many copies you will print. Keep in mind that if you try to print a page that is 

graphics intensive, you will need a printer that is capable of printing graphics. Also, the more graphics and pages 

a Web document has, the longer it will take to print.  

 

Setting Your Default Start-Up Page 

The "Start-Up" page is the Web Site or document that Internet 

Explorer will open automatically every time that you start the 

program. These steps will show you how you can change this page 

to whatever location you prefer. From the Tools dialog box, click 

on the "Internet Options" folder tab at the bottom of the box. You 

can change the start-up page from here. (The customize section is 

outlined in red for your convenience). Click on "General" and then 

click in the Address box. Type the address of the page you would 

like Internet Explorer to open each time you start the program. If 

you are satisfied with your choice and are done setting options, click on "Apply" then "OK" at the bottom of the 

Internet Options box.  
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Adjust Settings to Customise the View and Preferences of the Browser 
Application 
 

When you first use Internet Explorer 7, you may notice one key component missing from your browser window. 

This is the familiar Menu Bar that contains choices such as File and Edit. In older versions of the browser, this 

was displayed by default and most of us have grown accustomed to using it. This tutorial will show you how to 

display IE 7's Menu Bar in just a few easy steps. 

First, open your Internet Explorer browser. 

 

Click on the Tools menu, located in the upper right hand corner of your browser 

window. When 

the drop-down 

menu appears, 

select Menu 

Bar. 

 

 

You should now 

see the Menu 

Bar displayed in 

the toolbar section of your browser window. To hide the Menu bar, simply repeat the previous step. 

 

 

Managing your Internet Explorer Temporary Internet Files 

Every time you visit a web page Internet Explorer makes a copy of the content of these web pages as files on 

your computer. These files are called Temporary Internet Files and are used to allow for faster displaying of web 

sites that you visit. Depending on the setting, when you visit a web site Internet Explorer will compare the 

content of that web site with the information stored in the Temporary Internet Files and only download the 

content from the Internet if it has changed. This enables you to browse the web much quicker because you do 

not have to download these files.  

 

In most cases Temporary Internet Files do not pose a problem, but there some situations that make it important 

for you to clean out these files. One common reason is that you are worried about your privacy. If you give your 
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computer to someone they would potentially be able to discover information about web pages that you visit 

because copies of these web sites are stored locally on the computer. 

 

If privacy is not an issue, then you may be concerned with how much space 

these files take up. Temporary Internet Files, by default, take up 10% of your 

system partitions disk space. In the past this was not a problem as drives were 

smaller, but with drives ranging up to 100's of GB of storage this can equate 

to large amounts of disk space allocated towards these files. You only need 50 

MB for the Temporary Internet Files to work efficiently, so there is a lot of 

wasted disk space that we can reclaim for our personal use.  

 

Configuring your Temporary Internet Files Settings 

In this section of the tutorial we are going to go over the options on how you 

can configure Internet Explorer to use Temporary Internet Files.  

 

Click on the Start button and then click on Control Panel. Then double-click 

on the Internet Options icon. Once you double click on the Internet Options 

icon you will be presented with a screen similar to the figure on the right. 

 

To access the settings for the Temporary Internet files you will click on the 

Settings button designated by the blue box in Figure one above. When you 

click on the Settings button you will be presented with a screen similar to the 

figure on the right.  

 

The settings dialog shown in the figure on the right is broken down into two sections as described below: 

 

Check for newer versions of stored pages - The options in this section tell Internet Explorer what it should do 

when you visit a web page. Every time you visit a web site Internet Explorer stores a copy of this web page in the 

Temporary Internet Files folder. When you revisit that same web page, whether or not that information is 

downloaded again or taken directly from locally stored copy is decided based upon the setting you choose in 

this section. These settings are described below: 

 
 
 



 
 

SDA | MODULE 2 | STUDENT GUIDE 201 

 

Every visit to the page 

If you select this option then every time you view a web page that you had viewed previously, Internet Explorer 

will check to see if the web page content has been changed since you last viewed it. If it has changed, Internet 

Explorer will display the new page and store a copy of it in the Temporary Internet Files folder. 

 

Setting this selection can increase the time it takes to view a web page, but will guarantee that you are viewing 

only the most current content from that page and not content that was stored in your Temporary Internet Files. 

Recommendation: Use this option if you always want to see the most current content of a particular web site. 

 

Every time you start Internet Explorer 

If you select this option Internet Explorer will only check web pages for newer content the first time you go to it 

since starting Internet Explorer. That means that if you start Internet Explorer and visit a web site, Internet 

Explorer will check for new content. If you go to that site again in the same session, having not restarted 

Internet Explorer, the web site will not be checked for newer content and Internet Explorer will display the 

content from the  

 

Temporary Internet Files 

Using this option can reduce the amount of time it takes to display a web page but there is no guarantee that 

the content that is displayed when you revisit a web site is the most current. If you use this option and want to 

see the most current version of a web site you can click on the View menu and then click on Refresh. 

Recommendation: Use this option if you only care about seeing the most current content of a web site during 

that one session of Internet Explorer. For most people this option is the best choice. 

 

Automatically 

Selecting this option will have Internet Explorer manage how it checks for new content on web sites. When you 

visit a web site Internet Explorer will not check for new content when you revisit a web site during the same 

session or even the same day. Over time Internet Explorer will determine whether or not images are changing 

on the pages you visit, and if they do not change will check for newer images even less frequently.  

Using this option will display the web site in the quickest manner but at the time same give you no guarantee 

that you are viewing the latest content. If you use this option and want to see the most current version of a web 

site you can click on the View menu and then click on Refresh. Recommendation: With the high speed of 

Internet connections these days you should generally not use this option.
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Never 

With this option Internet Explorer will never check to see if the content on a web site is the most current and 

you will always be given the content stored in the Temporary Internet files. If you want to see whether a specific 

page has been updated even when this option is selected, click the View menu, and then click Refresh.  

Recommendation: You should never use this option.  

 

Temporary Internet Files folder - This section gives you information about the actual folder where the 

Temporary Internet Files are stored as well as the ability to manage the settings associated with these 

files/folders. 

 

Current Location 

This shows the current location of your Temporary Internet Files folder. 

 

Amount of Disk Space to Use 

This shows the amount of disk space that will be allocated for your Temporary Internet Files. By default 

Windows uses 10 percent of your Windows system partition. This amount can be significant if you use the 10 

percent model. It is advised that you change this setting to a lower number such as 50 MB. 

 

Move Folder 

Pressing this button will allow you to change the location where your Temporary Internet Files folder is stored. 

 

View Files 

Clicking on this button will open your Temporary Internet Files folder and display the contents. Press this button 

with caution because if you have a large amount of disk space allocated towards Temporary Internet Files it can 

take a while to open this folder. 

 

View Objects 

Clicking on this button will open up your Downloaded Program Files directory which contains files that were 

downloaded to your computer, usually using ActiveX. To exit from the Settings dialog, click on the OK button 

and then click on the OK button again. 



 
 

SDA | MODULE 2 | STUDENT GUIDE 203 

 

 

Deleting Temporary Internet Files 

A common question is "How do I Delete or clear the Contents of 

the Temporary Internet Files folder?", and we will give you step by 

step instructions on how to do this below. Step 1: Click on the 

Start button and then click on Control Panel. Then double-click on 

the Internet Options icon. You will now be presented with an 

screen similar to the figure below. 

 

 

 

 

 

 

 

Step 2: Click once on the Delete Files button designated by the 

red box in the figure above to the right above. This will bring up 

a confirmation box similar to the figure on the right. 

 

 

Step 3: Click on the checkbox labelled Delete all offline content 

if you would like to delete content that you marked as viewable when you are not connected to the Internet. If 

you do not have offline content you can leave this unchecked. 

 

Step 4: You should then click on the OK button which will start the process of deleting all of your Temporary 

Internet Files. This can take a while so do not be concerned if it looks like the Internet Options screen has 

become frozen. When it is done deleting the files, the Internet Options screen will go back to normal and you 

will be able to press the OK button to close the window. Now your Internet Explorer Temporary Internet Files 

have been deleted from your computer. 

 

Conclusion 

By understanding how to manage your Temporary Internet Files you can optimize how Internet Explores views 

web pages as well as takes up disk space on your computer. 
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Use a Search Engine to Locate Given Information Specifications 
 

 How to Search the Internet Effectively 

Search Engines 

Internet search sites can search enormous databases of Web pages, using titles, keywords or text. You can 

maximize the potential of search engines by learning how they work, and how to use them quickly and 

effectively. The challenge is to ask your question the right way, so that you don't end up overwhelmed with too 

many search results, underwhelmed with too few, or simply unable to locate the material that you need. As 

with most skills, practice makes perfect! 

 

Getting Started 

Before doing a search, it's important to define your topic as completely and succinctly as possible. Write down 

exactly what information you're looking for, why you're looking for it, and what you're not looking for. This will 

help you to discover the best keywords for your search. 

 

Keywords 

With the exception of search engines such as AskJeeves.com, which will take questions in the form of actual 

queries, most work best if you provide them with several keywords. So how do you determine which keywords 

will work best? Most users submit 1.5 keywords per search, which is not enough for an effective query - the 

recommended maximum is 6 to 8 carefully chosen words, preferably nouns and objects. (Search engines 

consider articles and pronouns clutter.) Avoid verbs, and use modifiers only when they help to define your 

object more precisely - as in "feta cheese" rather than just "cheese." Now you have your keywords. How do you 

enter them into the search engine?  

 

Use of Phrases  

Your most powerful keyword combination is the phrase. Phrases are combinations of two or more words that 

must be found in the documents you're searching for in the EXACT order shown. You enter a phrase - such as 

"feta cheese" - into a search engine, within quotation marks. Some searches provide specific options for 

phrases, while others don't allow them at all; but most will allow you to enter a phrase in quotation marks. 

Check the "Help" files of the search engine you're using to be sure what it accepts.  

 

Punctuation and Capitalisation  
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Most search engines are insensitive to case: you can type your queries in uppercase, lowercase, or a mix of 

cases. If you use lowercase, most engines will match on both upper and lower case; so for general searches, 

lowercase is the safest form to use. Not all search engines handle punctuation the same way. When in doubt, 

consult the "Help" file.  

 

Boolean Basics  

"Boolean" searching (named after George Boole, the 19th-century mathematician who founded the field of 

symbolic logic) is a powerful technique that can narrow your search to a reasonable number of results, and 

increase the chance of those results being useful. 

 

 Boolean searches are simple to learn and tremendously effective. The three most commonly used Boolean 

commands (or "operators") are: 

 

AND means "I want only documents that contain both/all words." For instance, the search "London" 

AND "Big Ben" AND "Buckingham Palace" AND "Trafalgar Square" would return only documents that contained 

all four keywords or phrases. AND is the most frequently used Boolean command.  

 

OR means "I want documents that contain either word; I don't 

care which." The query "London" OR "Big Ben" OR "Buckingham Palace" OR "Trafalgar Square" would return all 

documents that contained even one of these four keywords or phrases. Use OR to string together synonyms; be 

careful about mixing it with AND.  

AND NOT means "I want 

documents that contain this word, but not if the document also contains another word." The query "London" 

AND "Big Ben" AND NOT "Buckingham Palace" would return documents that include London and Big Ben, but 

not those that also include Buckingham Palace. Remember that AND NOT only applies to the word or phrase 

that immediately follows it.  

 

Most search engines support the AND NOT command.  It is sometimes called BUT NOT or NOT, and is 

sometimes indicated by placing a minus sign (-) before the term or phrase to be removed.  (Check the search 

tips of the engine you're using to see which form of AND NOT it accepts). Before you apply AND NOT, see what 

results you get from a simpler search. AND NOT is a great way to weed out results you don't want, such as 

pornography.  
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Quick Tips  

• Use	nouns	as	query	keywords.	Never	use	articles	("a,"	"the"),	pronouns	("he,"	"it"),	conjunctions	

("and,"	"or")	or	prepositions	("to,"	"from")	in	your	queries.		

• Use	6	to	8	keywords	per	query	

• Where	possible,	combine	keywords	into	phrases	by	using	quotation	marks,	as	in	"solar	system"	

• Spell	carefully,	and	consider	alternate	spellings	

• Avoid	redundant	terms	

• Check	the	"Help"	function	of	the	particular	search	engine	you're	using,	since	they	all	have	their	own	

quirks	and	preferences.	A	successful	Internet	search	can	take	several	tries.	But	remember:	it's	

estimated	that	there	are	between	200	and	800	million	documents	online	-	with	no	master	system	

for	organizing	this	information!	No	wonder	effective	searches	take	knowhow,	patience	and	

ingenuity.	

 

Web Crawling 

When most people talk about Internet search engines, they 

really mean World Wide Web search engines. Before the 

Web became the most visible part of the Internet, there 

were already search engines in place to help people find 

information on the Net. Programs with names like "gopher" 

and "Archie" kept indexes of files stored on servers 

connected to the Internet, and dramatically reduced the 

amount of time required to find programs and documents. 

In the late 1980s, getting serious value from the Internet 

meant knowing how to use gopher, Archie, Veronica and the 

rest.  

 

Today, most Internet users limit their searches to the Web, 

so we'll limit this article to search engines that focus on the contents of Web pages. 

 

Before a search engine can tell you where a file or document is, it must be found. To find information on the 

hundreds of millions of Web pages that exist, a search engine employs special software robots, called spiders, to 

build lists of the words found on Web sites. When a spider is building its lists, the process is called Web crawling. 

(There are some disadvantages to calling part of the Internet the World Wide Web -- a large set of arachnid-
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centric names for tools is one of them.) In order to build and maintain a useful list of words, a search engine's 

spiders have to look at a lot of pages.  

 

How does any spider start its travels over the Web? The usual starting points are lists of heavily used servers and 

very popular pages. The spider will begin with a popular site, indexing the words on its pages and following 

every link found within the site. In this way, the spidering system quickly begins to travel, spreading out across 

the most widely used portions of the Web. 

 

Google began as an academic search engine. In the paper that describes how the system was built, Sergey Brin 

and Lawrence Page give an example of how quickly their spiders can work. They built their initial system to use 

multiple spiders, usually three at one time. Each spider could keep about 300 connections to Web pages open at 

a time. At its peak performance, using four spiders, their system could crawl over 100 pages per second, 

generating around 600 kilobytes of data each second.  

 

Keeping everything running quickly meant building a system to feed necessary information to the spiders. The 

early Google system had a server dedicated to providing URLs to the spiders. Rather than depending on an 

Internet service provider for the domain name server (DNS) that translates a server's name into an address, 

Google had its own DNS, in order to keep delays to a minimum.  

 

When the Google spider looked at an HTML page, it took note of two things:  

• The	words	within	the	page		

• Where	the	words	were	found		

 

Words occurring in the title, subtitles, meta tags and other positions of relative importance were noted for 

special consideration during a subsequent user search. The Google spider was built to index every significant 

word on a page, leaving out the articles "a," "an" and "the." Other spiders take different approaches.  

 

These different approaches usually attempt to make the spider operate faster, allow users to search more 

efficiently, or both. For example, some spiders will keep track of the words in the title, sub-headings and links, 

along with the 100 most frequently used words on the page and each word in the first 20 lines of text. Lycos is 

said to use this approach to spidering the Web.  

Other systems, such as AltaVista, go in the other direction, indexing every single word on a page, including "a," 

"an," "the" and other "insignificant" words. The push to completeness in this approach is matched by other 

systems in the attention given to the unseen portion of the Web page, the Meta tags.
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Meta tags allow the owner of a page to specify key words and concepts under which the page will be indexed. 

This can be helpful, especially in cases in which the words on the page might have double or triple meanings -- 

the Meta tags can guide the search engine in choosing which of the several possible meanings for these words is 

correct.  

 

There is, however, a danger in over-reliance on Meta tags, because a careless or unscrupulous page owner 

might add meta tags that fit very popular topics but have nothing to do with the actual contents of the page. To 

protect against this, spiders will correlate Meta tags with page content, rejecting the Meta tags that don't match 

the words on the page.  

 

All of this assumes that the owner of a page actually wants it to be included in the results of a search engine's 

activities. Many times, the page's owner doesn't want it showing up on a major search engine, or doesn't want 

the activity of a spider accessing the page. Consider, for example, a game that builds new, active pages each 

time sections of the page are displayed or new links are followed. 

 

 If a Web spider accesses one of these pages, and begins following all of the links for new pages, the game could 

mistake the activity for a high-speed human player and spin out of control. To avoid situations like this, the 

robot exclusion protocol was developed. This protocol, implemented in the meta-tag section at the beginning of 

a Web page, tells a spider to leave the page alone, to neither index the words on the page nor try to follow its 

links. 
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You are now ready to go through a check list. Be honest with yourself. 

Tick the box with either a √ or an X to indicate your response. 
 

□ I	understand	the	concepts	and	terms	of	the	Internet.		
□ I	am	able	to	explain	legal	and	ethical	issues	in	relation	to	Internet	use.		
□ I	am	able	to	use	a	GUI-based	browser	to	display	a	given	Web	Page.		
□ I	am	able	to	adjust	settings	to	customize	the	view	and	preferences	of	the	browser	

application.		

□ I	am	able	to	navigate	on	the	Internet.		
□ I	am	able	to	use	a	Search	Engine	to	locate	given	information	specifications.		
□ I	am	able	to	format	information	from	a	Web	site.	

 

 

 
 
 
 
 

	
	
	
	
	
	

You	must	think	about	any	point	you	could	not	tick.	Write	this	down	as	a	goal.	
Decide	on	a	plan	of	action	to	achieve	these	goals.	Regularly	review	these	goals.	

 

 

 

 

 

 

 

 
 

My	Goals	and	Planning:	
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________

________________________________________________________________________________________


